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1 Introduction 
1.1 About This Guide and Related Documentation 

This document is intended for MOTOTRBO radio network administrators responsible 
for the dispatch operations. It provides guidance on the installation, configuration, 
and maintenance of the TRBOnet Server and Dispatch Console applications. 

1.2 About TRBOnet PLUS 
The TRBOnet is a suite of professional applications for MOTOTRBO digital two-way 
radio networks. The TRBOnet manages voice, text, and data communication paths 
across network endpoints and provides a unified graphical dispatcher workbench 
interface for the whole set of messaging and workforce orchestration tasks. 

1.3 Contacts 

Region Phone Email & Support 

EMEA +44 203 608 0598 
info@trbonet.com — general and 
commercial inquiries 

support@trbonet.com — technical 
support 

http://kb.trbonet.com — online 
knowledge base  

Americas +1 872 22 28 726 

APAC +61 28 6078325 

 
 

mailto:info@trbonet.com
mailto:support@trbonet.com
http://kb.trbonet.com/
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2 Hardware and Software Requirements 
TRBOnet Server/Agent with IP connection only 

Voice Channels 4 8 16 24 24+ 

CPU Intel Core i3 Intel Core i5 Intel Core i7, 4 Cores Intel Core i7, 6 
Cores 

Contact 
technical 
support 

Memory 2 GB 4 GB 4 GB 8 GB 

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording 

Sound Card No 

Supported OS Windows 7/8.x/10, Windows Server 2008, Windows Server 2012, Windows Server 2014 

Software .NET Framework 4.6.x, MS SQL Server 2008 R2 or higher 

 
TRBOnet Server /Agent with Control Stations 

Control Stations 1 2+ 

CPU Intel Core i5 

Memory 2 GB 

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording 

Sound Card Integrated sound card can be used. 

Multi-channel Sound Card required; 
Recommended: 
1. M-Audio Delta 1010 LT 
2. Roland OCTA CAPTURE Hi-SPEED USB 
Audio Capture 

Additional Devices Cable connector Motorola PMKN4016 

Supported OS Windows 7/8.x/10 

Software .NET Framework 4.6.x, MS SQL Server 2008 R2 or higher 

 
Dispatch Console 

CPU Intel Core i3 

Memory 4 GB 

HDD 70 MB for installation files 

Sound Card Yes 

Display 1280x1024 minimum resolution, 1600x900 recommended resolution 

Additional Devices Speakers and microphone, or headset; Imtradex devices are recommended 

Supported OS Windows 7/8.x/10 

Software .NET Framework 4.6.x 

 

http://www.m-audio.com/products/en_us/Delta1010LT.html
http://www.rolandus.com/products/details/1127
http://www.rolandus.com/products/details/1127
http://trbonet.com/pdf_files/TRBOnet_Cable_Connector_v2.zip
http://www.imtradex.com/en/Products/Dispatch-places-911/
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3 System Architecture Overview 
3.1 TRBOnet Server and Console 

The TRBOnet Dispatch Console is a PC-based voice dispatch and AVL software 
application for MOTOTRBO™ professional digital two-way radio systems. 
The software has a client-server architecture: TRBOnet Server runs as a Windows 
service on the server machine, stores data in an MS SQL database, and allows client 
connections from Web Console and Dispatch Console. In addition, remote software 
and/or hardware agents can be connected to provide voice and data from remote 
sites. 

TRBOnet
RadioServer

Dispatch Console

Web ConsoleRadio Infrastructure

WAN/LAN/USB
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3.2 MOTOTRBO Radio Systems 
3.2.1 Single Site conventional system 

A Single Site conventional system is a digital conventional two-way MOTOTRBO 
system that includes one digital repeater and allows you to transmit voice and data 
via two conventional channels. Radio groups and radio units are assigned to radio 
channels. 

3.2.2 IP Site Connect 
An IP Site Connect (IPSC) system is a digital conventional two-way MOTOTRBO 
system that allows you to increase the RF coverage area of your communications, 
providing two wide-area channels. It is possible to connect up to 15 repeaters (each 
geographical location of a repeater is called a "site") to one system using IP 
connection, which allows increasing the coverage area for voice and data 
transmissions. The main objective of IPSC systems is to provide a stable connection 
between the radio units and control centers regardless of the distance. 

TRBOnet
RadioServer

Dispatcher 1 Dispatcher 2 Dispatcher 3

LAN/WAN

Site 1 Site 2 Site 3

Master Repeater 1  Peer Repeater 2  Peer Repeater 3 
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3.2.3 Capacity Plus 
Capacity Plus (also known as Capacity Plus Single Site) is a digital trunked two-way 
MOTOTRBO system that allows you to accommodate high volume communication. 
It is designed to provide a stable connection between a few groups within one 
building or a set of buildings. This system type allows you to increase the number of 
channels for voice and data transmission between the radio units and control 
centers. The radio units are always automatically forwarded to a free channel. The 
main objective of Capacity Plus is to support more simultaneous voice and data 
transmissions within one capacious system. 

Dispatcher 1

Dispatcher 2

Dispatcher 3

LAN/WAN

Talk Group 2

Talk Group 1

TRBOnet
RadioServer

Voice Repeater 2 

Master Voice Repeater 1 

Voice Repeater 3 

Data Repeater 4 

Data Repeater 5 
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3.2.4 Linked Capacity Plus 
Linked Capacity Plus (also known as Capacity Plus Multi Site) is a digital trunked 
multisite two-way MOTOTRBO system that enables you to accommodate high 
volume and wide area communication that is required for your business allowing 
you to connect via IP up to 15 single Linked Capacity Plus sites located in one place 
or in separated territories. This system type allows you to increase the RF coverage 
area and the number of channels for voice and data transmission between the radio 
units and control centers. The main objective of Linked Capacity Plus is to support 
more simultaneous voice and data transmissions regardless of the distance. 

TRBOnet
RadioServer

Dispatcher 1

Dispatcher 2

Dispatcher 3

LAN/WAN

Site 1
Voice Repeater 1 Voice Repeater 2 Data Repeater 3 Data Repeater 4

Switch 2

Switch 1

Site 1

Voice Repeater 5 Voice Repeater 6 Data Repeater 7 Data Repeater 8

Switch 3

Control 
Station 1

Control 
Station 2

Control 
Station N  
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3.2.5 Connect Plus 
Connect Plus is a digital trunked multisite two-way MOTOTRBO system that enables 
you to accommodate high volume, wide area communication that’s required for 
your business allowing you to connect via IP multiple sites located in one place or in 
separated territories. This system type allows you to increase the RF coverage area 
and the number of channels for voice and data transmission between the radio units 
and control centers. The radio units are always automatically forwarded to the 
control channel. The main objective of Connect Plus is to support more 
simultaneous voice and data transmissions regardless of the distance as well as to 
provide a more structural addressing of the transmissions provided by XRC and XRT 
controllers. 

Dispatcher 1

Dispatcher 2

Dispatcher 3

TRBOnet
RadioServer*

LAN/WAN

Voice Repeater 3

Switch 2

Talk Group 1

Talk Group 2

Talk Group 3

Talk Group 4

XRC 9000

Switch 1

XRC 9000

Voice Repeater 1

Data Repeater 2 Data Repeater 4

XRT 9000

* RadioServer requires connections to the only one XRT 9000 Controller and one XRC 9000 Controller in the system
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3.2.6 Capacity Max 
Capacity Max is MOTOTRBO's next-generation trunking solution. Built on the DMR 
Tier III Mode of Operation, it delivers smooth scalability, low cost of ownership and 
reliable operation. 

 

3.3 IP Backend Network Requirements 
Before planning any of IP connected MOTOTRBO systems, read System Planner 
(chapter 4.6.3.2 Characteristics of Backend Network). 

• Delay/Latency 
The amount of time it takes for voice to leave the source repeater and reach 
the destination repeater. The delay should be less than 60 ms. It can be up to 
90 ms, but requires changes in CPS for both radio units and repeaters. 

• Jitter 
The variation of the packet inter-arrival time. It should be less than 60 ms. 

• Packet Loss 
In the case of voice, the ongoing call ends if six consecutive packets do not 
arrive within 60 ms of their expected arrival time. In the case of data, the 
repeater waits for the expected number of packets (as per the data header) 
before ending the call. 

• Bandwidth 
Refer to System Planner for bandwidth calculations, but roughly, it requires 96 
kbps for each repeater connection and should be summed up for all repeaters. 

If the IP backend network does not satisfy MOTOTRBO requirements, it will degrade 
audio quality significantly up to dropped voice calls. 
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3.3.1 Linked Capacity Plus Specific Requirements 
• Addresses and Ports 

A static IP Address and UDP Port for the master repeater must be made 
available to all peer devices on the Linked Capacity Plus system. 
 When a peer device registers with the master repeater, the network supplies 

the return IP address and UDP port of the peer device to the master 
repeater. The IP address and UDP port must then be made available to all 
other MOTOTRBO™ LCP devices on the system. 
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4 TRBOnet PLUS Software and Dependencies 
Installation 

4.1 Preparing and Updating the Base OS 
For all platforms, we recommend that before installing TRBOnet you upgrade your 
OS to the latest Service Pack and install critical updates available from Windows 
Update. 

4.2 Installing Microsoft SQL Server 
Download and install Microsoft SQL Server 2008 R2 or higher. 
You can download and install either a full-featured MS SQL Server or an Express 
edition of MS SQL Server. The Express edition of MS SQL Server is free, however, it 
has some technical restrictions (maximum database size, RAM usage, etc.). 
For example, Microsoft SQL Server 2008 R2 SP2 - Express Edition (which is free) is 
available at: 
http://www.microsoft.com/en-us/download/details.aspx?id=30438 

Note: We recommend that you download a version of SQL Server with 
Tools. 

Select the 32-bit or 64-bit version depending on the underlying OS. Accept the 
defaults for the setup. 

4.3 Installing .NET Components 
Windows 8 and later, as well as Windows Server 2012 and later, include the required 
.NET 4.6 components as part of the operating system. 
For the TRBOnet PLUS Compatibility Table, see 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=73 
The .NET Framework redistributables are available from Microsoft at: 
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework 

4.4 Installing TRBOnet PLUS 
• Contact Neocom Software to obtain the latest installation package of the 

TRBOnet PLUS software, unzip, and run the setup file as a local administrator. 
• When the TRBOnet PLUS Setup wizard opens, click Next. 
• On the End User License Agreement page, accept the terms of the license, 

and then click Next. 

http://www.microsoft.com/en-us/download/details.aspx?id=30438
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=73
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework
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• On the Choose Setup Type page, click one of the following options: 
 TRBOnet Dispatch Console 

Choose this option to install only TRBOnet Dispatch Console on your 
computer. 

 TRBOnet Server and Dispatch Console 
Choose this option to install both TRBOnet Server and 
TRBOnet Dispatch Console at once on your computer. 

 Custom 
Choose this option to select from the list one or more components to be 
installed. 

 

For example, you may install only TRBOnet Server: 
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• Accept the defaults for the rest of the setup and complete the installation. 
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5 TRBOnet Server 
To start TRBOnet Server, click the corresponding shortcut on the desktop, 
or click Start > All Programs > Neocom Software > TRBOnet Server x.x 

5.1 License Information 
The TRBOnet software requires a valid license. 

5.1.1 License Types 
There are three license types available for TRBOnet PLUS: 

License 
Type Demo Trial Commercial 

Validity 60 days By Request Permanent (non-expiring) 

Quantity of 
Control 
Stations and 
Radio Units 

Up to 2 control stations 
or 1 IP repeater 
connection 

10 Radio Units 

By Request According to Customer order 

Features Limited functionality By Request According to Customer order 

How to 
obtain 

It can be downloaded 
from the web page. 

Assigned to server’s 
Hardware ID. 

For more details on 
Hardware ID, see 
the article. 

Assigned to server’s Hardware ID. 
For more details on Hardware ID, 
see the article. 

Assigned to the serial numbers of 
master repeaters and control 
stations. To retrieve serial 
numbers, use Control Station 
CodePlug (do not rely on a serial 
number printed on the device’s 
label). 

For more information on the license and renewals, contact our technical support at info@trbonet.com 

To see how the Hardware ID and control stations and/or repeaters are assigned in 
your license, open the INFO file delivered with the license file (e.g., in Notepad): 

 

1. Your license is assigned to the Hardware ID. 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=31
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=31
mailto:info@trbonet.com
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2. Your license is assigned to the serial numbers of master repeaters and control 
stations. 

5.1.2 Moving TRBOnet Server to a Different Server PC 
In case you need to use TRBOnet Server on a different server PC, please contact your 
Neocom sales representative for further instructions. 

5.1.3 Using Spare Repeaters 
In case you are planning to use spare repeaters, for example, as replacement for 
damaged ones, you need to mention all of them when ordering a license. 
For example, you have 3 repeaters to use with TRBOnet Server and 1 spare repeater. 
In this case, mention the following repeaters limitation: 3, and send the serial 
numbers of 4 repeaters when placing an order (including the spare repeater’s serial 
number). 

5.1.4 License Manager 
• In the Configuration pane on the left, select License. 

In the right pane, you can see the text of your current license. 

 

To apply the new license: 

• Click the License Manager link in the right pane. 
The License Manager wizard opens. 

• Click Next. 
• Click …  on the right-hand side of the License file box. 

The Open dialog box opens. 
• Locate the license file you received from our technical support and click Open. 

The full path of the license file appears in the License file box. 
• Click Next. 
• Click Finish to close the wizard. 
• Click Apply and then confirm to restart TRBOnet Server. 
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Note: To use a single license for multiple TRBOnet software 
instances, you need TRBOnet License Server. For detailed 
instructions on how to use TRBOnet License Server, see 
TRBOnet License Server Configuration Guide. 

5.2 Creating TRBOnet Server Database 
• In the Configuration pane, select Database. 

 

• In the Database pane, specify the following database-related settings: 
 SQL Server 

Enter the location of the Microsoft SQL Server name and instance. For 
example, in the screenshot above, the default instance name of Microsoft 
SQL Server Express installed on the local computer is shown. 

 Database 
Enter the preferred name of the TRBOnet database. 

 Authentication 
Select the authentication method for the TRBOnet database. The default 
method is Windows Authentication. See also the Database Authentication 
section. 

 Login and Password 
Enter a valid SQL Server login and password if the SQL Server 
Authentication is selected for the database; 

 Specify the path for database archives 
Select this option, and in the corresponding Path box enter the full path of 
the custom folder for database backups. 

 Use custom folder for audio files 
Select this option, and in the corresponding Path box enter the full path of 
the custom folder for audio recordings of the talk sessions. 
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Note: If you don't specify folder paths for the database archives 
and audio files, TRBOnet Server will use the following 
default paths: 
%ProgramData%\Neocom Software\TRBOnet PLUS\Backups - for 
database archives. 
%ProgramData%\Neocom Software\TRBOnet PLUS\Audio - for 
audio. 

• When you finish configuring the required database parameters, click Create 
Database. 

• After you create or upgrade a database, click Apply and then confirm to 
restart TRBOnet Server. 

5.2.1 Database Authentication Methods 
5.2.1.1 Windows Authentication 

• From the Authentication drop-down list, select Windows. 

 

To provide access permissions for TRBOnet Server to connect to SQL Server, create 
an account with sysadmin privileges. 
During the installation process, MS SQL Server 2008 automatically grants sysadmin 
privileges to the NT Authority\SYSTEM account. 
In the case of MS SQL Server 2012 and higher versions, add the 
NT Authority\SYSTEM account to the Administrators group during the installation 
process. If the DB owner privileges are required to work with TRBOnet Database, you 
need to assign the sysadmin role to the Local System account. For instructions on 
how to install and configure MS SQL Server 2012, see 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=72 

5.2.1.2 SQL Server Authentication 
• From the Authentication drop-down list, select SQL Server. 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=72
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To connect to SQL Server using SQL Server Authentication, create an SQL login 
with sysadmin privileges in the SQL Server in use. For detailed instructions on how 
to create an SQL login, see 
http://technet.microsoft.com/en-us/library/aa337562.aspx 

5.3 Installing TRBOnet Server Service 
• In the Configuration pane, select Service. 

 

• In the Service pane, specify the following service-related parameters: 
 Choose the required logon type: 

Logon as Local System 
Choose this option to use an account with local system administrator 
privileges to run the service as a Windows service (Recommended); 
Logon as User 
Choose this option to use a different account to run the service as a 
Windows service. This account must allow the user to run services in 
Windows, have read and write access to the Neocom Software folder and 
subfolders in the “%ProgramFiles%” and “%ProgramData%” folders. For 
example, using such an account may be required in the following cases: 

http://technet.microsoft.com/en-us/library/aa337562.aspx


  

20 TRBOnet PLUS — Administrator’s Guide 

1. An Active Directory domain network is used, and the current Windows user 
is not allowed to use a Local System account to launch services on the 
local PC due to domain policy restrictions. 

2. MS SQL Server is installed on a remote PC, and Windows Authentication 
(see section 5.2.1) has been selected to connect to the database. 

 Click Install Service. 
 Click the Start Service link that appears in the right pane. 

5.4 Configuring Network Parameters 
• In the Configuration pane, select Network. 

 

• In the Network pane, specify the following network-related parameters: 
 Network interface 

Select the network interface from the drop-down list. Click  to refresh the 
list of network interfaces available on your PC. 

 Command port 
Enter the port number to be used by Dispatch Console to connect to the 
server (4021, by default). 

 First VoIP port 
Enter the number of the first VoIP port for audio communications (4022, by 
default). Each additional Dispatch Console will establish a connection on the 
next available port number. 

 VoIP protocol 
Select the VoIP protocol type from the drop-down list: 
• All - UDP will be used first; if unavailable, TCP will be used; 
• TCP - slower but more reliable (set by default); 
• UDP - faster but packets can be lost; some routers may drop 

UDP packets. 



TRBOnet Server 

21 

 Data protocol 
From the drop-down list, select the protocol to exchange data other than 
voice (TCP, by default). 

 Use broadcast mode for audio 
Select this option to optimize voice transmission quality and minimize 
transmission delay. Note that when the broadcast mode is set, Dispatch 
Console cannot run on the same machine as TRBOnet Server, and a warning 
message will appear when you select this option. 

 Broadcast port 
Enter the port number to be used to broadcast audio (5000, by default). 

 Use proxy server 
Select this option to enable an alternative proxy server for TRBOnet 
Dispatch Software to access Internet. 

• Click the Configure link to specify the alternative server settings: 

 

 Use an alternative server 
Select this option to enable an alternative proxy server. 

 Address 
Enter the proxy server IP address. 

 Port 
Enter the proxy server port number. 

 Use authentication 
Select this option to use an individual login and password to connect to the 
alternative proxy server. 

 Login 
Enter the login for the authentication. 

 Password 
Enter the password for the authentication. 

• After you configure the proxy server settings, click OK. 
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 Encrypt data over network 
Select this option to guarantee the security of data transfer between 
TRBOnet Server and Dispatch Console, and/or TRBOnet Agent. It is 
recommended that this option be used when a connection between system 
components is established via the Internet or other public networks. 

5.4.1 Configuring Backup Configuration 
TRBOnet Server supports backup configuration, which allows smooth switching 
between the working servers in case of a failure for the Dispatch Consoles. 

• In the Configuration pane, select Redundancy. 

 

• In the Redundancy pane, select the Redundant server mode option. 
• Redundancy Mode 

Select the mode for a backup server from the drop-down list. 
• To add a main server, click Add. 

 

• IP Address 
Type the IP address of the main server. 

• Port 
Enter the same port number as specified for the Command port. 

5.5 Service Management 
The Service Management pane allows you to specify various parameters for the 
Check Radio, Location, Telemetry, TMS, and Indoor services. 

• In the Configuration pane, select Service Management. 
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• In the Service Management pane, specify the following service-related 
parameters: 

5.5.1 Automatic "Check Radio" Service 
The Automatic "Check Radio" service group includes the following registration-
related parameters: 

• Auto request presence timeout 
Enter the time interval that will be used to regularly check a radio unit for 
inactivity. A radio is considered inactive (or, offline) if it does not send any GPS, 
Text, ARS, or Voice messages. If you do not have a dedicated channel for data 
revert, use the following table: 

Number of 
radio units 

ARS request presence 
timeout (minutes) 

Number of 
radio units 

ARS request presence 
timeout (minutes) 

up to 10 5 30 to 40 17 

10 to 20 9 40 to 50 21 

20 to 30 13 over 50 120 

• ARS refresh timeout 
Enter the value of the parameter that determines how often a radio unit will 
send ARS packets. It is recommended that a value of 30 minutes be used for 
this interval. 

• Ignore unregistered Radios 
Select this option so that unregistered radio units will be ignored and thus 
won't appear in Dispatch Console. 

5.5.2 Location Service 
The Location Service group includes the following location-related parameters: 
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• Dispatch Console update interval 
Enter the time interval that will be used to send GPS data packages to the 
Dispatch Consoles. 

• Automatic error correction 
Select this option to enable automatic error correction to detect and correct 
invalid GPS data. 
Click the Configure link to specify the GPS correction parameters: 

 

Discard GPS data if 

 Speed greater than 
Select this option and enter the maximum possible speed of your vehicles. 
As a result, the coordinates falling out of the appropriate speed range will 
be discarded. 

 Location accuracy worse than 
Select this option and enter the maximum accuracy of your GPS receivers so 
that the coordinates falling out of the acceptable range will be discarded. 

 GPS time error greater than 
Select this option and enter the time, in minutes, that will be used to 
discard the coordinates falling out of the appropriate time range. 

 Coordinates have duplicates 
Select this option to remove duplicate coordinates from GPS data. 

 Consider speed zero if less than 
Select this option and enter the low-speed threshold, below which the 
speed will be considered as zero by the server. 

• Send the latest GPS data to dispatchers on alert 
Select this option so that dispatchers receive the latest GPS data when alert 
happens. Then choose one of the following options: 
 For the last X minutes 

Choose this option and enter the time, in minutes, to be used as the last 
time period for the latest GPS data. 

 GPS points 
Choose this option and enter the number of GPS points to be used for the 
latest GPS data. 
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5.5.3 Telemetry Service 
The Telemetry Service group includes the following telemetry-related parameters: 

• Request for the status of GPIO when a radio unit is powered on 
Select this option to enable the server to request for the status of a radio unit 
telemetry when a radio is powered on. 

5.5.4 Text Messaging Service 
The Text Messaging Service group includes the following message-related settings: 

• Text Message format 
From the drop-down list, select one of the pre-defined formats for text 
messages, or select the Custom format. 

• Custom Format 
Enter your own format for text messages in this box, if you have selected 
'Custom' from the list above. 

• Max. message length 
Enter the maximum number of characters allowed in a text message. 

• Split long message into multiple messages 
Select this option to allow long messages to be split into multiple smaller 
messages. 

5.5.5 Indoor Service 
The Text Messaging Service group includes the following indoor-related 
parameters: 

• Remove offline radios from an Indoor map 
Select this option so that offline radios are not shown on the 2D/3D floor 
plans. 

• Ignore beacon position on alarm if GPS is fixed (only K-TERM) 
Select this option so that beacon positioning is ignored in case of alarm when 
a radio has a detected GPS position. 

Note: This feature relates only to K-TERM beacons. 

5.6 Advanced Settings 
• In the Configuration pane, select Advanced Settings. 
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• In the Advanced Settings pane, specify the following advanced parameters: 
 Language 

From the drop-down list, select the interface language for TRBOnet Server. 
 Logging level 

From the drop-down list, select the logging level, which determines the 
amount of data stored in the System Log. 

Note: This information is used by technical support for 
troubleshooting purposes, so it is recommended that this 
value be kept unchanged (Normal). 

 Audio Recording format 
From the drop-down list, select the format to be used to store audio 
recordings. The available formats are WAV and TNA. 

Note: The TNA format is a proprietary audio format that contains 
additional information about radio calls, such as radio ID, 
start time, end time, etc. This format provides more details 
about call participants and allows easy navigation within 
recorded audio files. 

 Audio Recording codec 
From the drop-down list, select the audio codec to be used to compress 
audio files. 

 Measurement system 
From the drop-down list, select either the Metric or the US unit system. 

 Latitude/Longitude format 
From the drop-down list, select the format of Latitude/Longitude pairs. 

 TX Passive timeout 
Enter the time period, in hours, that will be used to store messages while 
the transmission channel is unavailable ('Unlimited' recommended). 
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 Voice Mail timeout 
Enter the time period, in hours, during which TRBOnet Server will keep 
trying to deliver the voice mail message to the recipient ('Unlimited' 
recommended). 

 Text Message Passive timeout 
Enter the time period, in hours, during which TRBOnet Server will keep 
trying to deliver the text message to the recipient ('Unlimited' 
recommended). 

5.6.1 Geocoding Servers 
Geocoding servers resolve GPS coordinates to street addresses for reporting 
purposes and other needs, for example, for reports, such as 'GPS activity for period' 
reports. Online geocoding services, such as Google or Nominatim, can be used. 
However, their use may be limited by the number of requests. Furthermore, you can 
add custom geocoding servers to the system. 
You can configure geocoding servers in three various ways depending on whether 
the Server and/or Dispatch Console have Internet access and on your local 
geocoding server settings: 

1. The Dispatch Console has Internet access and the Server has no Internet 
access. The Dispatch Console can connect to preconfigured (Google and 
Nominatim) and/or local corporate geocoding servers via the Dispatch 
Console. 

2. The Server has Internet access and Dispatch Console has no Internet access. 
The Dispatch Console can connect to preconfigured (Google and Nominatim) 
and/or local corporate geocoding servers via the Server (follow the 
instructions below). 

3. You have your own Geocoding server in the local network. In this case, you 
can configure data resolving in both the Server and the Dispatch Console. 

5.6.1.1 Configuring Geocoding Servers 
• In the Configuration pane, select Geocoding Servers. 
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• In the Geocoding Servers pane, specify the following geocoding-related 
parameters: 
 Use MapPoint location resolving 

Select this option to get street addresses from MapPoint, and enter the 
MapPoint Application ID. MapPoint is a service from Microsoft that is 
used to transform coordinates into street addresses. 

 Google and Nominatim 
These are pre-configured geocoding servers, which allow resolving GPS 
coordinates to street addresses and street addresses to GPS coordinates. 

Note: These geocoding servers can't be deleted from the system. 

 Click Add to add a geocoding server to the system. 

 

• Server Name 
Enter the name of your geocoding server. 

• Get address by coordinates 
Select this option to resolve GPS coordinates to street addresses. 
In the box below, enter the server address with the appropriate 
parameters. 

Note: Keep in mind that the {lat} and {lon} variables are 
mandatory to allow TRBOnet Dispatch Console to retrieve 
GPS coordinates from the radio unit. 

Click Test to check the connection to the geocoding server. Enter a pair 
of GPS coordinates and see if the resolved street address appears. 

• Get coordinates by address 
Select this option to resolve street addresses to GPS coordinates (for 
example, for the Search By Address feature). 
In the box below, enter the server address with the appropriate 
parameters. 

Note: Keep in mind that the {address} variable is mandatory to 
allow TRBOnet Dispatch Console to search map objects by 
address. 
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Click Test to check the connection to the geocoding server. Enter an 
address and see if you get the list of map objects corresponding to the 
address entered. 

 Use the Up ( ) and Down ( ) buttons to move the selected geocoding 
server up and down in the priority list of geocoding servers. When 
requesting GPS data via the geocoding servers configured in TRBOnet 
Server, it requests GPS data from the geocoding servers according to the 
priority level. The first geocoding server in the list has the highest priority 
level. In case the first geocoding server is unavailable, data will be 
requested from the second geocoding server in the list, and so forth down 
the list of geocoding servers. 
The administrator must ensure that the geocoding servers in the list are 
able to resolve GPS data. 

 Request address when GPS coordinates are received 
Select this option to resolve GPS coordinates to street addresses 
immediately by a GPS event. Note that street addresses and GPS 
coordinates are stored in the TRBOnet database to optimize the response 
time for street address requests (for example, GPS reports) and to reduce 
geocoding server load. 

5.7 Radio Networks 
The Agent is a gateway between the radio network and the IP network. Enable 'Local 
Agent' to connect TRBOnet Server to a radio system. Otherwise, you should use 
Remote agents. 

• In the Configuration pane, select Radio Networks. 
• In the Radio Networks pane, select Enable Radio Networks. 

Or, in the Configuration pane, right-click Radio Networks and choose Use 
Radio Networks. 

 

• In the Configuration pane, select Digital Systems. 
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• In the Digital Systems pane, select or make sure Enable Digital Systems is 
selected. 

 

• In the Digital Systems pane, specify the following parameters: 
 CAI Network 

The CAI Network is a value that is combined with the Radio ID to produce 
the individual radio's air interface network IP address. All radios must use 
the same CAI Network ID to be able to exchange data. It is recommended 
that the default value of 12 is used. 

 CAI Group Network 
The CAI Group Network is a value that is combined with the Group ID to 
produce the group's air interface network IP address. The CAI Group 
Network ID forms the first or most significant byte of each group's network 
IP address. All radios must use the same CAI Group Network ID to be able 
to exchange data (225, by default). 

Note: The values of these two parameters must match those 
configured for the radio units via the MOTOTRBO CPS. 
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5.7.1 Digital System Elements 

 

All radio system elements based on MOTOTRBO services are represented in the 
Registered Digital Systems table, including their type (Control Station, Repeater, 
etc.), IP Address, and Radio ID (1): 

• To add an element to the system, click Add and select the element type from 
the drop-down menu (2). 

5.7.2 MOTOTRBO Services 
• In the Configuration pane, under MOTOTRBO, select Services: 
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• In the Services pane, specify the following MOTOTRBO Services-related 
parameters: 
 Automatic Registration Service (ARS) 

Select this option to enable the ARS service for the radios. When the radio 
powers up, the radio automatically registers with the server. This feature is 
used with data applications, i.e. any data traffic on this channel that is 
associated with an application server such as MOTOTRBO Text Messaging 
or MOTOTRBO Location Services. 
• Port 

Enter the local port number for the ARS service (4005, by default). 
 Telemetry service (TLM) 

Select this option to enable the Telemetry service, which is the wireless 
transmission and reception of measured quantities for remotely monitoring 
environmental conditions or equipment parameters. 
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• Port 
Enter the local port number for the Telemetry service (4008, by default). 
4008 set by default. 

 Text Messaging service (TMS) 
Select this option to enable the Text Messaging service which is used to 
exchange text messages between the radios and the dispatchers. 
• Port 

Enter the local port number for the Text Messaging service (4007, by 
default). 

 Location Service (GPS / Indoor) 
Select this option to enable the Location service. The radio can send its 
coordinates when it is in Global Positioning or iBeacon coverage area. 
• Port 

Enter the local port number for the Location service (4001, by default). 
 Text Messaging service (DMR) 

Select this option to enable the DMR-based Text Messaging service. 
• Port 

Enter the local port number for the DMR-based Text Messaging service 
(5016, by default). 

 Indoor Service (K-TERM) 
Select this option to enable the Indoor Location service. 
• Port 

Enter the local port number for the Indoor service (3022, by default). 
 Tallysman Sprite service 

Select this option to enable the service for autonomous event and 
aggregated event reporting to provide significant reduction in GPS data 
overhead. 
• Port 

Enter the local port number for the Tallysman Sprite service (4004, by 
default). 

 FS 5000 location service (GPS) 
Select this option to enable the FS 5000 location service, which is a service 
for transmitting GPS data packages. This service uses FS 5000 Option Board. 
• Port 

Enter the local port number for the FS 5000 location service (4004, by 
default). 

 Swift.Tracker service 
Select this option to enable the service to transmit coordinates and data 
packages via a radio channel using the Swift.Tracker TR001.M1 device. 
• Port 

Enter the local port number for the Swift.Tracker service (4004, by 
default). 
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 Swift.Tracker service (GSM channel) 
Select this option to enable the service to transmit coordinates and data 
packages via a radio channel and a reserved GSM channel using the 
Swift.Tracker TR001.M1 device. 
• Port 

Enter the local port number for the Swift.Tracker service (4080, by 
default). 

 Extended Text Messaging service 
Select this option to enable the Extended Text Messaging service to include 
sending detailed preconfigured templates with the help of TRBOnet 
Dispatch Software. 
• Port 

Enter the local port number for the Extended Text Messaging service 
(4010, by default). 

 Telemetry service NOVOX 
Select this option to enable the Telemetry service based on NOVOX devices. 
• Requests port 

Enter the local port number to listen for requests (8090, by default). 
• Events port 

Enter the local port number to listen for events (8091, by default). 
 G4S RS232 

Select this option to enable the custom developed G4S RS232 service. 
• Port 

Enter the local port number for the G4S RS232 service (4004, by default). 
 Zebra printer service 

Select this option to enable the service for printing Job Tickets. A Zebra 
printer is connected to a radio via Bluetooth. The radios should be 
Bluetooth-enabled. 
• Port 

Enter the local port number for Zebra printer service (4072, by default). 

5.7.3 Adding a Control Station 
• In the Digital Systems pane, click Add. 

Or, in the Configuration pane, right-click Digital Systems. 
• In the drop-down menu, click Add Control Station. 
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• In the Control Station pane, specify the following control station-related 
parameters: 
 Name 

Enter a name for the control station. This name will be displayed in the 
Dispatch Console. 

 Radio ID 
This is the Radio ID of the radio unit connected as a control station. 
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is 
65535). 

Note: This box is populated automatically once you have 
successfully tested the control station by clicking the Test 
button. 

 IP Address 
Enter the IP Address of the control station network interface; 

 Test 
Click this button to check the connection to the control station. If the test 
succeeds, you'll see information on the control station you are connected 
to, such as radio ID, serial number, firmware version, etc. 

 Mode 
From the drop-down list, select the connection mode for the control station 
being configured. For more details, see section 5.7.3.1, Control Station 
Connection Modes. 

 System Identifier 
Enter the system identifier if the control station is used with a Capacity Plus 
or Linked Capacity Plus system. Note that the system identifier should be 
the same for all control stations used in the radio system. 

 Use the radio for RX data only (GPS Revert or Data Revert) 
Select this option to configure the radio channel so that it will only receive 
data, thus having no any transmission capability. 
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 Playback device 
From the drop-down list, select the playback device connected to the 
control station. 

 Recorder device 
From the drop-down list, select the recording device connected to control 
station. 

5.7.3.1 Control Station Connection Modes 

Single Control Station 
The Single Station mode is the simplest connection mode for receiving and 
transmitting voice and data through a conventional channel using one control 
station at this particular frequency. 

Dispatch ConsoleTRBOnet 
RadioServer

LAN/WAN

Control Station

Subscriber #1

Subscriber #2

Subscriber #N

 

IP Site Connect 
The IPSC is a digital conventional two way MOTOTRBO system that allows you to 
extend the area of your communications by providing 2 wide area channels. It is 
possible to connect up to 15 repeaters in one system using IP connection. 
The Server Connection Modes are as follows: 

1. TRBOnet Server is connected to a repeater with two time slots in the "IP 
Site Connect" mode. The Server can transmit and receive over IP. 

2. TRBOnet Server has no IP connection to a repeater. To transmit and 
receive, two control stations are required, that is one control station per 
time slot. 
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TRBOnet
RadioServer 

Dispatcher 1 Dispatcher 2 Dispatcher 3

LAN\WAN

Site 1 Site 2 Site 3

Control Station
 Slot 1

Control Station
 Slot 2

USB
 + 

Audio

USB
 + 

Audio

Repeater 1 Master Repeater 2 Peer Repeater 3 Peer 

 

Common Channel 
The Common Channel is a mode where it is possible to use multiple simplex base 
stations operating at the same frequency with overlapping communication zones. 
This mode allows the customer to provide radio coverage of large areas when there 
is only one frequency and additional frequencies are unavailable. While in this mode, 
the coverage area is being extended only for the dispatcher, and specifically when 
operating at one and the same frequency. When a radio unit initiates a call, the 
signal that can potentially be received by several base stations will be filtered on the 
server side so that repeated audio playback and recording be prohibited. 
The signal filtering is preformed based on the "first packet", that is only the signal 
coming first to the server is played back and recorded, while the remaining signals 
are discarded. 
When a dispatcher initiates a call to a specific base station, the signals received by 
the neighboring base stations will be discarded to prevent dispatchers from listening 
to their own call at the time of transmission. The dispatcher is not recommended to 
use a simultaneous call to all base stations to avoid interference in the subscribers' 
area. 
The best way to use this mode is as follows: each base station is configured with its 
own color code, and radio units are equipped with option boards having a Geo-
roaming feature, and each geographic area is assigned its own radio channel with 
the corresponding color code. 
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Dispatch Console

TRBOnet
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Capacity Plus TRBOnet 
Capacity Plus TRBOnet is a limited option. All voice and data are received via IP. At 
least one control station is required for outgoing voice and data session at a time. 
Private calls and SIP calls require dedicated control stations. 

Dispatcher 1

Dispatcher 2

Dispatcher 3

TRBOnet
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AN

Talk Group 1
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Audio
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Voice Repeater 2

Voice Repeater 3

Data Repeater 4

Data Repeater 5
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Capacity Plus MOTOTRBO 
Capacity Plus MOTOTRBO is a digital trunked two-way MOTOTRBO system that 
allows you to accommodate high volume communication. It is designed to organize 
stable connection in a few groups within one building or a set of buildings. This 
system type allows you to increase the number of channels for voice and data 
transmission between the subscribers and control centers. The subscribers are 
always automatically forwarded to a free channel. The main objective of Capacity 
Plus MOTOTRBO is to support more simultaneous voice and data transmissions 
within one capacious system. 
In the Capacity Plus MOTOTRBO mode you can configure voice and data control 
stations to transmit and receive data over the air as it is displayed in System Planner. 
Keep in mind that two data control stations are required per each data repeater – 
one per time slot. TRBOnet Dispatch Software provides you an option to utilize an IP 
connection to receive voice and data. 

TRBOnet
RadioServer

Dispatcher 1

Dispatcher 2

Dispatcher 3

LA
N\

W
AN

Talk Group 1

Talk Group 2

USB
+

Audio

Voice Control Station(s)
1 Voice CS per 1 talk 
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Data Control Station(s)
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USB
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5.7.3.2 Advanced Settings 
• In the Configuration pane, under the corresponding Control Station, select 

Advanced Settings. 
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• In the Advanced Settings pane, specify the following control station-related 
advanced settings: 
 Automatically reset alarm mode 

Select this option to reset alarm mode on the control station radio 
automatically. It is recommended to enable this option. 

 Automatically handle call alert 
Select this option to automatically redirect call alerts from the control 
station radio to the Dispatch Console. 

 Emergency Call/Alarm indication 
Select this option so that audio and visual indication is given by the control 
station radio when an emergency Call/Emergency Alarm is received. 

 Use front microphone 
Select this option to use a remote speaker microphone on the radio. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 

 Use serial port for PTT key up 
Select this option to use a remote control of the PTT button via the radio's 
serial port. 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 Signaling system 
From the drop-down list, select the signaling system. 
• MDC 1200 signaling is a Motorola data system using audio frequency 

shift keying (ASFK) using a 1,200 baud data rate. A general option is to 
enable or disable an acknowledgement (ACK) data packet. 
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• SELECT 5 (5 Tone Signaling System). In the 5 Tone Signaling Systems, 
each radio has a unique numeric identity (e.g. 12345). To signal the 
number 12345, a sequence of 5 tones is sent. Sequences of audible 
tones of a very short duration are sent between radios. Most 5 tone 
sequences take less than half a second to send. Available for Voice Calls, 
Check Radio, Call Alert, and Enable/Disable Radio. 
Click the Configure link and specify desired SELECT 5 settings. 

 

5.7.4 Adding a MOTORBO Repeater 
• In the Digital Systems pane, click Add. 

Or, in the Configuration pane, right-click Digital Systems. 
• In the drop-down menu, click Add MOTOTRBO System. 

 

• In the Repeater pane, specify the following repeater-related parameters: 
 System Name 

Enter a name for the repeater. This name will be displayed in the Dispatch 
Console. 

 TRBOnet Peer ID 
Enter a Peer ID for TRBOnet Server. The Peer ID must be unique among the 
repeaters in the radio system. 
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 TRBOnet Radio ID 
Enter the Radio ID, which is a gateway for voice and data. The Radio ID 
must be unique in the radio system (for Capacity Plus and Linked Capacity 
Plus systems, the maximum value is 65535). 

 TRBOnet Local Port 
Enter the local port number that will be used by TRBOnet Server to 
establish connections for the repeater. Use unique port numbers for each 
repeater connection if there are several repeaters connected. 

 Master IP Address 
Enter the Ethernet IP address of the repeater. 

Note: This value is programmed for a repeater via MOTOTRBO 
CPS, in Link Establishment>Master IP. 

 Master UDP Port 
Enter the UDP port number of the master repeater. 

Note: This value is programmed for a repeater via MOTOTRBO 
CPS, in Link Establishment>Master UDP Port. 

 Authentication Key 
Enter the repeater's authentication key (if any). 

Note: This value is programmed for a repeater via MOTOTRBO 
CPS, in Link Establishment>Authentication Key. 

 System Type 
From the drop-down list, select the system type. 

 Test 
Click this button to check the connection to your master repeater. If the test 
succeeds, you'll see information on the repeater you are connected to, such 
as the serial number, firmware version, etc. 

 System Identifier 
Enter the system identifier if a Capacity Plus or Linked Capacity Plus system 
is used with one or more control stations. Use the same system identifier as 
you have specified for the corresponding control stations. 

 Use NAI Voice 
Select this option to connect to the repeater via NAI (Network Application 
Interface) for Voice transfer. 

 Use NAI Data (MNIS and DDMS) 
Select this option to connect to the repeater via NAI (Network Application 
Interface) for Data transfer. 
• MNIS 

MOTOTRBO Network Interface Service is a Windows application which 
acts as a data gateway between the data applications and the radio 
system. Data messages are routed through the MNIS. 
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• DDMS 
Device Discovery and Mobility Service is a service to receive data to a 
repeater. 

5.7.4.1 Advanced Settings 
• In the Configuration pane, under the corresponding Repeater, select 

Advanced settings. 

 

• In the Advanced Settings pane, specify the following repeater-related 
advanced settings: 
Voice Call Hang Time (ms): 
 Group Call 

This value sets the duration the repeater reserves the channel after the end 
of a group call transmission. During this time, only members of the group 
that the channel is reserved for can transmit. 

 Private Call 
This value sets the duration a radio keeps the private call setup after a user 
releases the PTT button. This is to avoid setting up the call again each time 
a user presses the PTT button to transmit. During this time, other radios can 
still transmit since the channel is essentially idle. After the hang timer 
expires, the radio transmits using the TX Contact Name parameter specified 
for this channel in MOTOTRBO CPS. 

 Emergency Call 
This value sets the duration the repeater reserves the channel after the end 
of an emergency call transmission. During this time, only members of the 
Group that the channel is reserved for can transmit. 

Note: The values of the above three parameters must be taken 
from the corresponding parameter values programmed for 
the repeater via MOTOTRBO CPS in General Settings. 
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 TX Preamble 
Enter the value of the TX Preamble. The TX Preamble is a string of bits 
added in front of a data or control message (Text Messaging, Location 
Messaging, Registration, Radio Check, Private Call, etc.) before transmission. 
The acceptable range is 0 - 8640 ms. The recommended value is 120 ms. 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When the 
dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 Phone system 
From the drop-down list, select the system for phone calls: 
• Motorola Phone System 

This system uses a special call type with the parameters specified for a 
radio unit in MOTOTRBO CPS. The Motorola Phone System is 
recommended for IP Site Connect mode to minimize Radio response 
time. For more details on programming Motorola Radios, see 
Appendix B: SIP Setup for Motorola Phone System. 

• TRBOnet Phone System (TX Interrupt) 
This is a phone call system based on the private call type using TX 
Interrupt feature. This phone system is available for radio systems with 
control stations. 

 Allow CSBK Data 
Select this option so that the GPS and ARS data are compressed into a 
single CSBK data. 

Note: This feature is available only when the MNIS data service is 
enabled for the repeater. 

5.7.4.2 Privacy 
• In the Configuration pane, under the corresponding Repeater, select Privacy. 

 



TRBOnet Server 

45 

• In the Privacy pane, specify the following privacy-related settings: 
 Privacy Type 

From the drop-down list, select one of the privacy types: None, Basic, or 
Enhanced. 

 Basic Privacy Key ID 
Enter the Privacy Key ID available for the Basic privacy type. 

 Enhanced Algorithm 
From the drop-down list, select one of the enhanced algorithms if you are 
going to use additional encryption. 

Note: For more details on ARC4, see 
https://en.wikipedia.org/wiki/RC4 

 Enhanced Privacy Keys 
Here you add enhanced privacy keys for the selected enhanced algorithm. 
• Click Add and specify the required ID, name, and value for the privacy 

key being added. 

5.7.4.3 DDMS Service 
The DDMS, or Device Discovery and Mobility Service is a service to receive data to a 
repeater. 

• In the Configuration pane, under the corresponding Repeater, select 
DDMS service. 

 

• In the DDMS service pane, specify the following DDMS service-related 
settings: 
 Use DDMS service 

Select this option to enable the DDMS service for the repeater. 
 Local Port 

Enter the number of the local port to be used on a PC with TRBOnet 
Dispatch Software for DDMS service. 

https://en.wikipedia.org/wiki/RC4
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 Service IP Address 
Enter the IP Address of the PC with the DDMS service installed and running. 

 Service port 
Enter the service port number. 

Note: This value is programmed for a DDMS service via 
MOTOTRBO DDMS Administrative Client, in 
Interfaces>Watcher Settings>PortWatcher. 

 Authentication Port 
Enter the authentication server port number. 

Note: This value is programmed for a DDMS service via 
MOTOTRBO DDMS Administrative Client, in 
Interfaces>Authentication Server Settings> 
AuthenticationServerPort. 

 Radio ID list 
Enter the list of radios to be monitored. 

 Redundant services 
Here you see the list of redundant DDMS services for failover purposes. 
• Click Add and specify the required parameters for the DDMS service 

being added. 
• Click Test to test if the selected DDMS service is available. 
• Use the Up ( ) and Down ( ) buttons to move a selected DDMS 

service up and down in the priority list of DDMS services. 

5.7.4.4 MNIS Data Service 
The MNIS, or Motorola Network Interface, is a service that captures data from DDMS 
service and transfers the data to a radio server. 

• In the Configuration pane, under the corresponding Repeater, select 
MNIS data service. 
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• In the MNIS data service pane, specify the following MNIS data service-
related settings: 
 Use Data Gateway 

Select this option to enable the MNIS data service for the repeater. 
 Service is on a local host 

Select this option if MNIS data service will be used on the local PC; 
 IP Address 

Enter the IP Address used by the MNIS to communicate with the PC. 

Note: This value is programmed for a MNIS data service via 
MOTOTRBO MNIS Configuration Utility, and can be 
retrieved from General>Tunnel Network>Tunnel IP Address. 

 Control port 
Enter the number for the MNIS control port. 

Note: This value is programmed for a MNIS data service via 
MOTOTRBO MNIS Configuration Utility, in 
Advanced>Network>MNIS Control Interface TCP Port. 

 MNIS Service 
Select this option, and from the drop-down list select the available MNIS 
service. 

 Redundant services 
Here you see the list of redundant MNIS data services for failover purposes. 
• Click Add and specify the required parameters for the MNIS data service 

being added. 
• Click Test to test if the selected MNIS data service is available. 
• Use the Up ( ) and Down ( ) buttons to move a selected MNIS data 

service up and down in the priority list of MNIS data services. 

Advanced Settings 
• In the Configuration pane, under MNIS data service, select Advanced 

settings. 
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• In the Advanced settings pane, specify the following advanced MNIS settings: 
 Register network routes 

Select this option to register network routes. 
 Send data to group over control port 

Select this option so that data will be sent via the specified control port. 
 Radio Range 

Specify the range of radios to be monitored by the MNIS service. 
 

5.7.4.5 Slots 

Note: The slots are available only when IP Site Connect is selected in the 
Repeater pane. 

• In the Configuration pane, under the corresponding Repeater, select Slot #1 
or Slot #2. 

 

• In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters: 
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 Name 
Enter a name for the slot. This name will be displayed in the Dispatch 
Console. 

 Messaging Delay 
From the drop-down list, select the inter-repeater messaging delay based 
on the IP network configuration. 
• Normal 

The inter-repeater messaging delay is 60 ms. 
• High 

The inter-repeater messaging delay is 90 ms. 
 Use the slot for RX data only (GPS Revert or Data Revert) 

Select this option to configure the slot so that it will only receive data, thus 
having no any transmission capability. 

 Use Privacy 
Select this option to use Privacy for the slot. 

Note: This option is available only if the Basic or Enhanced 
Privacy Type have been selected in Repeater's Privacy 
settings. 

 Privacy Key 
From the drop-down list, select the privacy key. 

Note: This option is available only if the Enhanced Privacy Type 
has been selected in Repeater's Privacy settings). 

 Allow TX interrupt 
Select this option to allow the slot to be interrupted during voice 
transmissions by radios that are Transmit Interrupt capable. 

Note: This feature is available only when the Use NAI Voice 
option is cleared in the Repeater pane. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 

 Data Call confirmed 
Select this option to enable individual packets in data calls (ARS, GPS, and 
Text Message) on the current slot to be confirmed. 

Note: This feature is available only when the Use NAI Voice 
option is cleared in the Repeater pane. 

 Private Call Confirmed 
Select this option to set Private calls on the current slot as confirmed. By 
default, Private calls are unconfirmed. 
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 Emergency Alarm Ack 
Select this option so that the slot is allowed to acknowledge an emergency 
alarm. 

 Emergency Call/Alarm Indication 
Select this option so that audio and visual indication is given by the slot 
when an emergency call/emergency alarm is received. 

5.7.4.6 Local Slots 

Note: Local slots are available only when IP Site Connect is selected, and 
the Use NAI Voice option is selected in the Repeater pane. 

While on a local slot, voice or data are not transmitted between sites in IPSC 
systems. Due to MOTOTRBO limitations TRBOnet Server can only receive 
information from local slots, but cannot transmit by IP connection to such slots. 

• In the Configuration pane, under the corresponding Repeater, select 
Local Slots. 

 

• In the Local Slots pane, specify the following Local Slot-related settings: 
 To add a Local Slot to the system, click Add. 
 Select the option in the first column to enable the selected local slot. 
 Enter a Name for the local slot. This name will be displayed in the Dispatch 

Console. 
 Enter the Peer ID of the repeater. 
 From the drop-down list, select the Peer Slot. 
 To configure the selected local slot, click Configure: 
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 Specify the desired local slot settings similar to those for a common 
repeater slot. 

5.7.4.7 Audio Paths 

Note: Audio paths are available only when Capacity Plus or Linked 
Capacity Plus are selected, and the Use NAI Voice option is 
selected in the Repeater pane. 

The Audio Paths are talk paths of the system to make and receive Voice Calls; in 
general, they are talk groups. TRBOnet Server requires that all audio paths of a 
Connect Plus system be registered in its configuration. If an audio path is not 
registered, the TRBOnet operator will not be able to receive and transmit to the 
corresponding talk group. 

• In the Configuration pane, under the corresponding Repeater, select 
Audio Paths. 

 

• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an audio path to the system, click Add. 
 Make sure the check box in the first column is selected to make and receive 

voice calls from the selected subscriber. 
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 From the drop-down list, select the Call Type for the audio path. The 
available call types are All Call, Group Call, and Private Call. 

 Enter the Group ID, which is an ID of the talk group the dispatcher can 
make calls to. The Group ID is not applicable for Private Calls and All Calls. 

 Enter the Site ID of the site the audio path will belong to in a Linked 
Capacity Plus system. Or, leave zero value in this column. In this case, the 
Site ID will be displayed as Wide, meaning that the audio path will belong 
to all sites in the system. 

 To configure the selected audio path, click Configure. 
 Specify the desired audio path settings similar to those for a common 

repeater slot. 

5.7.5 Adding a TRBOnet Swift Agent 
The TRBOnet Swift Agent functions as a gateway to receive and transmit voice and 
data. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click Digital Systems. 

• In the drop-down menu, click Add TRBOnet Swift Agent. 

 

• In the TRBOnet Swift Agent pane, specify the following Swift Agent-related 
parameters: 
 Name 

Enter a name for the Swift Agent. This name will be displayed in the 
Dispatch Console. 

 Radio ID 
This is the Radio ID of the Swift Agent. 
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is 
65535). 
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Note: This box is populated automatically once you have 
successfully tested the Swift Agent by clicking the Test 
button. 

 IP Address 
Enter the IP Address of the Swift Agent network interface; 

 Port 
Enter the port number of the Swift Agent for incoming connections (8002, 
by default). 

 Test 
Click this button to check the connection to the Swift Agent. If the test 
succeeds, you'll see information on the Swift Agent you are connected to, 
such as Serial number, Firmware version, etc. 

 Mode 
From the drop-down list, select the connection mode for the Swift Agent 
being configured. For more details, see section 5.7.2.1, Control Station 
Connection Modes. 

 System Identifier 
Enter the system identifier if the control station is used with a Capacity Plus 
or Linked Capacity Plus system. Note that the system identifier should be 
the same for all control stations used in the radio system. 

 Use the radio for RX data only (GPS Revert or Data Revert) 
Select this option to configure the radio channel so that it will only receive 
data, thus having no any transmission capability. 

 VoIP port 
Enter the port number for audio communication (4000, by default). 

 Audio Format 
From the drop-down list, select the format to transmit audio data. 

5.7.5.1 Advanced Settings 
• In the Configuration pane, under the corresponding TRBOnet Swift Agent, 

select Advanced Settings. 
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• In the Advanced Settings pane, specify the following Swift Agent-related 
advanced settings: 
 Automatically reset alarm mode 

Select this option to reset alarm mode on the control station radio 
automatically. It is recommended to enable this option. 

 Emergency Call/Alarm indication 
Select this option so that audio and visual indication is given by the Control 
Station radio when an Emergency Call/Emergency Alarm is received. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 PTT Mode 
From the drop-down list, select the mode of pressing the PTT on the radio. 

 Signaling system 
From the drop-down list, select the signaling system. 
• MDC 1200 signaling is a Motorola data system using audio frequency 

shift keying (ASFK) using a 1,200 baud data rate. A general option is to 
enable or disable an acknowledgement (ACK) data packet. 

• SELECT 5 (5 Tone Signaling System). In the 5 Tone Signaling Systems, 
each radio has a unique numeric identity (e.g. 12345). To signal the 
number 12345, a sequence of 5 tones is sent. Sequences of audible 
tones of a very short duration are sent between radios. Most 5 tone 
sequences take less than half a second to send. Available for Voice Calls, 
Check Radio, Call Alert, and Enable/Disable Radio. 
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5.7.5.2 Redundancy 
A Redundant TRBOnet Swift Agent will be used when a connection to the Main 
TRBOnet Swift Agent is lost. 

• In the Configuration pane, under the corresponding TRBOnet Swift Agent, 
select Redundancy. 

 

• In the Redundancy pane, specify the following Redundant Agent-related 
settings: 
 Click Add and specify the desired parameters for the Redundant Agent 

being added. 
• IP Address 

Enter the IP Address of the Swift Agent that will be used as a Redundant 
Swift Agent. 

• Port 
Enter the port number of the Redundant Swift Agent for incoming 
connections (8002, by default). 

• Click Test to check the connection to the Redundant Swift Agent. 
If the test succeeds, you'll see information on the Swift Agent you are 
connected to, such as Serial number, Firmware version, etc. 

• Local Port 
Enter the port number that will be used for incoming connections from 
the Redundant Swift Agent. The value 0 (default) means that a random 
port will be used. 

 

5.7.6 Adding an XRC Controller 
The XRC Controller is a site controller that provides a channel for transferring data 
between sites and managing data flow. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click Digital Systems. 
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• In the drop-down menu, click Add XRC Controller. 

 

• In the Controller pane, specify the following XRC controller-related 
parameters: 
 Name 

Enter a name for the XRC controller. This name will be displayed in the 
Dispatch Console. 

 IP Address 
Enter the IP Address of the XRC controller network interface. 

 Click Test to check the connection to the controller. 
 System Identifier 

Enter the system identifier. Note that the system identifier should be the 
same through all the controllers in a Connect Plus system. 

 Radio ID list 
Enter a list of the radios to receive data from according to the following 
rules: 
• To receive data from all radios in the system, leave this box blank. 
• To receive data from certain radios, separate each Radio ID by a comma, 

e.g. 105,106,111, etc. 
• To receive data from a range of radios, enter the range using the 

following example: 105-111. 

Note: In the Radio ID list, enter Radio IDs only, without 
mentioning Radio Names and/or the word "Radio". 

5.7.6.1 Advanced Settings 
• In the Configuration pane, under the corresponding XRC Controller, select 

Advanced Settings. 
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• In the Advanced Settings pane, specify the following XRC controller-related 
advanced settings: 
 Automatic Registration service (ARS) provides an automated data 

application registration for the radio. When the radio powers up, it 
automatically registers with the server. This feature is used with data 
applications, i.e. any data traffic on this channel that is associated with an 
application server, such as MOTOTRBO Text Messaging or MOTOTRBO 
Location Service. This option is selected by default and cannot be cleared. 
• Controller port 

Enter the controller's port number for ARS service (4005, by default). 
• Local port 

Enter the local port of the PC with TRBOnet Dispatch Software. The value 
0 (default) means that a random port will be used. 

 Location service (GPS) 
Select this option to enable Location service on the controller. The radio can 
send its coordinates when it is in Global Positioning coverage area. GPS 
settings can be configured in the Service Management pane (see section 
5.5.2, Location Service). 
• Controller port 

Enter the controller's port number for Location service (4001, by default). 
• Local port 

Enter the local port of the PC with TRBOnet Dispatch Software (4001, by 
default). 

• Use adaptive GPS trigger 
Select this option to use the adaptive GPS polling interval. 

 Text Messaging service (TMS) 
Select this option to enable text message transmission on the controller. 
• Port 

Enter the controller's port number for Text Messaging service (4007, by 
default). 
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• Local port 
Enter the local port of the PC with TRBOnet Dispatch Software (4007, by 
default). 

• Dispatcher ID 
Enter the Dispatcher ID. The Dispatcher ID should belong to TRBOnet 
Server account in a Connect Plus system. 

 Multi Gate Connection 
Select this option to use a multi-gate connection and enter the 
corresponding Subscribe ID. 

5.7.6.2 Redundancy 
A redundant XRC controller will be used when a connection to the main XRC 
controller is lost. 

• In the Configuration pane, under the corresponding XRC Controller, select 
Redundancy. 

 

• In the Redundancy pane, specify the following redundant XRC controller-
related settings: 
 Click Add and specify the desired parameters for the redundant XRC 

controller being added. 
• IP Address 

Enter the IP Address of the XRC controller that will be used as a 
redundant XRC controller. 

• Controller Port 
Enter the port number of the redundant XRC controller for incoming 
connections (4005, by default). 

• Click Test to check the connection to the redundant XRC Controller. 
If the test succeeds, you'll see information on the XRC controller you are 
connected to, such as serial number, firmware version, etc. 
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• Local Port 
Enter the port number that will be used for incoming connections from 
the redundant XRC controller. The value 0 (default) means that a random 
port will be used. 

5.7.7 Adding an XRT Controller 
The XRT controller functions as a voice gateway connected to each XRC controller in 
a Connect Plus system. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click Digital Systems. 

• In the drop-down menu, click Add XRT Controller. 

 

• In the Controller pane, specify the following XRT Controller-related 
parameters: 
 System Name 

Enter a name for the XRT Controller. This name will be displayed in the 
Dispatch Console. 

 Radio ID 
Enter the individual virtual radio ID (for Capacity Plus systems, the 
maximum value is 65535). The virtual Radio ID is required to do the 
following: 
• Make all types of voice calls from XRT Controller to radios, dispatchers 

and groups. 
• Send commands (e.g. Remote Monitor). 

 Start Local Port 
Enter the local port of the PC with TRBOnet Dispatch Software. The value 0 
(default) means that a random port will be used. 

XRT Controller Info: 
 Controller IP Address 

Enter the IP Address of the XRT controller network interface. 
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 Controller TCP Port 
Enter the port number of the XRT controller to be used for connections via 
TCP (10001, by default). 

 Click Test to check the connection to the XRT controller. 
 User Name 

Enter the user name. For the user name, refer to the XRT controller 
configuration. 

 Password 
Enter the password for the user. For the password, refer to the XRT 
controller configuration. 

Note: The user name and password should belong to the same 
TRBOnet Connect Plus account and be appropriately 
configured. 

 System Identifier 
Enter the system identifier. Note that the system identifier should be the 
same through all the controllers in a Connect Plus system. 

 Monitor Voice sessions (without audio) 
Select this option to monitor only PTT press events. 

5.7.7.1 Privacy 
• In the Configuration pane, under the corresponding XRT Controller, select 

Privacy. 

 

• In the Privacy pane, specify the following Privacy-related settings: 
 Privacy Type 

From the drop-down list, select one of the privacy types: None, Basic, or 
Enhanced. 

 Basic Privacy Key ID 
Enter the Privacy Key ID available for the Basic Privacy Type. 
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 Enhanced Algorithm 
From the drop-down list, select one of the enhanced algorithms if you are 
going to use additional encryption. 

Note: For more details on ARC4, see 
https://en.wikipedia.org/wiki/RC4 

 Enhanced Privacy Keys 
Here you add enhanced privacy keys for the selected enhanced algorithm. 
• Click Add and specify the required ID, Name, and Value for the privacy 

key being added. 

5.7.7.2 Data Path 
The Data Paths are used to transmit data in a Connect Plus system. 

• In the Configuration pane, under the corresponding XRT Controller, select 
Data Path. 

 

• In the Data Path pane, specify the following data path-related settings: 
 Data Service 

From the drop-down list, select the data service to be used to transfer data. 
 Radio ID 

Enter the Radio ID of the data service. 

5.7.7.3 Audio Paths 
The Audio Paths are talk paths of the system to make and receive voice calls; in 
general, they are talk groups. TRBOnet Server requires that all audio paths of a 
Connect Plus system be registered in its configuration. If an audio path is not 
registered, the TRBOnet operator will not be able to receive and transmit to the 
corresponding talk group. 

• In the Configuration pane, under the corresponding XRT Controller, select 
Audio Paths. 

https://en.wikipedia.org/wiki/RC4
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• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an Audio Path to the system, click Add. 
 Make sure the check box in the first column is selected to make and receive 

Voice Calls from the selected subscriber. 
 From the drop-down list, select the Call Type for the audio path. The 

available call types are All Call, Group Call, and Private Call. 
 Enter the Source ID, which indicates the Radio ID of the call initiator. In 

general, this is TRBOnet’s Radio ID. If more than one Radio ID is specified in 
a Connect Plus system (for example, for different dispatchers), the 
corresponding talk paths should be added for all of them. 

 Enter the Target ID, which is the Radio ID of the talk group to make a call 
to. The Target ID is not applicable for Private Calls and All Calls. 

5.7.7.4 Redundancy 
A Redundant XRT Controller will be used when a connection to the Main XRT 
Controller is lost. 

• In the Configuration pane, under the corresponding XRT Controller, select 
Redundancy. 
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• In the Redundancy pane, specify the following Redundant XRT Controller-
related settings: 
 Click Add and specify the desired parameters for the Redundant XRT 

Controller being added. 
 Controller IP Address 

Enter the IP Address of the XRT Controller that will be used as a Redundant 
XRT Controller. 

 Controller TCP Port 
Enter the port number of the Redundant XRT Controller to be used for 
connections via TCP (10001, by default). 

 Start Local Port 
Enter the local port of the PC with TRBOnet Dispatch Software. The value 0 
(default) means that a random port will be used. 

 Click Test to check the connection to the Redundant XRT Controller. 
If the test succeeds, you'll see information on the XRT Controller you are 
connected to, such as Serial number, Firmware version, etc. 

5.7.8 Adding a Selex Repeater 
The Selex repeater is configured as a stand-alone repeater which supports 
connections to MOTOTRBO™ radios to transmit voice and data in digital, analog, 
and mixed modes. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click MOTOTRBO. 

• In the drop-down menu, click Add SELEX Repeater. 

 

• In the Selex pane, specify the following Selex Repeater-related parameters: 
 Name 

Enter a name for the Selex Repeater. This name will be displayed in the 
Dispatch Console. 
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 Radio ID 
Enter the Radio ID for the Selex Repeater (for Capacity Plus systems, the 
maximum value is 65535). 
The Radio ID is an individual ID that uniquely identifies the radio. This ID is 
used by other calling radios when addressing the radio, for instance, when 
making a private call or sending a text message. 

 Repeater Mode 
From the drop-down list, select the mode. The available modes are Digital, 
Analog, Mixed, and Tier III. 

5.7.8.1 Advanced Settings 
• In the Configuration pane, under the corresponding Selex, select Advanced 

Settings. 

 

• In the Advanced Settings pane, specify the following Selex Repeater-related 
advanced settings: 
 Keep Alive Interval 

Enter the time interval, in seconds, for TRBOnet Server to check the 
connection to the Selex repeater (10, be default). 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
Dispatcher starts any Voice Session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires (60, be default). 

5.7.8.2 Slots 
The Selex repeater has two available slots (in Digital or Mixed mode) to transmit 
voice and data. 

• In the Configuration pane, under the corresponding Selex, select Slot #1 or 
Slot #2. 
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• In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters: 
 Name 

Enter a name for the slot. This name will be displayed in the Dispatch 
Console. 

 TRBOnet IP Address 
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the 
Port number (6080, by default). 

 SELEX IP Address 
Enter the IP Address of the Selex Repeater (refer to the repeater 
configuration). Enter the Port number (6080, by default). 

 Click Test to check the connection to the repeater. 
 Use the gateway for RX data only (GPS Revert or Data Revert) 

Select this option to configure the channel so that it will only receive data, 
thus having no any transmission capability. 

 Use Encryption 
Select this option to encrypt voice and data traffic over IP. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 

 Data Call Confirmed 
Select this option to enable individual packets in data calls (ARS, GPS, and 
Text Message) on the current slot to be confirmed. 

 Private Call Confirmed 
Select this option to set Private calls on the current slot as confirmed. 

5.7.8.3 Tier III and Audio Paths 
The Selex repeater can be used in a Tier III mode. To configure this mode, do the 
following: 

• While in the Selex pane, select Tier III from the Repeater Mode drop-down 
list. 
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• In the Configuration pane, under the corresponding Selex, select Tier III. 

 

• In the Tier III pane, specify the following Tier III-related parameters: 
 Use Encryption 

Select this option to encrypt voice and data traffic over IP. 
 Always transmit when the PTT is pressed ("Impolite" channel access) 

Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 

To configure Audio Paths: 

• In the Configuration pane, under the corresponding Selex, select 
Audio Paths. 

Note: Make sure the Tier III mode has been selected as a 
Repeater Mode for the Selex repeater. 

 

• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an Audio Path to the system, click Add. 
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 Make sure the check box in the first column is selected to make and receive 
Voice Calls from the selected subscriber. 

 From the drop-down list, select the Call Type for the audio path. The 
available call types are All Call, Group Call, and Private Call. 

 Enter the Group ID, which is a radio ID of the talk group to make a call to. 
The Group ID is not applicable for Private Calls and All Calls. 

 

5.7.8.4 Analog channel 
The Selex repeater can also use the Analog channel. 

• In the Configuration pane, under the corresponding Selex, select Analog. 

Note: Make sure the Analog or Mixed mode have been selected 
as a Repeater Mode for the Selex repeater. 

 

• In the Analog pane, specify the following Analog channel-related settings: 
 Name 

Enter a name for the Selex repeater in the analog mode. This name will be 
displayed in the Dispatch Console. 

 TRBOnet IP Address 
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the 
Port number (6080, by default). 

 SELEX IP Address 
Enter the IP Address of the Selex Repeater (refer to the repeater 
configuration). Enter the Port number (6080, by default). 

 Click Test to check the connection to the repeater. 
 Always transmit when the PTT is pressed ("Impolite" channel access) 

Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 
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5.8 Analog Control Stations 
TRBOnet Dispatch Software allows using analog radios as control stations. 

• In the Configuration pane, select Analog Control Stations 
• In the Analog Control Stations pane, select Enable Analog Control Stations. 

 

5.8.1 Adding an Analog Control Station 
• In the Analog Control Stations pane, click Add. 

 

• In the Control Station pane, specify the following Analog Control Station-
related settings: 
 Name 

Enter a name for the analog control station. This name will be displayed in 
the Dispatch Console. 

 Playback device 
From the drop-down list, select the playback device connected to control 
Station. 
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 Recorder device 
From the drop-down list, select the recording device connected to control 
station. 

 Serial port 
From the drop-down list, select the serial port the control station is 
connected to on the PC. 

 Always transmit when the PTT is pressed ("Impolite" channel access) - 
Select this option so that the radio will always transmit when the PTT button 
is pressed (not available in Capacity Plus and Linked Capacity Plus systems). 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
Dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 Mic delay time 
Enter the time, in milliseconds, to be used as a delay time interval between 
pushing the PTT and starting voice communication. 

 Extended protocol 
From the drop-down-list, select either None, if your radio does not support 
the extended protocol, or IC-F1721D v1.01 if the radio supports the 
extended protocol. 

5.8.1.1 Serial Port 

Note: The serial port settings are available only when the 
extended protocol IC-F1721D v1.01 is selected for the 
analog control station. 

• In the Configuration pane, under the corresponding Control Station, select 
Serial Port. 

 

• In the Serial Port pane, specify the same serial port settings as those on the 
radio device connected to the serial port. 



  

70 TRBOnet PLUS — Administrator’s Guide 

5.9 Remote Agents 
The Remote Agent is TRBOnet Agent installed on a remote PC. 

• In the Configuration pane, select Remote Agents. 

 

• In the Remote Agents pane, click Add. 

 

 In the Agent pane, specify the following parameters: 
• Agent Name 

Enter a name for the remote agent. This name will be displayed in the 
Dispatch Console. 

• IP Address 
Enter the IP address of the remote agent (each remote agent has its own 
IP Address). 

• Port 
Enter the local port number that will be used by TRBOnet Server to 
accept connections from the remote agent. 

• Click Test to check the connection to the remote agent. 
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• Use all services 
Choose this option so that all available services will be used on the 
remote agent. 

• Use only specified services 
Choose this option and click the Load services from agent link to load 
services available on the remote agent. 

5.9.1 Redundancy 
A Redundant remote agent will be used when a connection to the Main remote 
agent fails. 

• In the Configuration pane, under the corresponding Agent, select 
Redundancy. 

 

• In the Redundancy pane, click Add. 

 

• In the Remote Agent dialog, specify the following parameters: 
• Agent Name 

Enter a name of the redundant remote agent. 
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• IP Address 
Enter the IP address of the redundant remote agent. 

• Port 
Enter the local port number that will be used by TRBOnet Server to 
accept connections from the redundant remote agent. 

• Click Test to check the connection to the redundant remote agent. 
• Use all services 

Choose this option so that all available services will be used on the 
redundant remote agent. 

• Use only specified services 
Choose this option and click the Load services from agent link to load 
services available on redundant the remote agent. 

• Click OK to add a redundant remote agent to the system. 

5.10 Friendly Servers 
The Friendly Servers are used to transmit voice over IP between dispatchers from 
different servers. 

• In the Configuration pane, select Friendly Servers. 

 

• In the Friendly Servers pane, click Add. 

 

 In the Server dialog box, specify the following parameters: 
• Name 

Enter a name for the friendly server. This name will be displayed in the 
Dispatch Console. 
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• IP Address 
Enter the IP Address of the server. 

• Port 
Enter the local port number on the PC to connect to the friendly server. 

• Click Test button to check the connection to the friendly server. 
• Click OK to add the friendly server to the system. 

5.11 Telephony 
TRBOnet Server has its own built-in SIP server to support VoIP communications 
between the radios as well as other SIP-compliant clients. In addition, you can add 
an external PBX server to the TRBOnet Server configuration. 

• In the Configuration pane, select Telephony 
• In the Telephony pane, select Use Telephony. 

 

5.11.1 Internal PBX Server 
• Make sure the Internal PBX Server option is selected in the Telephony pane. 
• In the Configuration pane, select Internal PBX Server. 
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• In the Internal PBX Server pane, specify the following parameters: 
 Local IP 

Enter the IP address of the PC with TRBOnet Server. 
 Port 

Enter the local UDP port number for the SIP service (5060, by default). 

Dispatch Center 

 SIP ID 
Enter the SIP ID that will be used by the Dispatch Center. 

 SIP user 
Enter the SIP user name that will be used by the Dispatch Center. 

5.11.1.1 Advanced Settings 
• In the Configuration pane, under Internal PBX Server, select 

Advanced Settings. 

 

• In the Advanced Settings pane, specify the following Internal PBX Server-
related advanced settings: 
 Packet time 

Enter the packet length, in milliseconds. 
 Сodecs 

In the drop-down list, select/deselect the codecs to be used. 
 Registration Interval (sec) 

Enter the time interval, in seconds, to check the radio status (online/offline 
etc.). 

 DTMF Send Mode 
Enter mode for sending DTMF tones. The available modes are RFC 2833, 
SIP INFO (dtmf relay), and SIP INFO (dtmf). 

 First VoIP port 
Enter the number of the first VoIP port for audio communications 
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 Use VoIP ports 
From the drop-down list, select which VoIP ports will be used (all, even, or 
odd). 

5.11.2 External PBX Server 
You can enable an external PBX server to use the SIP Interconnect feature. This 
feature enables calls from the radio to the phone and vice versa. The dispatcher can 
make a call from the Dispatch Console to a phone as well as redirect a phone call to 
a subscriber radio. 

• In the Telephony pane, click Add. 
Or, in the Configuration pane, right-click Telephony and choose 
Add PBX Server. 

 

• In the External PBX Server pane, specify the following parameters: 
 Use External PBX Server 

Select this option to enable the SIP Interconnect feature. 

Provider options 

 Address 
Enter your SIP provider address, and select the protocol from the drop-
down list to the right of the address (for more details, contact your SIP 
provider). 

 Port 
Enter the port number of the SIP provider (5060, by default). 

 Click Test to check the connection to the provider. 
 Local IP 

Enter the IP address of the PC with TRBOnet Server. 
 Port 

Enter the local port number to make connections from. 

Dispatcher Center 
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Note: This information is provided by the SIP provider. 

 SIP ID 
Enter the SIP ID that will be associated with TRBOnet Server to make and 
receive calls. 

 SIP user 
Enter the SIP user name for the login. 

 Password 
Enter the password for the login. 

 Test Call 
Click this button to make a test call. 

Note: To make a test call, make sure that the TRBOnet Server 
service is not running. 

5.11.2.1 Advanced Settings 
• In the Configuration pane, under External PBX Server, select 

Advanced Settings. 

 

• In the Advanced Settings pane, specify the following External PBX Server-
related advanced settings: 
 Packet time 

Enter the same value as specified in the phone system; 
 Codecs 

In the drop-down list, select/deselect the codecs specified in the phone 
system. 

Note: For more details on Phone System configuration, see 
Appendix B: SIP Setup for Motorola Phone System section. 

 Registration Interval (sec) 
Enter the time interval, in seconds, to check the radio status (online/offline 
etc.). 
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 Do not register users on a PBX server (SIP trunk) 
Select this option so that radios will use the SIP trunk system to get 
extensions. See the following example of the SIP trunk configuration of 
Asterisk/FreePBX. 

 Configure user’s authorization 
Click this link to set up user authorization for the systems with enhanced 
authorization parameters. It is recommended to use when Radio ID is equal 
to SIP ID. In case when Voice is transmitted via Radio Channel, Radio ID is 
used. When voice is transmitted via GSM channel, SIP ID is used. 

 

• Click Add to add a new user authorization. 
• SIP ID 

Enter the SIP ID for the new user. 
• User Name 

Enter the User Name for the new user; 
• Click OK to save the new user authorization. 

5.12 Data Sources 
The Data Sources feature allows receiving data from third-party applications and 
devices. 
TRBOnet Dispatch Software can work with the following two data source types: 

1. Physical or virtual devices connected via a COM port 
2. PCs running third-party applications connected via TCP/IP 

To allow TRBOnet Dispatch Software to receive data from a third-party application 
or device: 

• In the Configuration pane, select Data Sources. 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=55
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• In the Data Sources pane, select the Enable Data Sources option. 

5.12.1 COM Ports 
To manage physical or virtual devices connected to the TRBOnet Server PC via COM 
port: 

• In the Configuration pane, under Data Sources, select COM ports. 

 

• In the COM ports pane, click Add to add a new device. 
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• In the COM Port dialog box, specify the following parameters: 
 Serial port name 

From the drop-down list, select the COM port on the PC with TRBOnet 
Server to which the device is connected to. 

 Baud rate 
From the drop-down list, select the baud rate at which the data is 
transmitted. 

 Parity-checking protocol 
From the drop-down list, select one of the values that represent the parity-
checking protocol. 

 Stop bits per byte 
From the drop-down list, select the standard number of stop bits per byte. 

 Data bits per byte 
From the drop-down list, select the standard length of data bits per byte. 

 Handshaking protocol 
From the drop-down list, select the handshaking protocol for serial port 
transmission of data. 

 Text Encoding 
From the drop-down list, select the Text Encoding type. 

Note: The Text Encoding types selected in the TRBOnet Server 
and in the connected application must be the same to 
avoid incorrect text display and incorrect data parsing. 

 Message delimiter 
From the drop-down list, select the type of delimiters in the data. 

Note: The Message delimiter types selected in the TRBOnet 
Server and in the connected application must be the same 
to avoid incorrect text display and incorrect data parsing. 

 Click OK to save settings and close the dialog. 

5.12.2 TCP/IP 

Note: When TCP/IP connection is used, all data will be transferred 
via UDP protocol only. 

To manage PCs running third-party applications: 
• In the Configuration pane, under Data Sources, select TCP/IP. 
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• In the TCP/IP pane, click Add to add a TCP/IP connection. 

 

• In the External Connection dialog box, specify the following parameters: 
 Name 

Enter a name for the TCP/IP connection. 
 Mode 

From the drop-down list, select the connection mode. The connection 
mode depends on the type of the application installed on the connected 
PC: 
• Client 

In this case, the application connects to TRBOnet Server which sends the 
data to the application. 

• Server 
In this case, TRBOnet Server accepts connections from the application 
and receives the data. 

 Remote IP 
Enter the IP address of the application server. 

Note: Available only when the Server connection mode is selected. 
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 Port 
In case of the Client connection mode, select the local port of the PC with 
TRBOnet Server PC. 
In case of the Server connection mode, select the port of the PC where the 
third-party application is installed. 

 Text Encoding 
From the drop-down list, select the Text Encoding type. 

Note: The Text Encoding types selected in the TRBOnet Server 
and in the connected application must be the same to 
avoid incorrect text display and incorrect data parsing. 

5.13 Email Settings 
TRBOnet Dispatch Console allows processing emails as follows: 

1. Receive emails from email servers and forward them to a particular radio or 
talk group (via a POP3 or IMAP server); 

2. Send emails from radios to a particular email address (SMTP Server). 

Note: Microsoft Exchange Server can be used as SMTP and POP3/IMAP 
servers. 

• In the Configuration pane, select Email. 
• In the Email pane, select Enable Email Server. 

 

5.13.1 Incoming Mail Server 
The Incoming Mail Server is used to synchronize the Incoming Emails folder located 
on a mail server with your local PC. If you are using a POP3 server, all incoming 
emails can be downloaded from the mail server to the local PC to be then forwarded 
as text messages to radios or talk groups. 

• In the Configuration pane, under Email, select Incoming Mail Server. 
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• In the Incoming Mail Server pane, specify the following incoming mail-
related parameters: 
 Enable 

Select this option to enable Incoming Mail Server. 
 Server 

Enter the server hostname or IP address. 
 This server requires a secure connection (SSL) 

Select this option to enable a secure connection. Note that a dedicated port 
will be used to connect to the mail server via SSL. 

Note: The port number will automatically change as you select 
this option. For example, from 110 to 995 for POP3, and 
from 143 to 993 for IMAP. 

 Port 
Enter the port number to be used for the connection. 

Note: This box is populated automatically depending on the 
selected protocol and whether a secure connection is 
required. 

 Protocol 
From the drop-down list, select the protocol for the incoming mail server. 

Note: The port number will automatically change as you change 
the protocol. 

 Check for new messages every X seconds 
Enter the time interval to check for new email messages (60, by default). 

 Connect using 
Choose one of the following options: 
• Anonymous access 

Choose this option to use an anonymous access to the incoming mail 
server. 
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• Windows authentication 
Choose this option to connect via TRBOnet Service Windows Account, if 
it is running under a specific account; 

• Use login and password 
Choose this option and specify the credentials for the mailbox: 
 Login 

Enter the incoming mail server login. 
 Password 

Enter the incoming mail server password. 
 Check New Emails Now 

Click this button to synchronize the Incoming Emails folder and check for 
new emails. 

5.13.2 Outgoing Mail Server 
The SMTP Server is used to send emails from users to mail servers as well as 
between mail servers to deliver emails to the final destination. 
For example, the Administrator can enable email notifications from TRBOnet 
Dispatch Console to particular email users when alarms occur on selected radios. In 
this case, the radio sends an alarm to TRBOnet Server which in turn converts this 
alarm to text and then forwards it as an email message to particular email addresses 
(for example, to admin@yourcompany.com). 

• In the Configuration pane, under Email, select Outgoing Mail Server. 

 

• In the Outgoing Mail Server pane, specify the following outgoing mail-
related parameters: 
 Enable 

Select this option to enable Outgoing Mail Server. 
 Sender Email 

Enter the email address to send emails to. 
 SMTP server 

Enter the server hostname or IP address of the SMTP server. 

mailto:admin@yourcompany.com
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 This server requires a secure connection (SSL) 
Select this option to enable a secure connection. Note that a dedicated port 
will be used to connect to the mail server via SSL. 

Note: The port number will automatically change as you select 
this option. For example, from 25 to 465. 

 SMTP server port 
Enter the port number to be used for the connection. 

Note: This box is populated automatically depending on whether 
a secure connection is required. 

 Connect using 
Choose one of the following options: 
• Anonymous access 

Choose this option to use an anonymous access to the SMTP server. 
• Windows authentication 

Choose this option to connect via TRBOnet Service Windows Account, if 
it is running under a specific account; 

• Use SMTP user name and password 
Choose this option and specify the credentials for the mailbox: 
 User name 

Enter the SMTP server user name. 
 Password 

Enter the SMTP server password. 
 Type 

From the drop-down list, select the SMPT login type. 
 Send Test Message 

Click this button to send a test message from the Sender Email address. 

5.14 SMS Settings 
TRBOnet Dispatch Console allows sending SMS notifications to a cell phone when 
alarms and other events occur on selected radios (e.g. DTMF commands from radios, 
Telemetry, Radio State, etc.). 

• In the Configuration pane, select SMS. 
• In the SMS pane, select Enable SMS Server. 
• In the Configuration pane, under SMS, select SMS. 
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• In the SMS pane, specify the following SMS-related parameters: 
 Sender 

Leave this box blank. 
 Connection to GSM via 

From the drop-down list, select the type of connection. 
• Nokia mobile phone connected to TRBOnet Server PC 

Select this item to send SMS notifications via a Nokia cell phone 
connected to the TRBOnet Server PC. 

• Vianett service 
Select this item to use an account on Vianett service. 
For more details on Vianett service, see www.vianett.com 

• SMS Broadcast 
Select this item to use an account on SMS Broadcast service. 
For more details on SMS Broadcast service, see 
www.smsbroadcast.com.au 

• Clickatell 
Select this item to use an account on Clickatell service. 
For more details on Clickatell service, see www.clickatell.com 

 Login 
Enter the login for the selected service account. 

 Password 
Enter the password for the selected service account. 

 Send Test MMS 
Click this button to send a test MMS from the selected service account to a 
recipient's phone number. 

Note: This button is available when connected via Vianett service 
only. 

 Send Test SMS 
click to send a test SMS from Vianett account to recipient phone number. 

http://www.vianett.com/
http://www.smsbroadcast.com.au/
http://www.clickatell.com/
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Note: This button is available when connected via Vianett, SMS 
Broadcast, or Clickatell services. 
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6 TRBOnet Dispatch Console 
The key features of TRBOnet can be configured by the Administrator in TRBOnet 
Dispatch Console after initial installation and configuration. The default 
Administrator credentials are admin for the login and admin for the password. 

6.1 Main Menu 
The TRBOnet Dispatch Console main menu allows the user to manage the main 
Dispatch Console options. The main menu is located in the upper left corner of the 
main window. 

 

6.1.1 File 

 
The File menu contains the following items: 

• File > Connect to TRBOnet Server 
Choose this menu item to connect to a different TRBOnet Server, or to use 
different credentials for the current connection. 

 

In the dialog that opens, specify the following connection parameters: 
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Connect to: 

 Address 
Enter the IP address of the TRBOnet Server to connect to. 

 Port 
Enter the local port of the TRBOnet Server PC to accept connections from 
Dispatch Console. Use unique ports for each Dispatch Console connection if 
there are several Dispatch Consoles connected. 

Authentication: 

 Method 
From the drop-down list, select the Authentication method: 
• TRBOnet Authentication 

Select this method to log on as a User registered in the TRBOnet 
Dispatch Console Users list. 

• Windows Authentication 
Select this method to log on using the PC name. The system 
automatically shows the PC name as a User Name. 

Note: The password is not required when the Windows 
Authentication method is used. 

 User Name 
Enter the User Name registered in the TRBOnet Dispatch Console Users list. 

 Password 
Enter the individual password. 

 Connect on startup 
Select this option to launch Dispatch Console without typing User Name 
and Password. 

• File > Exit 
Choose this menu item to exit TRBOnet Dispatch Console. 
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6.1.2 View 

 
The View menu contains the following items: 

• View > Show Navigation 
Choose this menu item to toggle the Navigation Tree display. 

• View > Show Modules > 
Choose this menu item and in the pull-down menu select/deselect the 
modules to display. 

• View > Configure PTT Boxes 
Choose this menu item to configure the view of PTT boxes. 

 

In the Configure Voice Boxes dialog, specify the following PTT box 
parameters: 
 Type 

In this column, the box type (e.g. Channel or Group) is displayed. 
 Name 

Ether a name for the selected box. This name will be displayed in the title of 
the PTT box. 
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 View Mode 
From the drop-down list, select the view mode: 
• Invisible 

Select this mode so that the PTT box will not be displayed. 
• Normal 

Select this mode so that the PTT box will be displayed in Normal view 
mode: 

 

• Minimized 
Select this mode so that the PTT box will be displayed in Minimized view 
mode: 

 

Note: Hover your mouse pointer over the Minimized PTT box and 
see the PTT box popped up in Normal view mode. 

 Available Calls 
From the drop-down list, select available Call Types for the PTT box: 

Create virtual channel boxes 

 To create a virtual PTT box, click the Create link in the upper-left corner of 
the Configure Voice Boxes the dialog. 
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In the Virtual Channel dialog, specify the following virtual channel 
parameters: 
 Name 

Select this option and enter a name for the virtual channel. 
 Choose the Call Type for the channel. 
 Call Target 

(available only when Group Call or Private Call is selected as the Call Type) 
Choose Select by Dispatcher to allow the dispatcher to select a Call Target. 
Or, choose Selected from list and from the list below select the desired 
group (if the Group Call type is chosen) or individual radio (if the Private 
Call type is chosen). 

 Execute call on channels 
(available only when All Call or Group Call is selected as the Call Type) 
Choose Execute call on all available channels, 
or Execute call only on selected channels and in the in the list below 
select the available channels. 

• View > Configure Active Calls panel 
Choose this menu item to configure call types and advanced settings for the 
Active Calls panel: 
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• Call Types 
While on this tab, you can select which call types to display in the Active Calls 
panel: 

 

• Advanced 
While on this tab, you can specify whether to display Visible/Hidden Channels 
and Missed Calls, as well as their display time. 

The Active Calls panel is displayed in the upper part of the Dispatch Console: 
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• View > Customize Hot Keys 
Choose this menu item to configure hot keys for the actions on the selected 
channels. 

 

 If you are going to configure PTT actions for PTT boxes, click the 
Show all PTT boxes link and assign a hotkey or a combination of hotkeys. 
Double-click the desired PTT box and select the hotkey(s) for the action. 

 If you are going to set some specific actions for PTT boxes (e.g., mute 
channels or set default PTT channels), click the Create link: 
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In the Action dialog box that opens, specify the following parameters: 
• Hotkey 

Click the Configure button and on the keyboard, press the key or key 
combination you want to assign as a hot key for the selected action. 

• Caption 
Enter a caption that will be displayed in the Dispatch Console. 

• Action 
From the drop-down list, select the desired action: 
 Default PTT channel 

Selected PTT box functions as a default PTT channel. 
 Mute channels 

This action mutes selected PTT boxes. 
 Unmute channels 

This action unmutes selected PTT boxes. 
 Voice from channels 

This action mutes voice from all PTT boxes except for selected one(s). 
 Terminate All Transmissions 

This action terminates all transmissions for selected PTT boxes. 
• Channels 

In the list below, select PTT boxes to assign the actions specified above. 
 To enable displaying the configured hotkeys in the Dispatch Console, select 

the Show actions panel option. 
All the hotkeys you have configured are displayed in the upper part of the Dispatch 
Console: 
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• View > Add Radio Interface Page 
Choose this menu item to add a new Radio Interface page. 

 

 In the Configure Voice Boxes dialog, specify the following PTT box 
parameters for the new radio interface: 
• Name 

Enter a name for the radio interface. 
Other parameters can be configured in the same way as when Configuring 
PTT Boxes. 

Radio Interfaces can be switched between by clicking on the tab bar in the upper 
part of the Calls pane. 
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• View > Delete Radio Interface Page 
Choose this menu item to delete the currently selected Radio Interface page. 

Note: The default Radio Interface pages can't be deleted. 

• View > Audio Message Library 
Choose this menu item to add configured Voice Messages to the Queued 
Messages panel. To configure Voice Message settings, see Tasks, Voice 
Message. 

 

 In the Saved Audio Files dialog box, specify the following parameters: 
• Filename 

The name of the message displayed in the Queued Messages panel. 
• Description 

Enter a description for the Voice Message. 
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• Severity 
From the drop-down list, select the severity level (Information, Alarm, or 
Warning). 

• Hot Key 
Click the Hot Key button and press the key or key combination you want 
to assign as a hot key for the selected Voice Message box. 

• Visibility 
From the drop-down list, select how to display the selected Voice 
Message box: 
 Hidden 

Hide the Voice Message box. 
 Button 

Display the Voice Message as a button (1). 
 Link 

Display the Voice Message as a link (2). 

 

 
• View > Extended PTT boxes 

Select this command to display PTT boxes as shown: 

 

• View > Large PTT boxes 
Select this command to display PTT boxes as shown: 
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• View > Medium PTT boxes 
Select this command to display PTT boxes as shown: 

 

• View > Small PTT boxes 
Select this command to display PTT boxes as shown: 

 

• View > Custom PTT boxes 
Select this command to display PTT boxes as shown: 

 

• View > Show Active Calls Panel 
Select this command to display the Active Calls panel in the Dispatch Console. 
See also Configuring Active Calls panel. 

• View > Show Quick Commands Panel 
Select this command to display the Quick Commands panel in the Dispatch 
Console. 

• View > Show Queued Messages Panel 
Select this command to display the Queued Messages panel in the Dispatch 
Console. 

• View > Show Cross Patch Panel 
Select this command to display the Cross Patch panel in the Dispatch Console. 

• View > Telephony Tab 
Select this command to display the Telephony tab in the Radio Interface pane. 

• View > Show Extended Messages Tab 
Select this command to display the Extended Messages tab in the Radio 
Interface pane. 
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• View > Show Radios Tab 
Select this command to display the Radios tab in the Radio Interface pane. 

The Extended Messages and Radios tabs appear on the top of the Calls pane: 

 

6.1.3 Map 
• Select Location Tracking (1) in the Navigation pane to enable Map Options: 
• Click the Map menu (2). 

 

The Map menu contains the following items: 

 
• Map > Select Active Map 

Click this menu item to select the map to display in the Dispatch Console. 
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 Enter the Caption of the map that will be displayed in the Dispatch 
Console. 

 In the list of Available Maps, choose the map to be displayed. 
 You can also add a custom map using the URL. 

Click the Add button. 

 

• Enter the Name for the new map. 
• Enter the URL, as shown in the example. 
 Z 

Enter the zoom value for the map. 
 X 

Enter the coordinate in X-direction. 
 Y 

Enter the coordinate in Y-direction. 
• Map > Save Online Map Data 

Click this menu item to save your current map region. 
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In the dialog box, specify the following parameters: 
 Expire tiles days 

Enter the time the saved offline map will be stored before it is automatically 
updated. 

 Redownload all tiles 
Select this option to re-download the map tiles before saving to your PC. 

 Zoom level 
Move the slider from left to right to increase the detail level of the map. 

 Show tiles preview 
Select this option to show how the map is divided into tiles. 

 Show tiles progress 
Select this option to show the progress bar while the online map is being 
saved. 

 Click Start and wait for the system to save the files. This may take several 
minutes. 

• Map > Map Content 
Click this menu item to specify the folder and settings to store the map data. 

 

In the Online Map dialog box, specify the following settings: 
 Cache folder 

Click Change and locate the folder on the PC where you wish to store the 
map data. 

 Update 
Enter the update interval for the map data stored in the specified Cache 
folder. 

Note: The value 0 means that the map data won't be updated. 

 Map Type 
From the drop-down list, select the map type. For more details on the maps 
used in TBOnet Dispatch Console, see Map Types. 

6.1.3.1 Map Types 

Online maps: 

 OpenStreetMap – free online maps. Includes MAPNIK, CYCLE, 
TRANSPORT, LANDSCAPE, and MAPQUEST subtypes. For more details on 
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OpenStreetMaps, visit the official the website: 
http://www.openstreetmap.org 

 Microsoft BING – commercial maps from Microsoft. Includes 
BING_ROAD, BING_AREA, and BING_HYBRID subtypes. A user may use 
BING maps for 90 days and then they must get a Basic Key. Visit 
http://msdn.microsoft.com/en-us/library/ff428642.aspx to get a Basic Key. 

Offline Maps: 

 TRBOmap – internal map-making resource. A user can customize a part of 
online maps according to requirements. For more details on map 
calibration, visit TRBOnet Knowledge Base and read the following article: 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=27. 

 TMap – internal map-making resource. A user can create an offline copy of 
online maps for selected regions according to requirements. A user can 
create a map from any picture via the TRBOnet Map Edit application. 
Click Start > All Programs > Neocom Software > TRBOnet Map Edit 
For more details on map calibration, visit TRBOnet Knowledge Base and 
read the following article: 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=28. 

 GIS Panorama – offline Russian map. For more details, visit the official 
website: http://www.gisinfo.ru/ 

 Beacon 2D – two-dimension offline map for Indoor positioning. A user 
can create maps using the Beacon2DMapGenerator tool. To get 
Beacon2DMapGenerator, contact your local TRBOnet dealer. 

 Beacon 3D – tree-dimension map for Indoor positioning. A user can use 
any dicectX(.x) file as a map. 

 MapLib map format – free offline map. Requires a lot of internal 
memory. Requires Franson GpsTools. For more details on Franson 
GpsTools, visit the official website: http://franson-
gpstools.software.informer.com/2.3/ 

 TatukGIS – commercial offline map. For more details on TatukGIS, visit 
the official website: http://www.tatukgis.com/ 

• Map > Print 
Click this menu item to print the map region currently displayed in the Map 
pane. 

• Map > Geocoding 
Click this menu item to configure geocoding servers in the Dispatch Console. 

 

http://www.openstreetmap.org/
http://msdn.microsoft.com/en-us/library/ff428642.aspx
http://www.gisinfo.ru/
http://franson-gpstools.software.informer.com/2.3/
http://franson-gpstools.software.informer.com/2.3/
http://www.tatukgis.com/
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 Load data from the TRBOnet server if local one is unachievable 
Select this option to allow the Dispatch Console to resolve GPS data from 
the TRBOnet Server PC. 

 For other settings, see 5.6.1.1 Configuring Geocoding Servers. 
• Map > Open New Map in Tab 

Click this menu item to add a new map tab to the Map pane. 

 

 Map Type 
From the drop-down list, select the map type. 

 Caption 
Enter a caption for the new map tab. 

 For other required settings, see Selecting Active Map. 
Once you have clicked OK, the new tab will appear in the Map pane: 

 

• Map > Open New Map in Window 
Click this menu item to create a new map window with the specified map. 
 For the required settings, see Selecting Active Map 
Once you have clicked OK, the new Map window will appear: 
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• Map > Google Earth 
Click this menu item to open the Google Earth application. 

Note: Google Earth must be previously installed on the PC. For 
more details on Google Earth, visit Google's official website: 
http://www.google.co.uk/earth 

• Map > Delete Routes on Google Earth 
Click this menu item delete all routes from Google Earth. 

• Map > Show Radios on Google Earth 
Click this menu item and in the drop-down menu select which radios to 
display on Google Earth. 

6.1.4 Tools 

 
The Tools menu contains the following items: 

• Tools > Event Log in Window 
Click this menu item to open the Event Log in a new window. 
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• Tools > Recent Calls/Events in Window 
Click this menu item to open Recent Calls/Events in a new window. 

 

 Click Playback to play back the selected call. 
 Click Save to save the selected call as an audio file. 

In the 'Save As' dialog box, locate the folder where you want to save the 
audio file, specify the file name, and from the drop-down 'Save as type' list, 
select the format (*.wav or *.tna) for the audio file. 

 Click Add Note to add a note to the selected call. 

 

• Enter the text of the note in the text box. 
• You can extend the form of a note by clicking the Add Extension link 

and adding new fields and their possible values to the form. 
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• Tools > Job Ticketing Monitoring 
Click this menu item to open the window that visually represents the job 
tickets created by dispatchers and assigned to radios. 

 

In this window, you can perform the following actions: 
 Select a time period for which to display Job Ticketing data. 
 Monitor tickets created by dispatchers. 
 Monitor tickets assigned to radios. 
All data are shown in the form of status diagrams. 

• Tools > Radios in Window 
Click this menu item to open a new window that displays the radios present in 
the system. 

 

In this window, you can make radio calls, send text messages. In addition, you 
can select to display radios by groups and statuses. 

• Tools > Telephony in Window 
Click this menu item to open a new window that displays the Telephony 
system present in the system. 
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In this window, you can make and receive telephone calls. 
• Tools > Telemetry Monitoring 

Click this menu item to open the window that displays configured telemetry 
profiles for the radios. 

 

 From the Show drop-down list, select the Telemetry profile to display. 
• Tools > Text Messages in Window 

Click this menu item to open a new window to manage text messages. 

 

In this window, you can perform the following tasks: 
 View sent messages in the in the upper-right pane. 
 Select online dispatchers and radio groups in the left pane, or by clicking 

the … button in the lower-right pane. 
 Type messages in the text box in the lower-right pane. 
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 Send messages by clicking the Send button in the lower-right pane. 
• Tools > Routes in Window 

Click this menu item to open a new window to manage routes. 
For more details on Route Management configuration, see section 6.2, Route 
Management. 

• Tools > Terminate All Transmissions 
Click this menu item to terminate all voice sessions. 
This action is a "hard" inquiry to stop all transmissions in TRBOnet software 
and is intended to stop any "hung" transmission in TRBOnet. If a radio 
communication session does not allow to be interrupted on a repeater or base 
station, it will be interrupted for TRBOner software only. 

6.1.4.1 Options 
• On the Tools menu click Options 

 

Sound 
 In the Options dialog box, click the Sound tab. 

• Use Sound Notifications 
Select this option to enable sound notifications in the Dispatch Console. 

• Select the event in the list and specify the sound. 
• From the Sound drop-down list, select ether 'Sound by default' to play 

default sound, or 'Disabled' to disable sound notification for the event. 

• Click  to listen to the sound notification for the selected event. 
• Click Select and browse for the sound file on your PC. 

 Alarm of Emergency Call duration 
Enter the time value, in seconds, for the duration of the alarm tone when 
an emergency call is received. 

Map 
 In the Options dialog box, click the Map tab. 
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• Map refresh interval 
Enter the time period, in seconds, to update map data. 

• Show the directions of motion 
Select this option to display a direction of motion for map objects. 

• Show names of objects  
Select this option to display object names on the map. 

• Show PTT on map 
Select this option to allow the dispatcher to make private calls by 
clicking a corresponding radio icon on the map. 

• Select the image size 
From the drop-down list, select the size of a radio icon. 

• Select the default image type 
From the drop-down list, select the default image type of a radio icon. 

• Path to Google Earth exe file 
Click … and specify the location of the Google Earth exe file on your PC. 

Coverage Map 
TRBOnet Dispatch Console allows displaying RSSI levels on a map. The RSSI is a 
received signal strength indicator. It measures a radio signal loss from the radio. The 
RSSI maps can be used by radio system engineers to plan a further extension of their 
radio networks. 

 In the Options dialog box, click the Coverage Map tab. 
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 Draw in Dots 
Choose this option to display RSSI levels on the map as dots that represent 
coordinate points for more a detailed data view. 
The RSSI map will be displayed as follows: 

 

 Draw Coverage Zone 
Choose this option to configure RSSI zone in meters and display on map 
average data of RSSI level GPS coordinates for more common data view: 

 

 RSSI Zone Size 
Enter the size, in meters, of an RSSI zone. 
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 Click Add to add a new RSSI level. 
• Value 

Enter the minimum level for the signal range (e.g., -65 means -65 and 
higher). 

• Description 
Enter a name of the RSSI level to display in the system. 

• Color 
Pick the color for RSSI indicator on the map. 

To view RSSI levels on the map, click the Location Tracking tab and on the 
Map pane's toolbar, click Coverage Map. Then set the Start Date and End 
Date to display RSSI data. 

Hardware 
 In the Options dialog box, click the Hardware tab. 

 

 Use external hardware 
Select this option to use external hardware devices, e.g. mic connectors. 
• Serial port 

From the drop-down list, select the COM port the device is connected to. 
• TRBOnet footswitch 

Select this option if you are going to use TRBOnet footswitch as a PTT 
button. 

 Use signaling device 
Select this option to use an external signaling device. 
• Serial port 

From the drop-down list, select the COM port the signaling device is 
connected to. 

• Click Configure and specify the duration of a signal and which call types 
to include in signaling. 
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 PTT USB device 
From the drop-down menu, select the type of the USB device with a PTT 
button connected to the PC (DirectX or HID).  
• Device Name 

From the drop-down menu, select the USB device name. 
• PTT button 

From the drop-down menu, select the available PTT button. 
Press the PTT button on the USB device. If the device's PTT and the PTT 
in the Dispatch Console are set up correctly, the Pressing indicator will 
become green. 

 First VoIP port 
Enter the number of the first VoIP port for audio communications (4022, by 
default). Each additional Dispatch Console will create a connection on the 
next port number. 

 Use proxy server 
Select this option to enable Proxy Server service in TRBOnet Dispatch 
Console to access the Internet. 
A proxy server can be used when a user's computer cannot be connected 
directly to the Internet, but there is another computer with Internet access 
in the network. 
• Click the Configure link to specify the alternative server settings. 

 

Configure audio devices 

 Playback device (Speaker) 
From the drop-down list, select the audio device to play incoming voice 
messages and playback voice recordings in the Dispatch Console; 
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 Recorder device (Mic) 
From the drop-down list, select the recording device where the microphone 
is connected. 

Note: If TRBOnet Dispatch Console is running on the same PC 
with TRBOnet Server connected to control stations via 
programming cable and sound card, the playback and 
recorder devices cannot be the same for TRBOnet Dispatch 
Console and TRBOnet Server. 

• Click the Configure link to configure the Recorder device: 

 

 Use frequency filter 
Select this option to configure the microphone to use the frequency 
filter to reduce external noise level. 

 Specify the Min. and Max. values for the frequency filter. 

Advanced 
 In the Options dialog box, click the Advanced tab. 

 

Configuration Scope 

 Per machine 
Choose this option to store settings in a common place for all dispatchers 
of the Dispatch Console. 

 Per user 
Choose this option to store settings for each dispatcher separately if they 
are using different Windows user accounts. 
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PTT Options 

 Tone and PTT when using external PTT device 
Select this option to enable Alert Tone for all subscribers on a channel when 
the dispatcher presses the PTT button on an PTT external device. 

 Use Record Mode with external PTT 
Select this option to record all voice transmissions from external PTT 
devices (Palm mics, Footswitches, etc.). 

 Suggest Queued Message when channel is busy or subscriber radio is 
offline 
Select this option to record a TX Queued Voice Message when a radio 
channel is busy or subscriber is offline (see TX Passive configuration page); 

 Enable Short Press PTT 
Select this option to start and finish voice calls by a short press of the PTT 
rather than keeping the PTT pressed until the end of a voice call. 

 Use 'Space' key to press PTT 
Select this option to use a hot key for the PTT. Click the Configure link and 
on the keyboard, press the key you want to assign as a hot key for the PTT 
button. 

Voice Options 

 Mute other dispatchers 
Select this option to mute all other dispatchers voice transmissions. 

 Mute radio-to-radio private calls 
Select this option to mute all private calls on the channel. 

 Mute all receive sources during voice input 
Select to mute all Voice Notifications when Dispatcher transmits or records 
audio. 

 Automatically set channel to Solo when transmitting audio 
Select this option to mute other channels when transmitting audio. 

 Automatically unmute channel when transmitting audio 
Select this option to automatically unmute a channel when transmitting 
through this channel. 

View Options 

 Customize the automatic subscriber name pattern 
Select this option and click the Configure link to set a custom alias for a 
radio in the list of subscribers. 
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• Radio display name 
Click … and in the Format dialog box pick the fields to display for a 
radio. 

 

• Allocated radio display name 
Click … and in the Format dialog box pick the fields to display for an 
allocated (taken) radio. 

• Allocated radio display name 
(the owner has more than one radio) 
Click … and in the Format dialog box pick the fields to display for an 
allocated (taken) radio in case when a user has more than one radio. 

• Click Defaults to set default settings for radio display. 
 Show extended notes 

Select this option to enable Extended Notes in the Dispatch Console. 
The Extended Notes feature is intended to add predefined Extended Notes 
templates, the same as for Extended Messages, for the selected calls and 
events. 
E.g., a Taxi Dispatcher needs to check clients' calls response period for the 
company internal monitoring of the employees. They can add a predefined 
template and check the time period. All Extended Notes are displayed in 
the Extended Notes column: 
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Click the Extended Notes button (1) to fill the template; 
Click the View button (2) to see the Extended Note. 

 Show confirmation dialogs 
Select this option to enable confirmation dialogs for dispatcher actions (e.g. 
when sending a configured Voice Message from the Dispatch Console). 

 Use popup windows to display incoming Text Messages 
Select this option so that incoming Text Messages will pop up over the 
application window. 

 

 
 Use popup windows to display incoming Request to Talk 

Select this option so that incoming Request to Talk messages will pop up 
over the application window. 

 

 Close button minimizes application 
Select this option so that clicking the Close button will minimize the 
Dispatch Console rather than close it. 

 Minimize button minimizes to Voice Bar 
Select this option so that once you click the Minimize button you will see 
only the Voice Bar displayed. 
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 Max items in "Recent calls/Events" 
Enter the maximum number of items to display in the Recent calls/Events 
pane. 

 Measurement system 
From the drop-down list, select either the Metric or the US unit system. 

 Coordinate system 
From the drop-down list, select the coordinate system to be used. 
• On Map 

Select this option to display coordinates on the map. 

Volume 
 In the Options dialog box, click the Volume tab. 

 

 Customize Selected channel speakers and volume parameters. 
 Customize Unselected channel speakers and volume parameters. This 

option is intended for radio channels which are not selected in Dispatch 
Console. 

 Customize Intercom speakers and volume parameters. This option is 
intended for Intercom Voice session between the dispatchers. 

 Customize System sounds speakers and volume parameters. 
For the list of system sounds, see section Sound. 

 Customize SIP Interconnect speakers and volume parameters. This option 
is intended for SIP calls. 

Alarm 
 In the Options dialog box, click the Alarm tab. 
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 Radio in alarm mode in new window 
Select this option to display a radio in alarm mode on the selected map in a 
new window. 
• Map 

This field displays the map name. Click the Select map link and specify 
the map on which to display a radio in alarm mode. 

 Always show radio in alarm mode on map 
Select this option so that radios in alarm mode will always be displayed on 
the map. 

Note: When this option is selected, you cannot disable the display 
of radios in alarm mode. 

 

6.1.4.2 Exporting/Importing Options 
A dispatcher can export custom Dispatch Console settings (Volume level, UI view, 
hotkeys configuration, etc.) as a .config file and save it to the local PC or to a 
selected external device. 

• Click Tools > Export Options and save the file to the specified location. 
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If you want to apply settings from a different TRBOnet Dispatch Console: 
• Click Tools > Import Settings and browse for the .config file with the desired 

settings. 

6.1.4.3 Setting Language 
• On the Tools menu, click Set Language 

 

 From the drop-down list, select the desired language and click OK. 
The changes will apply after you restart the Dispatch Console. 

6.1.4.4 Changing Password 
• On the Tools menu, click Change Password 

 

 In the Old password box, enter your current password. 
 In the New password box, enter the new password. 
 In the Repeat password box, enter the new password again. 
 Click OK. 

6.1.5 Help 
• Help > Send Feedback 

Click this menu item to send your feedback to Neocom Software, either 
through E-mail, or online via the site. 

• Help > Save System Logs 
Click this menu item to save the logs as a .zip file. This .zip file can then be sent 
to Neocom support. 

• Help > About 
Click this menu item to see the About dialog displaying information about 
TRBOnet PLUS (applied license, version, build date, etc.). 

6.2 Route Management 
The Route Management feature allows the user to create routes and assign them to 
selected radio subscribers or dispatchers. 
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• Click the Route Management tab (1). 

6.2.1 Creating a Route 
• Click the Create button (2) to create a new route. 

 

• Name 
Specify a name for the route to display in the route list. 

• Description 
Add a description for the route. 

• Rule 
Select the type of the rule from the drop-down-list: 
 All checkpoints, strict order, strict schedule 

Checkpoints are to be attended in the specified order, each within a 
specified time range. 



TRBOnet Dispatch Console 

121 

 All checkpoints, strict order, loose schedule 
Checkpoints are to be attended in the specified order. The time for 
attending each checkpoint is not limited. 

 All checkpoints, loose order, loose schedule 
Checkpoints can be attended in any order, each at any time. 

• Click the Start/Stop Rules tab. 

Start Route 
Specify the rules to start the route. 

 Manually by dispatcher 
This option is enabled by default and cannot be edited. This option enables 
the dispatcher to start the route by clicking the Start button in the Route 
Management tab or in the Active Routes pane. 

 Automatically by receiving Text Message from a radio 
The route starts when the radio sends a specified text message to TRBOnet 
Server. If you select this option, specify a brief text message in the Message 
box. 

 Automatically by receiving Telemetry Command from a radio 
The route starts when the user presses a preconfigured button on the radio 
and TRBOnet Server receives a telemetry command from the user's radio. If 
you select this option, specify the VIO contact, and from the Command 
drop-down list, select the signal level at which the user's radio should send 
the telemetry command. 

 Automatically by receiving DTMF command from a radio 
The route starts when the user sends a specified DTMF command to 
TRBOnet Server, for instance, #11#. If you select this option, specify the 
DTMF combination without the # characters in the Command box. 

 Automatically by receiving Status from a radio 
The route starts when the user sends the specified Status to TRBOnet 
Server, for instance, 1. If you select this option, specify the Status. 

 Wait for confirmation from a radio 
Select this option to delay the start of a route until a confirmation from the 
radio is received. In this case, the route is assigned to the radio or user and 
paused. The route can then be resumed. 

Pause Route 
Specify the rules to pause the route. 

Resume Route 
Specify the rules to resume the route. 

Finish Route 
Specify the rules to finish or stop the route. 

 Automatically when all points have been attended 
Select this option so that the route is finished automatically when all 
checkpoints have been attended. 



  

122 TRBOnet PLUS — Administrator’s Guide 

 Limit route processing time 
Select this option, and specify the maximum allowed time in the Max. Time 
box. If the time is exceeded, the route will stop automatically. All 
unattended checkpoints automatically change their statuses from 'Waiting' 
to 'Not Attended'. 

• In the Route dialog box, click the Route Points tab. 

 

 Click the GPS Points link (1) to add points to the selected map: 

 

 Select the map. For more details on map types, see Map Types section. 
 Click the Create link or double-click a selected point on the map to create a 

new route point: 

 

 Name 
Specify a name for new point to display on the map. 

 Location 
This box displays the current GPS coordinates of new point. 
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 Radius 
Specify the radius within which to consider the point as attended. 

 Intermediate way point (not served) 
Select this option to exclude the point from being used as a checkpoint. 

 Time 
Specify the time the point is to be attended at. 

 Time delta 
Specify the time accuracy to attend the point. 

 Click OK to add the new point. 
 Click the Beacons link (2) to add a beacon as a checkpoint. 

Note: To enable the Indoor feature, make sure your license 
includes Indoor Positioning (see License information page) 
and Indoor Service is selected in the list of available 
services (see Services). 

 

 Click the Create link and then click a beacon in the list. 

 

 Click the Map Objects link to add a map object as a checkpoint. 
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 Click the Create link and then click an object in the list. 

 

• In the Route dialog box, click the Checkpoint Statuses tab. 

 

• Set status to Attended 
Select this option so that TRBOnet Server will change the checkpoint status to 
'Attended' based on the information from the radio. 
 When the radio enters the point area 

Choose this option so that the radio detects the closest beacon and sends 
location data to TRBOnet Server. The respective checkpoint changes its 
status to 'Attended ' automatically. 
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 By condition when the radio is in the point area 
If this option is chosen, the radio sends a preconfigured command to 
TRBOnet Server. The last detected checkpoint changes its status to 
'Attended ' by this command. Configure the preferred command(s): 
• Automatically by receiving Text Message from a radio 

Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a text message with the specified text from 
a radio. If you select this option, specify a brief text message in the 
Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a specified telemetry command from a 
radio. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's 
radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a specified DTMF command from a radio, 
for instance, #11#. If you select this option, specify the DTMF 
combination without the # characters in the Command box. 

• Statuses that can be set by dispatcher 
Select this option to allow the Dispatch Control operator to manually change 
the status of checkpoints in the Active Routes panel. 
In the drop-down list, select the checkpoint statuses to be available for the 
operator: Waiting, Attended, Unattended, and Alarm. 

• Set status to Alarm 
Select this option to allow the radio to set an alarm on the attended 
checkpoint. Configure the command(s) that can set the checkpoint status to 
'Alarm'. 
 Automatically by receiving Text Message from a radio 

Select this option to set the point to alarm mode after the dispatcher 
receives a text message with the specified text from a radio. If you select 
this option, specify a brief text message in the Message box. 

 Automatically by receiving Telemetry Command from a radio 
Select this option to set the point to alarm mode after the dispatcher 
receives a specified telemetry command from a radio. If you select this 
option, specify the VIO contact, and from the Command drop-down list, 
select the signal level at which the user's radio should send the telemetry 
command. 

 Automatically by receiving DTMF command from a radio 
Select this option to set the point to alarm mode after the dispatcher 
receives a specified DTMF command from a radio. If you select this option, 
specify the DTMF combination without the # characters in the Command 
box. 
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 Automatically by receiving Emergency from a radio 
Select this option to set the point to alarm mode after the dispatcher 
receives an Emergency from a radio. 
• Emg. Type 

Select the Emergency type from the drop-down list. 
• In the Route dialog box, click the Notifications tab to manage notifications to 

a radio. 

 

Note: To enable an option, select the checkbox. The Text Message 
boxes already include text. If necessary, replace the text 
with your own text, using variables as placeholders that will 
be substituted with actual data. 

 Send a Text Message on route assign 
Select this option to inform a radio holder that the route is assigned to. 

 Send a Text Message on route start 
Select this option to inform a radio holder that the route started. 

 Send a Text Message on route suspend 
Select this option to inform a radio holder that the route is suspended. 

 Send a Text Message on route resume 
Select this option to inform a radio holder that the route is resumed. 

 Send a Text Message on route finish 
Select this option to inform a radio holder that the route is finished. 

 Send a Text Message when approaching attendance time 
Select this option to inform a radio holder that the next checkpoint is 
expected in the time interval specified in the Time before attendance box. 
This message is only available for routes with the specified attendance time. 
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 Send a Text Message after point is attended 
Select this option to confirm attending a checkpoint. 

 Send a Text Message if point is not attended 
Select this option to notify a radio holder if the point was not attended. 

 Send a Text Message if point is in alarm mode 
Select this option to notify radio holder if the point is in alarm mode. 

 Click OK to save settings. 
The new route is added to the route list (1): 

6.2.2 Starting a Route 

 

• Click the Start button (2) to start the route: 

 

 Name 
Enter a name for the route to be started. Tis name will be displayed in the 
Active Routes pane. 

 Start Date 
Select a date to start the route on. 
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 Route 
From the drop-down list, select the route to start. Click the Create Route 
button to create a new route based on the selected route. Click the Modify 
button to modify selected route parameters. 

 Radio 
From the drop-down list, select the radio to assign the route to. 

 Radio Owner 
From the drop-down list, the select the User to assign the route to. 

 Dispatcher 
From the drop-down list, the select the dispatcher to monitor the route. 

Note: Do not select both Radio and Radio Owner to prevent 
incorrect route running. 

 Click OK to start the route. 
The active route appears in the Active Routes panel. 

 

If the route point is not attended, it becomes red. 
• Click the Stop button to replace an active route in the list of created routes. 

The administrator can generate reports on the finished routes. 
• Click the Reports (1) tab, and in the Reports pane select Common reports > 

List Finished Routes (2): 
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6.3 Radio Allocation 
The radio can be assigned to a selected employee registered in the system. 
All available radios are disabled and an employee will need to type in username and 
password to take and enable selected radio. When an employee returns allocated 
radio it gets disabled again. 

• Click the Radio Allocation tab (1) to assign radios to users: 

 

• Select the radio in the list and click the Take/Return Radio button (2): 
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 Radio 
This box displays the selected radio. 

 User 
Form drop-down list, select the user to allocate the radio to. 

 Password 
Enter the password for the selected user. 

Note: For more details on user access to Allocation Console, see 
Users section. 

• Click the Take Radio button to assign the radio to the selected user. 
The administrator can generate reports on the allocated radios. 

• Click the Reports (1) tab, and in the Reports pane select Common reports > 
Radio Allocation (2): 

 

6.4 Beacons 
TRBOnet Dispatch Console provides the Indoor Positioning feature to monitor 
radio location inside a building where no GPS signal is available. The feature requires 
additional hardware (beacons spread around the building and option boards in 
radios). A radio unit will be displayed on indoor floor plan on exact beacon when the 
radio enters the beacon's coverage area. A beacon icon on the map notifies on the 
amount of radios that are currently in this beacon's coverage area (e.g. Room 1(3) - 
there are 3 radios in Room 1). 

Note: To enable the Indoor feature, make sure your license 
includes Indoor Positioning (see License information page) 
and Indoor Service is selected in the list of available 
services (see Services). 

• Click the Location Tracking tab (1), then click Map (2) and choose Open New 
Map in Tab: 
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 Map Type 
From the drop-down list, select 'Beacon 2D' to enable 2D floor plan, or 
'Beacon 3D' to enable 3D floor plan (3). 

 Click Add (4), and browse required map on your PC. 
 Click OK to add the map. 

Add a beacon to the selected floor plan 

• Click the Set Location button (1) and then click on the map to point the 
location of a physical beacon on the floor. 

• In the dialog box that opens (2), specify the beacon properties. 

 

 Type 
Select the beacon type from the drop-down list. 

 Name 
Specify a name for the beacon. 
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 Major ID and Minor ID 
Enter the beacon’s major and minor ID exactly as specified on the iBeacon 
device. 

 Description 
Add a description for the beacon. 

Edit parameters of a beacon 

 Select a beacon in the Objects panel and double-click to edit its 
parameters. 

 

Note: For more details on beacon parameters, see the following 
article. 

6.5 Administration 
Click the Administration tab to set system elements and options. 

6.5.1 Server 
Click the Administration tab (1), and see the Server (2) pane with the full system 
information: 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=36
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6.5.1.1 Database 
Go to Administration (1), Database (2) to see the full overview of the database: 

 

In the Database pane, the administrator can restore and back up the database and 
audio recordings. 
For more details on backups, see Appendix A: Database and Audio Recordings 
Backup and Restore. 

6.5.1.2 Radio Systems 
All radio systems registered in the Server are represented on the Radio Systems 
pane. 
Go to Administration (1), Radio Systems (2) to see system elements’ parameters: 



  

134 TRBOnet PLUS — Administrator’s Guide 

 

The administrator can see the following radio system parameters in the table: 
• System Type - the type of the system. 
• System ID - a unique System Identifier configured in TRBOnet Server 

configuration for repeater or controller stations in the system. 
• Caption – channel type to transmit voice and data. 

Radio System Properties 
To see the radio system properties, do the following: 

• Select a radio system in the list and click the Properties button (1); 
or, 
double-click the radio system in the list; 
or, 
click the corresponding element at the bottom of the Dispatch Console 
window, and choose Properties (2). 
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The administrator can see Active and Inactive registered systems. In case you have 
more than 10 registered systems, systems are grouped and can be seen in the drop-
down list. 
Common information for all system elements is listed below: 

Description tab 

On the Description tab, you can see the general info: 

 

• System Type 
The system type for a repeater/Digital or Analogue mode for a control station. 
For the repeater, see MOTOTRBO Radio Systems page. 

• System ID 
A unique System Identifier configured in TRBOnet Server for repeater or 
controller stations in the system; 

• Caption 
Enter the channel name. 

Channels tab 

On the Channels tab, you can see channel properties: 
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• Click the Properties button to see the repeater additional data: 

 

 ID 
Default registration number (manufacturer’s number); 

 Name 
System element’s name in the system; 

 Type 
System type for repeater/Digital or Analogue mode for control station. 
For the repeater, see MOTOTRBO Radio Systems page. 

 Mode 
System type for a repeater/connection mode for a control station. 
For the control station, see Control Station Connection Modes. 

 Connected 
• Serial number 

Default system element’s serial number (manufacturer’s number). 
• Firmware Version 

Current system element’s firmware version. 
• Click the Reset button to test the connection to the system element. 

Note: For a repeater, clicking the Reset button reconnects the 
repeater. 
For a control station, clicking the Reset button reloads the 
radio. 

Talk groups tab (for repeaters only) 

 On the Talk groups tab, you can see selected Talk group info: 
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 Specify available Talk groups for the system element in the list of created 
Talk groups. 
Selected Talk groups are available on the Radio tab in the system element 
box in the drop-down list: 

 

Note: Close TRBOnet Server before applying the system element 
settings. 

Volume tab (for repeaters only) 

 On the Volume tab, you can see Volume settings for the repeater: 
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• Specify the RX and TX volume levels for the Repeater using a volume 
control slider. 

• Click the Reset link to set default volume level for RX or TX. 
• Configure system volume 

Select this option to save default volume settings for Voice transmissions 
from the selected Repeater. 

Transmits tab 

• On the Transmits tab, you can see information about audio and data 
transmissions: 

 

 Record audio 
Select this option to enable audio recordings for the selected repeater. 

 Manage Audio by DTMF 
Select this option to manage audio in the selected channel by specified 
DTMF tones. 
• Mute channel 

Enter a DTMF sequence to be used to mute the selected channel. 
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• Unmute channel 
Enter a DTMF sequence to be used to unmute the selected channel. 

6.5.1.3 System Bridging 
TRBOnet Dispatch Console provides the System Bridging function. System Bridging 
allows configuring the network to redirect calls. 
Administrator can create two types of System Bridging: 

1. System Bridging for Master stations – allows connecting all types of Radios 
(analogue and digital radios, supports IP Site Connect, Capacity Plus, Linked 
Capacity Plus and Connect Plus modes). 

2. System Bridging for repeaters - allows connecting only the repeaters in the 
IP Site Connect mode. 

Go to Administration (1), System Bridging (2) to add System Bridging to the 
system: 

 

• Click the Add button (3) to add a Cross Patch. 
From the drop-down menu, select the System Bridging type. 

Radio System Bridging 
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 Name 
Specify a name for System Bridging to display in Radio Interface. 

 Work mode 
Select the work mode from the drop-down list. For more details on System 
Bridging types, see System Bridging Types. 

 PTT Button 
set PTT on the System Bridging interface to be able to transmit voice or do 
not set only to hear the voice from other channels. There are 3 options 
available: 
• Enable when a Bridge enabled 
• Always Enabled 
• Invisible 

 On the Channels tab, click the Add button (1) to add a channel to the list. 
 In the Radio System column, select a radio channel from the drop-down 

list (2). 
 In the Group column, select available group for the radio channel (3). 
 In the Mode column, select a mode for the radio channel (4). 

• Always 
Enables System Bridging always, regardless of the radio status 
(online/offline). 

• ByRadio 
Enables System Bridging on a selected channel when there are online 
radios capable to receive voice calls from the selected group. 

 On the Parameters tab, specify call types for System Bridging: 

 

 Select call types to use in System Bridging mode. 
 Click OK to add System Bridging for the radio channels. 
The System Bridges are displayed on the Cross Patch panel of the Radio 
Interface pane: 
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System Bridging Types 
1. Channels redirect the calls to each other 

This is the most common type of System Bridging when data exchanges 
between the channels set in the System Bridging settings. Thus, there is a 
common channel for all the subscribers of the specified control stations: 
To create this mode of System Bridging, add a System Bridging and set the 
Work Mode as Channels redirect the calls to each other. 
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2. One channel station redirects calls to many channels 
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To create this type of System Bridging, add a System Bridging and set the 
Work Mode as One channel redirects the calls to many channels. 

3. Many channels redirect calls to one channel 

Radio network 
2

Radio network 
1

Radio network 
N

Control Station

Control Station
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To create this type of System Bridging, add a System Bridging and set the 
Work Mode as Control stations redirect the calls to one control station. 

Binary Patch (for IP Site Connect only) 

 

• Name 
Specify a name for the Binary Patch to display in Radio Interface. 

• Rules 
Specify the rules for System Bridging to redirect calls. 
 Check Voice/Data to transmit on the selected slot. 
 Select available Call types. 
 Select available Groups for System Bridging from the drop-down list. 
 Select available Repeaters to redirect calls in System Bridging from the 

drop-down list. 
The Binary Patches are displayed on the Cross Patch panel of the Radio Interface 
pane: 
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Note: System Bridging can also be created by drag and drop of 
the PTT boxes in Radio Interface. It is a temporary System 
Bridging; it will be deleted after reconnecting to TRBOnet 
Server or exiting TRBOnet Dispatch Console. 

6.5.1.4 Telephony 
Click Administration (1), and then Telephony (2) to configure incoming and 
outgoing SIP calls: 

 

Radio Calls Configuration 
Click the Configure button (3) to set radio call configuration parameters: 
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• Allow subscribers to make outgoing calls 
Select this option to enable outgoing phone calls for the radio subscribers. 

• Allow to use DTMF 
Select this option to allow radio subscribers to dial the phone number as a 
sequence of DTMF tones. 

• Allow to use Text Messages 
Select this option to allow radio subscribers to initialize phone calls via sending 
TMS messages with a specified prefix to the dispatcher. 
 Prefix 

Enter the standard prefix for a text message. 
• Play the incoming call tone on the radio 

Select the mode for playing the incoming call tone on the radio that initiates a 
call. 
 After the called party answers the call 

When a radio initiates a phone call to a subscriber via DTMF tones or a TMS 
message, the incoming call tone will be played on the radio after the called 
party answers the call. 

 Immediately 
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS 
message, the incoming call tone will be played on the radio immediately 
that is without waiting for the called party to answer the call. 

• Initialize call to radio 
Select the option how to start a call on a radio. 
 Start transmission 

Select to start a call to a radio automatically. 
 Send ring tone 

Select to play a ring tone until the radio user presses the PTT. 
• Initialize call timeout 

Specify a timeout that defines how long to make an attempt to connect to the 
called party. 
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• Execute Check Radio before call 
Select this option to execute a Check Radio command before placing a call. 

• Send text message if cannot establish call 
Select this option to send a text message when the channel is busy and a 
phone call cannot be established. 

• Play tone when PTT changed 
Select this option so that a phone will play sound tones when the PTT is 
pressed/released on the remote radio. 

• DTMF Access Code 
Specify a DTMF Access Code as 0. 

• DTMF Deaccess Code 
Specify a DTMF Deaccess Code as #. 

Incoming Calls Configuration 
Click the Configure button (4) to set incoming call configuration parameters: 

 

• Call to Dispatch Center 
Select the mode for handling incoming calls made to the dispatcher. 
 Decline calls 

All incoming phone calls will be declined. 
 Open voice menu 

When an incoming call arrives, the subscriber will hear Voice menu 
commands. 

 Redirect to dispatchers 
All incoming voice calls will be redirected to all dispatchers of the Dispatch 
center and any free dispatcher will answer the phone call. 

• Call to external number 
Select the mode for handling incoming calls made from unregistered 
subscribers. 
 Decline Calls 

Select this option to decline all calls from unregistered subscribers. 
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 Use number as Radio ID 
Select this option to allow the system to read unregistered numbers as a 
Radio ID and start a Private Call. 

 Use number as Internal 
Select this option to allow the system to read unregistered numbers 
according to Voice Menu rules. 

Extension numbers (Voice menu) 

• Start call automatically 
Select this option to search for the number in the table automatically. When 
this option is disabled, the subscriber must dial the number according to the 
following example: 0(phone number)#. The character # is used to search for 
the phone number in the table. 

• Max. number length 
Specify the maximum number of characters allowed in a phone number. 

• Accept Code 
Specify the character that will be used to finish dialing the number. 

All available numbers are listed in the table below. 
• Click the Add link to add a number to the table. 

To add a static number 

 Choose Static number. 

 

 Number 
Enter a phone number to add to the table (contact list). 

 Call Type 
Select the call type from the drop-down list. 
• Call Dispatcher 

Select this type to make a phone call to the dispatcher. 
• Call Radio 

Select this type to make a phone call to the selected radio. 
• Call Group 

Select this type to make a phone call to the selected group. 
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 Channel 
Select the channel to make a group phone call through (available for Group 
Calls only). 

 Dispatcher/Radio/Group 
Select the dispatcher, radio, or group depending on what you have selected 
in the Call Type box. 

To add a dynamic number 

 Choose Dynamic number. 

 

 Prefix 
Specify a prefix to type in on the keyboard. 

 Call Type 
Select the call type from the drop-down list. 
• Call Radio 

Select this type to make a phone call to a radio. 
• Call Group 

Select this type to make a phone call to a group. 
• Call Phone 

Select this type to make a phone call to a telephone. 
 Channel 

Select the channel to make a group phone call through (available for Group 
Calls only). 

6.5.1.5 Tasks 
Go to Administration (1), Tasks (2) to see the list of the tasks created in the system: 
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Note: After you have created a task you need to enable it. Just select the 
checkbox (3) beside the task you want to enable. 

Agenda 
The Agenda is used to automatically send predefined messages to the radios. It may 
be used when you have any software receiving any messages but it is not able to 
send them to the subscribers. In this case, TRBOnet Dispatch Console acts as an 
intermediary for receiving the messages from the folder and sending them to radios. 

• To add an agenda, select Tasks (1), and click Add > Agenda (2). 

 

• In the Agenda dialog box, specify the following parameters. 
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 Task name 
Specify a name for the task. 

 Outgoing folder (on server) 
Specify the outgoing folder for the text messages to be displayed in the 
Dispatch Console (e.g. C:\Outgoing). 

 Incoming folder (on server) 
Specify the incoming folder for the reports (e.g. C:\Incoming files); 

 Wait for response 
Specify the time interval for the response. 

 Text to confirm 
Specify the text to be sent by the subscribers after they receive the 
message. 

Recorder 
The Recorder feature allows connecting to an audio recorder via IP. 

• To enable the task, select Tasks, and click Add (1) > Recorder (2): 

 

The feature allows replicating audio recordings to the recorder: 
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• Task name 
Specify a name for the task. 

• IP 
Enter the recorder's IP address. 
Port 
Specify the recorder's port number. 

• Click Test of channels to view all available channels on the recorder. 
• Click OK to add the task. 

Import Beacon Data from Firebird DB 
The Import beacon data from Firebird DB option allows import beacon data from 
Firebird database to TRBOnet Dispatch Software database. 
To enable the task, select Tasks, and click Add (1) > Import beacon data from DB 
Firebird (2): 
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• Name 
Specify a name for the task; 

• Server 
Specify a remote server or a server on the local PC. 

• User 
Type in a name of the Firebird DB user. 

• Database path 
Specify the Firebird DB path. 

• Password 
Specify a password to connect to Firebird DB (provided at logon). 

• Port 
Specify the port number to connect to Firebird DB. 

• Update (sec.) 
Specify the update period for Firebird DB. 

• Click Test to test the connection to Firebird DB. 
• Click the Import tab to specify Import settings: 
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• Import data from 
Specify the Firebird DB name. 

• Click Import to import data. 
• Delete old data 

Select this option to delete all previously imported data from Firebird DB. 
• Report 

In this box, an import report will be displayed. 
• Click OK to add the task. 

Export Data 
TRBOnet Dispatch Console provides the Export Data function, which allows 
exporting data to an external database table. 

• To add an Export Data task, select Tasks (1), and click Add > Export Data (2): 

 

• In the Export Data dialog box, specify the following parameters: 
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Connection tab 

• Task name 
Specify a name for the task. 

• Type 
Select the type of data export from the drop-down list. TRBOnet Dispatch 
Console allows exporting data for third-party systems using data export tasks. 
 Export to database table 

Allows exporting data to MS SQL Server tables. Specify MS SQL Server 
connection parameters, database, base and table to export data. 

 Export to VersaTrans 
Allows exporting data to the VersaTrans data collection system via IP. For 
more details, visit the official website of VersaTrans. 

 Export to Google 
Allows exporting data to file (file format is KML). For more details, visit the 
following website. 

 Export to NMEA 
Allows exporting data to a file (text file format, export format is NMEA 
0183). For more details, visit the following website. 

 Export to file 
Allows exporting data to a text file. 

• Data 
Select which data to export from the drop-down list. 

• Default connection 
Choose this option for default connection to SQL Server. 

• Specified connection 
Choose this option and specify the SQL Server and database name. 

• Server name 
Specify the SQL server name. 

• Database name 
Select the database from the drop-down list. 

• Windows authentication 
Select this option to use Windows authentication, or deselect it to use SQL 
Server authentication (SQL Server user name and password will be required). 

Data tab 

http://www.tylertech.com/solutions-products/versatrans-product-suite
http://en.wikipedia.org/wiki/Keyhole_Markup_Language
http://en.wikipedia.org/wiki/NMEA_0183
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• Table 
the name of the table to be exported into external database (by default, the 
name of the table is created after you have specified it in Create table dialog 
box). 

• Click the Load columns list link to update the columns list in case you have 
made any changes to the table. 

• Click the Create table link to add a new table for data export: 

 

 Select the data fields to add to the table. 

Scheduler tab 
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• Days of week 
In the drop-down list, select the days of the week on which to export the data. 

• Execute recurrently with interval 
Choose this option to perform data export on a periodic basis. 
 Start time 

Specify the time at which to start data export. 
 Stop time 

Specify the time at which to stop data export. 
 Repeat every 

Specify a time period for periodic data exports. 
• Execute at particular time 

Choose this option and specify the times in the columns of the table below. 

Advanced tab 
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• Export only changed data 
Select this option to export only changed location of the radio data. 

• Export mode 
Choose the mode for exporting data. 

Geofencing 
The Geofencing feature allows controlling the location and speed of radios relative 
to manually defined regions on the map. 
The Geofencing monitoring consists of the manually defined regions and the tasks. 
The regions specify where to apply the rules, while the tasks specify how to apply 
the rules for the regions and radios. 

• Click Tasks (1), and double-click Geofencing (2) in the Tasks pane. 

 

The administrator can add/disable/delete the rules for Geofencing as well as edit 
the currently selected rules: 
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• Click the Add Rule button (1) and select the appropriate rule from the drop-
down list (Map Region, Beacons, Radios, Lone Worker) to add a rule to the 
current Geofencing configuration. A new rule will be displayed in the list of 
rules (4). 

• Click the Disable rule button (2) to disable the selected rule. 
• Click the Delete rule button (3) to delete the selected rule. 

General tab 

• Name 
Specify the rule name. 

• Description 
Add a description of the rule. 

• Run the rule on a schedule 
Select this option and in the boxes below specify the schedule for the rule to 
run. 
 Days of week 

In the drop-down list, select the days of the week on which to run the 
Geofencing rule. 

 Start time 
Specify the start time to run the rule. 

 Stop time 
Set the time to stop running the rule. 

• Reset Alarm mode when the rule conditions are no longer met 
Select this option to reset Alarm mode after the rule is triggered. 

Location tab 

 

Trigger this rule when a subscriber: 
• Enters the selected regions 

Select this option so that the rule will be triggered as soon as a subscriber 
enters the selected region. 
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• Leaves the selected regions 
Select this option so that the rule will be triggered as soon as a subscriber 
leaves the selected region. 
For multiple nested/overlapping regions 
Choose one of the options specifying for multiple regions whether to consider 
only outer border of the group of regions, or any border of a region within the 
group. 

Perform the following actions: 
Here you specify which actions to execute when the rule is triggered. 

• Activate Alarm mode 
Select this option to activate an Alarm mode in the Dispatch Console. 

• Activate Lone Worker mode 
Select this option to automatically activate a Lone Worker mode for the radio 
in case of entering or leaving the selected region. 

• Send Text Message to the source radio 
Select this option to automatically send a text message to the radio when it 
enters or leaves the selected region. 

• Send notification 
Select this option to send a notification when the radio enters or leaves the 
selected region. Click the Recipients link and specify the recipients to send the 
notification to. 

• Send Call Alert to the source radio 
Select this option to automatically send a call alert to the radio when it enters 
or leaves the selected region. 

Speed tab 

 

Trigger the rule when a subscriber: 

• Moves faster than 
Select this option and specify the maximum allowed speed for the vehicles. 
The rule will be triggered when the vehicle with the radio exceeds this speed 
limit. 
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• Moves slower than 
Select this option and specify the minimum allowed speed for the vehicles. The 
rule will be triggered when the vehicle with the radio drops below the 
specified speed. 

• Stands still for longer than 
Select this option and specify the time period, in seconds, during which the 
vehicle is allowed to stand still. The rule will be triggered when the vehicle with 
the radio stands still for longer than this specified time period. 

• Track speed in relation to regions 
From the drop-down list, select where to track the speed of the vehicles: inside 
or outside the selected regions, or independently of the region. 

Regions tab 

 

 
• All regions 

Choose this option to apply this rule for all regions. 
• Only selected regions 

Choose this option to apply the rule for one or several regions. 
• Select all 

Click this button to select all regions in the list. 
• Deselect all 

Click this button to deselect all regions in the list. 

Radios tab 
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• All radios 
Choose this option to apply this rule for all radios. 

• Only selected radios 
Choose this option to apply the rule for one or several radios. 

• Select all (1) 
Click this button to select all radios in the list. 

• Deselect all (2) 
Click this button to deselect all radios in the list. 

• Collapse all (3) 
Click this button to collapse the view of radios in the list. 

• Expand all (4) 
Click this button to expand the view of radios in the list. 

•  (5) 
Click this button, and from the drop-down menu, select which list to display: 
Radio List, Radio Groups, or Logical Groups. 

Lone Worker tab 
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• All Tasks 
Choose this option to execute all Lone Worker tasks configured by the 
administrator when the rule has been triggered. 

• Only selected tasks 
Choose this option, and in the list below, select the Lone Worker tasks to be 
executed when the rule has been triggered. 

Variable settings for Geofencing rules of event types (Map Region, Beacons, Radios 
and Lone Worker) are represented in the table below: 

Event type Tab Name Parameters Description 

Common Settings General Name – specify the rule name; 

Description – add the rule description; 

Scheduler Run the rule on a schedule - select to start a scheduler 
for Geofencing rules; 

Days of week - select the days of the week on which to 
activate the Geofencing rule; 

Start time - set the time at which to start the rule; 

Stop time - set the time at which to stop the rule. 

Radios All radios – choose to apply this rule for all radios; 

Only selected radios – choose to apply the rule for one 
or several radios; 

Select all – click to select all radios in the list; 

Deselect all – click to deselect all radios in the list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Map Region. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

General 

Regions Control – select to enable regions control; 

Control mode – select the control mode for regions in 
the dropdown list; 

Activate Alarm mode if the rule has been triggered – 
select to activate Alarm mode in the Dispatch Console if 
Regions Control rule has been triggered;  

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Regions 
Control rule has been triggered;   

Activate Lone Worker if the rule has been triggered – 
allows automatically activating a Lone Worker policy for a 
radio in case of entering or leaving exact region on map.  
Select to enable this option. 

Speed and Idle Control – select to enable speed and 
idle control; 

Control mode – select the control mode for speed and 
idle control in the dropdown list; 

Maximum Speed – set the maximum speed for radio; 

Maximum Idle Time – set the maximum idle time for 
radio; 

Activate Alarm mode if the rule has been triggered – 
select to activate Alarm mode in the Dispatch Console if 
Speed and Idle Control rule has been triggered 
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Allows configuring 
rules when a 
radio(s) enters or 
leaves the defined 
map region(s). 

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Speed 
and Idle Control rule has been triggered; 

Send Call Alert to a radio if the rule has been 
triggered – select to inform radio subscriber if the rule 
has been triggered; 

Reset Alarm mode if the rule is not triggered - select 
to inform radio subscriber if the rule has not been 
triggered. 

 

Scheduler See above 

 

Regions. Select 
regions to apply 
the rule 

All regions – choose to apply this rule for all regions; 

Only selected regions – choose to apply the rule for one 
or several regions; 

Select all – click to select all regions in the list; 

Deselect all – click to deselect all regions in the list. 

Radios See above 

Lone Worker. 

Enables Lone 
Worker when 
the rule has 
been triggered 

All Tasks – choose to apply all tasks configured by the 
administrator when the rule has been triggered; 

Only selected tasks – choose this option, and in the list 
below, select the Lone Worker tasks to be executed when 
the rule has been triggered. 

 

Beacons. 

Allows configuring 
rules when a radio 
(s) enters or leaves 
the beacon 
coverage zone 

General Control mode: 

Control entering beacon coverage zone – select to 
enable the rule when a radio enters beacon coverage 
zone; 

Control leaving beacon coverage zone - select to 
enable the rule when a radio leaves beacon coverage 
zone; 

Activate Alarm mode if the rule has been triggered -  
select to activate Alarm mode in the Dispatch Console if 
Beacons rule has been triggered; 

Reset Alarm mode if the rule is not triggered – select 
to reset Alarm mode in the Dispatch Console 
automatically if the rule condition was not triggered (e.g., 
when Control entering beacon coverage zone is 
selected and the radio enters the monitored coverage 
zone and then instantly leaves the zone, the alarm mode 
in the Dispatch Console will be reset automatically) 

Send Call Alert to a radio if the rule has been 
triggered – select to inform radio subscriber if the rule 
has been triggered;   

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Beacons 
rule has been triggered;   

Activate Lone Worker if the rule has been triggered – 
allows automatically activating a Lone Worker policy for a 
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radio in case of entering or leaving beacon coverage 
zone.  Select to enable this option. 

Scheduler See above 

 

Radios See above 

 

Beacons. 

Enables rule for 
selected 
beacons 

All Beacons – choose to apply this rule for all beacons; 

Only selected beacons – choose to apply the rule for 
one or several beacons. 

Lone Worker See above. 

 

 

 

 

 

 

 

Radios. 

Allows using 
radio(s)1 as a map 
region and monitor 
when another 
radio(s) enters or 
leaves radio’s 
coverage zone 

 

 

 

 

 

 

 

 

 

 

 

 

General 

Control mode: 

Control Entering Region – select to enable the rule 
when a radio enters the coverage zone associated with 
another radio; 

Control Leaving Region - select to enable the rule when 
a radio leaves the coverage zone associated with another 
radio; 

Activate Alarm mode if the rule has been triggered -  
select to activate Alarm mode in the Dispatch Console if 
Radios rule has been triggered; 

Reset Alarm mode if the rule is not triggered – select 
to reset Alarm mode in the Dispatch Console 
automatically if the rule condition was not triggered (e.g., 
when Control Entering Region is selected and radio 
enters to the monitored coverage zone and then 
instantly leaves the zone, alarm mode in the Dispatch 
Console will be reset automatically) 

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Radios 
rule has been triggered; 

Send Call Alert to a radio if the rule has been 
triggered – select to inform radio subscriber if the rule 
has been triggered;   

Minimum distance between radios – specify the 
distance, in meters. When a distance is less than the 
selected value, the rule will be triggered according to the 
settings above. 

Color of region – select the radio coverage zone color. 

Scheduler See above 

 

Regions Select radio coverage zones the rule is applied for. 

Radios See above 

 

 

Lone Worker.  

 

Days of week - select the days to activate the Lone 
Worker rule; 
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Allows configuring 
scheduled Lone 
Worker tasks 

General Start time - set the time to start the rule; 

Stop time - set the time to stop the rule. 

Radios See above 

 

 

Lone Worker 

Select all configured by Administrator Lone Worker tasks 
or several configured tasks. 

When a Lone Worker task is mentioned as Disabled, the 
administrator should enable the task.  

Idle Time 
The Idle Time feature allows monitoring vehicles idle time assigning Telemetry 
Commands on selected VIOs. 

• Click Tasks (1), and double-click Idle Time (2) in the Tasks pane. 

 

Specify the telemetry to set the Idle Time: 

 

Start 

• Specify the telemetry VIO and Command to start the Idle Time. 

Stop 

• Specify the telemetry VIO and Command to stop the Idle Time. 
The administrator can see Idle Time reports and statistics. 
Click Reports (1), and under GPS reports, click Idle Time Summary or Idle Time 
detailed (2) to see a common Idle Time report: 
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Note: Specify the speed accuracy value in the Speed box (3). 

Lone Worker 
The Lone Worker policy lets the dispatcher set a time interval the communication 
with a subscriber is expected. For example, if a lone worker has not called the 
dispatcher for 15 minutes, the radio receives a message and the Dispatcher receives 
an alarm signal. 

• To add a Lone Worker task, select Tasks (1), and click Add > Lone Worker (2). 

 

• In the Lone Worker dialog box that opens, specify the following parameters: 
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Task Start tab 

• Manually by dispatcher 
Select this option to start the Lone Worker task manually by the dispatcher. 

• Automatically by receiving Text Message from a radio 
Select this option so that the Lone Worker task will start after receiving a 
message from a radio. If you select this option, specify a text message in the 
Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option so that the Lone Worker task will start after receiving a 
telemetry command from a radio. If you select this option, specify the VIO 
contact, and from the Command drop-down list, select the signal level at 
which the user's radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option so that the Lone Worker task will start after receiving a 
predefined DTMF command, for instance, #11#. If you select this option, 
specify the DTMF combination without the # characters in the Command box. 

• Automatically by receiving Status from a radio 
Select this option so that the Lone Worker task will start after receiving a 
specified status from a radio. If you select this option, specify Status. 

• Send the following text message to the radio 
Select this option and in the Message box enter the text message that will be 
sent to the radio when a Lone Worker task is started for that radio. 

Conditions tab 
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• Radio has not been transmitting during 
Specify the time period, in minutes, during which the radio has not been 
transmitting, to enable the Lone Worker policy. 

• Send a notification to a radio to start transmitting 
Select this option to send a notification to a radio before triggering the Lone 
Worker policy if the radio has not transmitted during the specified time period. 
 Send notification before 

Specify the time period before the time comes to trigger the Lone Worker 
policy, to send a notification asking the radio to respond. 

 Send Call Alert to a radio 
Choose this option to send a call alert to the radio in case the policy has 
been triggered; 

 Send Text Message to a radio 
Choose this option to send a text message to the radio in case the policy 
has been triggered. Specify the message text in the Message box. 

• Reset Lone Worker after receiving Text Message  
Select this option to reset the Lone Worker task after receiving the message 
specified in the Message box. 

• Reset Lone Worker after receiving Telemetry command 
Select this option to reset the Lone Worker task after receiving the telemetry 
command. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's radio 
should send the telemetry command. 

• Reset Lone Worker after the distance has been traveled 
Select this option to reset the Lone Worker task after the distance specified in 
the Distance box has been traveled. 
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• Do not trigger alarm if radio is offline for less than 
Select this option so that the alarm is not triggered if the radio is offline for the 
time less the time specified in the Interval box. 

Task Stop tab 

 

While on Task Stop tab, you can specify how to stop the Lone Worker task. 
The available options are similar to those you specified on the Task Start tab. 

Enabling Lone Worker 

• To enable the Lone Worker task for a selected radio, go to Voice Dispatch (1), 
right-click the selected radio (2), and choose Start Lone Worker (3): 

 

• To monitor the Lone Worker task, click the Active Tasks tab: 
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Enabling Lone Worker from Geofencing 

• Click Location Tracking (1), and click the Geofencing button (2) in the Map 
pane: 

 

• In the Geofencing and Speed Control dialog box, click 
Add Rule > Lone Worker (1): 
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 Specify a Name for the Lone Worker rule and add a Description. 
 Days of week 

In the drop-down list, select the days of the week on which to activate the 
Lone Worker rule. 

 Start time 
Specify the time at which to start the rule. 

 Stop time 
Specify the time at which to stop the rule. 

• Click the Radios tab and add radios to which to apply the Lone Worker rule: 

 

 All radios 
Choose to apply this rule to all radios. 

 Only selected radios 
Choose to apply the rule to one or several radios. 

 Select all 
Click to select all radios in the list. 
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 Deselect all 
Click to deselect all radios in the list. 

• Click the Lone Worker tab and select the configured Lone Worker tasks: 

 

 Choose either all configured Lone Worker tasks or several configured tasks. 

Note: When a Lone Worker task is mentioned as Disabled, enable 
it on the Tasks pane. 

Radio Allocation (Sprite Forms) 
This function is used for direct communication between the dispatcher and the 
subscriber via special Tallysman Option board installed into the radio. The 
dispatcher and subscriber have special form templates. The dispatcher receives Duty 
ID of the subscriber with his template output form whereas the subscriber sends it 
using his template input form. The radio name changes to its Duty ID. 

Note: Any activity may be decoded with its Duty ID so this is a 
way to communicate for the dispatcher and subscribers 
only. 

• Click Tasks (1), and double-click Radio Allocation (Sprite Forms) (2) in the 
Tasks pane. 
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• Load the Sprite Form (output template) and select the Field Name: 

 

• Click OK to add a Sprite Form. 

Scheduled Task 
This function allows sending scheduled messages to radios. 

• To add a scheduled task, click Add (1) > Scheduled task (2): 
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 Task name 
Specify a name for the task. 

 Command 
From the drop-down list, select what to send to selected radios. 

Send Text Message 

 Message 
Enter the message text in this box. 

Send Telemetry 
Select this command to send scheduled telemetry commands to selected 
radios/groups, or request telemetry states from selected radios/groups. 

 VIO 
Specify the VIO contact. 

 Command 
From the drop-down list, select the signal level at which to send the 
telemetry command to selected radios/groups, or select 'Request state' to 
receive telemetry states from selected radios/groups. 
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Request Location 
Select this command to receive location data from selected radios/groups. 

 Send to radio group 
Choose this option to send the specified command to selected radio 
groups. 

 Send to subscribed radio 
Choose this option to send the specified command to selected radios. 

 Recipient 
In this list, select radio groups/radios to send the specified command to, or 
receive telemetry/location data from. 

Send Voice Message 
Select this command to send a voice message to selected radios/groups: 

 

 Load from file 
Click this link to load an existing file from your PC. 

 Record Message 
Click this link to record a new voice message. 

 Play back message 
Click this link to play back the voice message. 

 Specify Call type, Channel, and Call Target for a voice message. 

Note: To send a Voice Message to a subscriber from the phone 
book, click … in the Call Target column and select a contact 
from the phone book. 

 Impolite channel access 
Select this option so that the voice message will be sent regardless of 
whether the channel is busy or not. 

Scheduler tab 
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• Start date 
Select a date to start the task. 

• Stop date 
Select a date to stop the task. 

• Days of week 
In the drop-down list, select the days of the week on which to perform the 
task. 

• Execute recurrently with interval 
Choose this option to perform the task on a periodic basis. 

• Start time 
Specify the time at which to start the task. 

• Stop time 
Specify the time at which to stop the task. 

• Repeat every 
Specify a time period for periodic task executions. 

• Execute at particular time 
Choose this option and specify the times in the columns of the table below. 

SMS and Email Notifications 
TRBOnet Dispatch Console allows managing text messages: 

1. Send Text Messages from LAN to a particular radio or talk group (POP3 
Server); 

2. Forward all Text Messages from radios to base radio to particular email 
address (SMTP Server). 

Note: Microsoft Exchange Server can be used as SMTP and POP3 
servers. For more details on SMTP or POP3 servers, ask your 
System Administrator. 

To enable the task, click Tasks (1), and double-click SMS and Email notifications 
(2) in the Tasks pane. 
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SMS settings tab 

 

 Send SMS to recipients if ALARM has been activated 
Select this option to send an SMS in case of an alarm on the radio. 

 Send MMS to recipients if ALARM has been activated 
Select this option to send an MMS in case of an alarm on the radio. 

Forward Text Messages to cell phone recipients 

 Input messages (from radio network to dispatchers) 
Select this option to forward incoming text messages to cell phones. 

 Output messages (from dispatchers to radio network) 
Select this option to forward outgoing text messages to cell phones. 

For more details on SMS settings, see Outgoing Mail Server (SMTP). 
A radio sends text messages to the base station. TRBOnet Server forwards all text 
messages to a particular email address (e.g. admin@yourcompany.com). The 
administrator receives text messages from radios as regular emails. 

Outgoing Email settings (SMPT) tab 

mailto:admin@yourcompany.com
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 Send Email to recipients if ALARM has been activated 
Select this option to send an Email in case of an alarm. 

Forward Text Messages to email recipients 

 Input messages (from radio network to dispatchers) 
Select this option to forward incoming text messages to Email address(es). 

 Output messages (from dispatchers to radio network) 
Select this option to forward outgoing text messages to Email address(es). 

Incoming Email settings tab 

TRBOnet Server connects to POP3 server, reads emails and sends text messages to 
radios or talk groups. 

1. Create an email account on your email server. 
2. Send an email to radioserver@yourcompany.com. In the Subject field, enter 

Radio ID: XXX to send an email to a selected radio, or Group ID: XXX to send 
an email to a selected radio group. 

Note: If you don't properly specify the email Subject, or specified 
a non-existing Radio ID, a corresponding notification will 
appear in the Event Log of the Dispatch Console. 

• Forward incoming emails to radio network (from email box to radios) 
Select this option to forward incoming emails to radio network. 

User Activity 
The User Activity function allows the dispatcher to create lists of radios, to which 
radios can be assigned due to their activity. 
For example, if a subscriber sends an On duty message or presses an exact preset 
telemetry button, this subscriber gets assigned to the On duty list in the Dispatch 
Console. The dispatcher can also manually assign subscribers to lists. 

• To enable the User Activity task, click Tasks (1), and double-click User Activity 
(2) in the Tasks pane: 

mailto:radioserver@yourcompany.com
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Lists of radios tab 

 

• Click Add to add a list of radio activities: 
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• Name 
Specify a name for the user activity list. 

• Description 
Add a description for the user activity list. 

• Background 
Select the background color to display the radios assigned to the list. 

Move a radio to this list if: 

• Manually by dispatcher 
Select this option to assign radios to the list manually. 

• Automatically by receiving Text Message from a radio 
Select this option to assign a radio to the list after receiving a text message 
from the radio. If you select this option, specify a brief text message in the 
Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to assign a radio to the list after receiving a telemetry 
command. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's radio 
should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option to assign a radio to the list after receiving a predefined 
DTMF command, for instance, #11#. If you select this option, specify the DTMF 
combination without the # characters in the Command box. 

To assign offline radios to the default User Activity list, click the Advanced tab: 

 

• Automatically set the default status for offline radios 
Select this option to allow assigning the default status for offline radios. 

• Timeout 
Specify the time period, in minutes, after which the default status is set to a 
radio. 
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Voice Message 
The Voice Message allows automatically broadcasting a predefined Voice Message 
after receiving a telemetry command, a text message or a DTMF command. 

• To add a Voice Message task, select Tasks (1), and click Add > Voice Message 
(2). 

 

The user can have several Voice Message policies for different purposes. Specify a 
name of the policy in the Task name box and set the policy's parameters. 

Task Start tab 

 

• Manually by dispatcher 
Select this option to allow the dispatcher to manually start the Voice Message 
task. 
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• Automatically by receiving Text Message from a radio 
Select this option to start the Voice Message task after receiving a specified 
text message from a radio. If you select this option, specify a brief text 
message in the Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to start the Voice Message task after receiving a telemetry 
command. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's radio 
should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option to start the Voice Message task after receiving a DTMF 
command from a radio, for instance, #11#. If you select this option, specify the 
DTMF combination without the # characters in the Command box. 

• Automatically by receiving Emergency from a radio 
Select this option to start the Voice Message task after receiving an emergency 
command from a radio.  
 Emg. Type 

From the drop-down list, select the type of emergency to be sent from a 
radio. 

• Activated by any radio 
Choose this option to expect receiving data from any radio in the system. 

• Activate by specific radios only 
Choose this option to expect receiving data from selected radios. 
 Radio 

In the drop-down list, select the radio(s). 
• Send Text Message to a radio 

Select this option so that a text message will be sent to the radio that activated 
the Voice Message task. If you select this option, specify a brief text message 
in the Message box. 

Task Process tab 
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• Send Voice Message once 
Choose this option to send the voice message to a selected radio (s) only 
once. 

• Send Voice Message repeatedly 
Choose this option to send the voice message repeatedly. 
 Repeat Interval 

Specify the repeat interval, in seconds. 
 Repeat Count 

Select this checkbox and specify the number of times to repeat the voice 
message. 

• Impolite channel access 
Select this option so that the voice message will be sent regardless of whether 
the channel is busy or not. 

• Start delay 
Select this checkbox and specify the delay time, in seconds, for the Voice 
Message task. 

Task Stop tab 

Note: These options are available only if you have selected the Send 
Voice Message repeatedly option in the Task Process tab. 
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• Manually by dispatcher 
Select this option to allow the dispatcher to manually stop the Voice Message 
task. 

• Automatically by receiving Text Message from a radio 
Select this option to stop the Voice Message task after receiving a message 
from a radio. If you select this option, specify a text message in the Message 
box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to stop the Voice Message task after receiving a telemetry 
command from a radio: If you select this option, specify the VIO contact, and 
from the Command drop-down list, select the signal level at which the user's 
radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio  
Select this option to stop the Voice Message task after receiving a DTMF 
command from a radio, for instance, #11#. If you select this option, specify the 
DTMF combination without the # characters in the Command box. 

• Send Text Message to a radio 
Select this option so that a text message will be sent to the radio that stopped 
the Voice Message task. If you select this option, specify a brief text message 
in the Message box. 

Message tab 
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• Load from file 
Click this link to load an existing file from your PC. 

• Record Message 
Click this link to record a new voice message. 

• Play back message 
Click this link to play back the voice message. 

• Specify Call type, Channel, and Call Target for a voice message. 

Note: To send a Voice Message to a subscriber from the phone 
book click … in the Call Target column and select a contact 
from the phone book. 

Telemetry tab 
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• Send telemetry before starting task 
Select this option to send a telemetry command before the voice message is 
transmitted. 
 Specify the VIO contact number. 
 Select the signal level from the Command list. 
 Delay after sending 

Specify the time period, in seconds, that will be used as a delay timeout for 
the voice message after the telemetry command is sent. 

• Send telemetry after stopping task 
Select this option to send a telemetry command after the Voice Message task 
is stopped. 
 Specify the VIO contact number. 
 Select the signal level from the Command list. 
 Delay before sending 

Specify the time period, in seconds, that will be used as a delay timeout 
before sending the telemetry command after the Voice Message task is 
stopped. 

• Recipient 
In the drop-down list, select the radios/groups to send the telemetry 
command to. 

• Send Telemetry on every Voice Message 
Select this option to send the telemetry command to the selected 
radios/groups every time the voice message is sent, provided the voice 
message is repeatedly sent. 

Scheduled Report 
The Scheduled Report task allows reporting on selected parameters and sending 
these reports to selected Email subscribers groups. The user can have several 
Scheduled Report policies for different purposes. 

Note: Before configuring the task, you need to create a number 
of the Email groups to send reports to. For more details on 
Email groups, see Email Groups section. 

• To add a Scheduled Report task, select Tasks (1), and click Add > Scheduled 
Report (2): 
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• Specify a name of the policy in the Task name box and set the policy 
parameters. 

 

• On the Report tab, select the type of a report for the Scheduled Report task. 
The report details and filter might be different. 
For more details on reporting, see User Guide, section Reports and Statistics. 

• Click the Schedule tab to configure a schedule for the report. 

http://s3.trbonet.com/download/docs/latest/TRBOnet_User_Guide_V_4.4_.pdf
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• Start date and Stop date 
Select the time period over which to generate reports and send them to email 
group. 

Note: The start date may be any date you choose to start the task 
on. The stop date must be later or the same as the current 
date. 

• Days of week 
In the drop-down list, select the days of the week you want to generate 
reports on. 

• Start time 
Specify the time to start generating the report at. 

• Statistic period 
Select the time interval (in minutes, hours, days, weeks, or months) to collect 
the data. 

• Email groups 
In the list, select Email groups to send the report to. 

The created scheduled report will be displayed in the Tasks pane: 
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To enable the task, just select the checkbox in front of the Scheduled Report task 
you have already created. 
There are three types of the Scheduled Report status icons: 

• Green indicates an active task, meaning the task is enabled (checked). 
• Grey indicates an inactive task, meaning the task is disabled (unchecked). 
• Red indicates a disabled task, meaning the task period is up in the past. 

6.5.1.6 Event/Alarm Management 
The Event/Alarm Management feature allows creating action rules for Alarms, 
Emails, Notifications, Text Messages to radios etc. When a configured rule is 
executed, a configured action will start. 
For example, an external application sends text data which contains the text "alarm" 
to TRBOnet software. The text "Alarm" is configured as the rule to start sending a 
predefined voice message to selected radios (e.g. the group "firemen") with (e.g. 
"Alarm in Sector N"). As a result, the group "firemen" is notified about emergency 
condition. 

• Go to Administration (1), Event/Alarm Management (2) to set Event/Alarm 
Management: 
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• Click Add (3) to add a new Event/Alarm Management configuration. 
• The administrator can create a copy of the existing Event/Alarm Management 

configuration. Select a configuration in the list and click the Create a Copy 
button. The system will create a copy with the same configuration parameters. 

• On the Source tab (1), click Add (2) to add a new data source for the action. 

 

 Event 
From the drop-down list (3), select the event type to set as a rule for the 
action. 
For the settings for various event types, see the table below: 

Event Type Parameters Description 

Text 
Message 

Activated by any radio – choose to receive text messages with predefined 
text from any radio in the system to enable the action; 

Activate by specific radios only - choose to receive text messages with 
predefined text from selected radios in the system to enable the action; 

Text Contains – specify the text or characters that the text messages from 
radios must contain to start the action selected in the Action page. 

Telemetry Activated by any radio – choose to receive telemetry data from any radio in 
the system to enable the action; 
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Activate by specific radios only - choose to receive telemetry data from 
selected radios in the system to enable the action; 

VIO – specify VIO to send telemetry; 

Command – specify a command for selected VIO. 

DTMF 

Activated by any radio – choose to receive DTMF command from any radio 
in the system to enable the action;  

Activate by specific radios only - choose to receive DTMF command from 
selected radios in the system to enable the action; 

Command – specify DTMF command to start the action. 

COM Port 

COM Port – select the COM Port connection configured in Server; 

Regular Expression – specify the text or characters that the external 
application data must contain to start the action selected in the Action page. 
For more details on regular expressions, see the Wiki article. 

External 
Network 
Connection 

Connection – select the connection configured in Server in the TCP/IP page; 

Regular Expression – specify the text or characters the external application 
data must contain to start the action selected in the Action page. For more 
details on regular expressions, see the Wiki article. 

Alarm 

Activated by any radio – choose to receive an alarm from any radio in the 
system to enable the action; 

Activate by specific radios only - choose to receive an alarm from selected 
radios in the system to enable the action; 

Alarm – select alarm type in the dropdown list. 

Emergency Alarm – alarm configured in radio Code Plug; 

Man Down – radio's Man-Down monitoring; 

No Movement – radio's No-Movement monitoring; 

Crash Detect – radio's speed and sudden stop monitoring; 

Geofencing - control the location and speed of radios relative to manually 
defined map regions. 

Radio State 

Activated by any radio – choose to receive radio state data from any radio 
in the system to enable the action; 

Activate by specific radios only - choose to receive radio state data from 
selected radios in the system to enable the action; 

Radio is detected as online –  select to start the action when a radio is 
online; 

Radio is detected as offline - select to start the action when a radio is 
offline; 

Radio fixed GPS - select to start the action when a radio has fixed GPS 
signals; 

Radio lost GPS - select to start the action when a radio has lost GPS signals. 

 

Note: Select the checkbox beside the event you want to enable. In 
case no event is selected, all configured events are disabled 
by default: 

http://en.wikipedia.org/wiki/Regular_expression
http://en.wikipedia.org/wiki/Regular_expression
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• Click the Location tab (1) to set the regions for the action. 
When the Location rule is enabled and a region is selected, the events 
specified in the Source tab must take place in the selected region to start the 
action. 

Note: When COM Port and/or External Network Connection 
are selected as the event source, the Location rule should 
not be used. 

 

 Enable 
Select this option to apply the Location rule to the action. 
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 All Regions 
Choose this option to use Source Event rule in all map regions to start the 
action; 

 Selected Regions 
Choose this option to use Source Event rule to start the action only in 
selected regions. 
• Region 

In the list, select the region(s). 
• Click the Action tab (1) to set actions for the Source Event and Location 

rules. 
In the Actions list, the administrator can add and configure the action types to 
be started when the rules configured in the Source and/or Location pages are 
executed. 

• Click Add (2) to add an action: 

 

 Action Type 
From the drop-down list (3), select the action type. 
For the settings for various action types, see the table below: 

Action Type Parameters Description 

Alarm Not applicable. 

Email 

Recipients – select email recipients in the drop-down list; 

Subject – enter the subject of the email to send to recipients; 

Variables –add variables to include in the email subject: 

Text – enter the email text to send to recipients; 

Variables –add variables to include in the email text: 

Job Ticket 

Deadline – select the task end time; 

Recipients – select the radios or radio groups registered in the system; 

Description – add a description for the Job Ticket; 

Variables – add variables to include in Job Ticket description. 
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Notification 

Severity – select the severity level from the drop-down list. 

Information – low severity level; 

Warning – middle severity level; 

Alarm –high severity level. 

Text – add text to the notification to display in the Dispatch Console; 

Variables – add variables to include in the notification. 

Request 
Location Not applicable. 

SMS  

Recipients – select SMS recipients from the drop-down list; 

Text – enter the SMS text to send to recipients; 

Variables – add variables to include in the SMS text. 

System 
Bridging 

Profiles – select the System Bridging profile to activate/deactivate; 

Activate/deactivate – choose the action type for the System Bridging 
profile. 

Telemetry 

VIO - select the VIO to send telemetry commands to; 

Command – select a signal level for the command for selected VIO; 

Recipients – select radios or radio groups to send telemetry commands to. 

Text 
Message 

Recipients – select text message recipients in the drop-down list; 

Text Message – enter the message text to send to recipients; 

Variables –add variables to include in the message text. 

Text to 
Speech 

The Text to Speech feature allows converting text to speech: 

 
1 – click the Add link to add a text to convert to speech; 

2 – configure Call Type, Channel and Call Target to send the text converted 
to speech. 

Text – enter the text to be converted to speech. 

Variables - add variables to include in the message to be converted to 
speech. 

Voice 
Message 

Voice Messages – select recorded voice messages. For more details on 
Voice Messages, see section Voice Message. 
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Note: After you configure the rule, enable it by selecting the 
checkbox beside it. In case when no rule is selected, the 
action will not be started. 

 

6.5.1.7 Telemetry 
On the Telemetry page you can configure settings for Telemetry. 

Radio Groups Telemetry 
This is a default telemetry profile that is used to send telemetry commands to radio 
groups. 

• Click Radio Groups Telemetry in the Administration pane. 
• In the Telemetry configuration pane, click Edit. 
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 Click Add and specify ID (VIO), Name, and Command (signal level). 

Note: For Radio Groups Telemetry only the Digital Outputs tab 
is available. 

Adding Telemetry Profile for Radios 
• Go to Administration (1), Telemetry (2), and click Add (3): 

 

 

 

 Specify Telemetry Type for Radio groups: 
• MOTOTRBO – telemetry from Motorola devices. 
• Novox – telemetry from Novox devices connected to a radio via COM 

port. 
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• Swift.Tracker – telemetry from Swift.Tracker sensors connected to a 
radio over-the-air. 

• Sprite – telemetry from Sprite devices. 

Note: Sprite telemetry profile can be read but not written. 

 Profile name 
Specify a name of the profile to display in the Dispatch Console. 

 Click OK. 

 

Common tab 

 Auto request input states 
Select this option and in the Request interval box specify the time interval, 
in seconds, to request input data. 

 Trace digital inputs 
Select this option to monitor digital input damages. 

 Trace analog inputs 
Select this option to monitor analog input damages. 

 Replace state event to VIO events 
Select this option to generate VIO ON/OFF event when the system 
compares between the last and the current states of the VIO. 

Note: Most of the policies are set to replace events, so it is 
recommended to enable this option. 

Digital Inputs 
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• Click Add to add a VIO (Virtual Configured PIN) to the profile. 
 ID 

Select the VIO to set the parameters for. 
 Name 

Specify a name for the VIO to be displayed in the Dispatch Console. 
 Event 

Select the signal level of VIO events from the drop-down list. When an 
event with the selected signal level occurs on the selected VIO, the 
telemetry will be activated. The signal level must be the same in the radio's 
Code Plug and in Telemetry configuration in TRBOnet. It is a programmable 
option that sets the pin's voltage level to High or Low in order to trigger a 
selected functionality. 

 Severity 
Specify a severity level for the VIO event from the drop-down list. 

 Display as subscriber state 
Select this option so that the radio will change its status after it sends the 
telemetry command. 

 Auto reset state 
Select this option to automatically reset the telemetry VIO after the radio 
sends the telemetry command. 

 Request location of subscriber 
Select this option to request a GPS position of the radio after it sends the 
telemetry command. 

 Click Apply to apply settings to selected inputs. 

Digital Outputs 
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• Click Add to add a VIO (Virtual Configured PIN) to the profile: 
 ID 

Select the VIO in the dropdown list to set its parameters; 
 Name 

Specify a name for the VIO to be displayed in the Dispatch Console. 
 Command 

Specify a signal level for the command to send to the selected VIO. 
 Click Apply to apply settings to selected outputs. 

6.5.1.8 GPS Profile 
The GPS Profile feature allows configuring different profiles of GPS update settings 
for built-in GPS receiver. GPS Profile overrides default GPS trigger configuration in 
Server settings. For example, fire emergency service has a number of departments in 
a city and needs to monitor current position of radio subscribers (firemen). The 
administrator can create a number of separate GPS profiles with different GPS 
tracking settings for each department. 

Note: The GPS Profile feature is available for MOTOTRBO 
Generation II radios, firmware version 2.4 or later. 

Go to Administration (1), GPS Profile (2). You can see the default GPS Profile 
settings (3) in the GPS Profile pane. 
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There is a default GPS Profile that the administrator can use and edit. 
The administrator can do the following: 

1. Use default GPS profile. 
2. Create a custom GPS profile: Add button. 
3. Edit a profile: Edit button. 

Note: In the default profile, the Name and Description cannot be 
changed. 

Adding a GPS Profile 
• In the GPS Profile pane, click the Add button. 

 

 GPS type 
Select the GPS type. 

 Profile name 
Enter a name of the profile. 
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• Name 
Specify a name for the GPS profile. 

• Description 
Add a description for the GPS profile. 

• Save GPS data to database 
Select this option so that GPS data is saved in TRBnet database. 

• Manage trigger manually 
Select this option so that GPS triggering will be started manually by the 
dispatcher. 

• GPS channel type 
From the drop-down list, select a radio channel for sending location data to 
TRBOnet Server: 
 Non-scheduled 

This is a channel with regular GPS (Enhanced GPS not supported). 
 Scheduled 

This channel is available when the Enhanced GPS feature is configured in 
the radio system. 

 Non-scheduled with CSBK data 
This channel allows using CSBK (Control Signaling Block) while decoding. 

 Scheduled with CSBK data 
This is a channel with Enhanced GPS, which allows using CSBK (Control 
Signaling Block) while decoding. 

• GPS data 
Select this option to enable sending GPS data to TRBOnet Server. In the drop-
down list, select which GPS data to include in a packet. 

• iBeacon data 
Select this option to enable sending iBeacon data to TRBOnet Server. In the 
drop-down list, select which iBeacon data to include in a packet: 
 Major, Minor (included by default and cannot be disabled) 
 UUID 
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 TX Power, RSSI 
• Periodic Trigger 

Select this option to set a periodic GPS trigger on a radio. The trigger initiates 
the radio to send GPS and/or iBeacon data at the specified time interval. 
 Interval 

Specify the update interval, in seconds. 
• Distance trigger 

Select this option to allow receiving GPS updates by a distance: 
 Distance 

A radio will send GPS updates if it exceeds a specified distance from the last 
GPS point, in meters. 

 Min. interval 
A radio will send GPS updates if it does not move within a specified period 
of time, in seconds. 

• Telemetry trigger 
Select this option so that a radio will send GPS and/or iBeacon data upon 
sending a Telemetry command. 

• Emergency Trigger 
Select this option so that a radio will send GPS and/or iBeacon data upon 
entering the emergency mode. 
 Show emergency mode for Radio when Emergency GPS message is 

received 
Select this option if you want a Dispatch Console operator to see the 
emergency status of a radio that transmitted location data. 

• Click OK to save the GPS profile settings. 

To apply GPS Profile to a radio: 

• Go to Administration (1), Radios (2), select the radio in the table, and click 
Edit (3): 
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 Click the General tab, and from the GPS Profile list select the GPS profile. 
 Select/clear the Location Enabled checkbox to enable/disable the location 

trigger. 

Note: The GPS Profile is only applicable when the 'Built-in GPS 
receiver' is selected in the GPS Source. 

6.5.1.9 Tools 
On the Tools page, you can find some useful tools. 

Swift.Tracker Configuration Tool 
In general, a MOTOTRBO™ portable radio comes with a standard option board 
factory-installed to the radio. 
Generic Option Board replaces this standard option board, new radio like XPR 7550 
come with Generic Option Board already installed. Generic Option Board can be 
flashed with custom firmware to provide additional functionality: ManDown, No 
Movement, Crash Detect, Lone Worker and event-driven GPS functionality. Event-
driven GPS feature allows to collect GPS data more frequently, store and forward 
GPS data by event, also it allows to collect and store GPS data while radio is out of 
radio coverage to request GPS data when comes back to radio coverage. 
Go to Administration (1), Swift Configuration Tool (2) to manage Swift.Tracker 
settings: 
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Click Add to add a configuration for Swift Tracker. 
• Name 

Specify a name for the configuration to apply to a radio or a group of radios. 
• Description 

Add a description for the configuration. 
• Set Defaults 

Click this button to enable default settings. 
On the General tab, set general settings for Swift Tracker: 

 

Modules 

• Enable GPS Tracker- when GPS enabled radio sends data to TRBOnet Server 
according individual GOB settings. 

• Enable "No Movement" Alarm - select to enable No Movement feature; 
• Enable "Man Down" - select to enable Man Down feature. 
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General report 

• Report period (sec.) - select time period for data transfer to the server; 
• Number of retries - specify the number of retries when data transfer is 

impossible. If the channel is busy data transfer to the server is priority and TX 
Interrupt feature will be enabled automatically; 

• Retry delay - select time period between data transfer retries. 

Radio settings 

• Network radio ID (CAI ID) - select your Server PC network radio ID. ID=13 is 
a default value to route packet to Server PC, value 12 will send packets to a 
control station. 

• Target Radio ID - select target radio ID for data transfer. In case of direct 
connection to repeater select the TRBOnet server ID (TRBOnet peer ID). 

• Port - select port for data transfer. 
• Automatically Switch to Revert Channel - select to transfer data via revert 

channel in automatically mode. 

Note: If the radio does not have a revert channel, this option must 
be disabled. 

On the GPS Tracker tab, set GPS Tracker settings: 

 

GOB data Storage 

• Save GPS data on passing distance every (m) - specify the distance. When 
the indicated distance is passed radio saves the data in Option Board memory 
but GPS data are not added in the report; 

Adding data to report 

• Speed and Direction - select to receive radio speed and direction data; 
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• Add data to report every (m) - specify the distance. When indicated distance 
is passed radio adds data to the report. At this case the data is saved in the 
report to send the report according to selected time period (see «Report 
Period » option). 

Note: Number value Add data to report every (m) must exceed 
number value Save GPS data on passing distance every (m). 

• Minimal direction angle - select minimal direction angle to add data to the 
report automatically (if the radio reverses the direction the current data is 
added to the report automatically and next data recording is started). 

• Add data to report every (sec.) - specify time period for the report. When the 
indicated time period is passed radio adds the data to the report. 

Report Transmit Conditions (custom report settings) 

• Report period (sec.) – set time period to send the report; 
• Passed distance is more than (m) - type in the distance. When the indicated 

distance is passed the Option Board sends the report. 

Note: Number value Add data to report every (m) must exceed 
number value Save GPS data on passing distance every (m). 

• Speed exceeds - select speed. When current speed is more than the indicated 
one, radio sends data to the TRBOnet Dispatch Software server; 

• Stop/Idle Time is more than (sec.) - select stop/idle time. When stop/idle 
time is more than the indicated one radio sends data to TRBOnet Server. 

Go to Tasks page to set Man Down, No Movement, Lone Worker and Crash Detect 
settings: 
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• Activate the accelerometer on the radio switching on - select to enable 
accelerometer; 

• Disable alarm by button click – select to allow radio subscriber disable alarm 
notification by pressing any button on the radio. 

"Man Down" settings 

• Activation angle - select activation angle to enable Man Down feature; 
• Pre-Alarm (1) Timeout (sec.) - select time period preceding pre-alarm Tone 

1; 
• Pre-Alarm tone (1) - select pre-alarm tone. All pre-alarm tones can be found 

in radio’s code plug configuration. 

"No Movement" Settings 

• Vibration Threshold (%) - select max. vibration threshold for No Movement 
feature; 

• Pre-Alarm Timeout (sec.) - select time period preceding pre-alarm Tone 1; 
• Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in 

radio’s code plug configuration. 

"Lone Worker" Settings 

• Timeout (sec.) – select time period to enable Lone Worker alarm; 
• Pre-alarm tone - select pre-alarm tone. All pre-alarm tones can be found in 

radio’s code plug configuration; 
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Second Pre-Alarm Notification 

When pre-alarm tone (1) activates for Man Down, No Movement and Lone 
Worker, and there was no user’s activity (the radio remains unchanged), the second 
pre-alarm tone activates: 

• Timeout (sec.) - select time period preceding pre-alarm Tone 2; 
• Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in 

radio’s code plug configuration; 
• Volume Level Increase (%) - select the percentage of the Volume Level 

Increase for pre-alarm Tone 2; 
• Pre-Alarm Duration (sec.) - select pre-alarm Tone 2 duration. 

"Crash Detect" Settings 

• Crash Threshold (g) - select acceleration changing value to enable Crash 
Detect alarm notification; 

• Movement Stop Timeout – select the time period of movement stop to 
enable Crash Detect alarm notification; 

• No Movement Timeout - select the time period of the radio without any 
movement to enable Crash Detect alarm notification; 

Emergency call 

• TRBOnet Emergency Timeout (sec.) - select time period preceding 
emergency tone to the Dispatch Console for Man Down, No Movement and 
Lone Worker options; 

• MOTOTRBO Emergency timeout (sec.) - select time period preceding 
emergency tone to the Dispatch Console. 

Note: MOTOTRBO Emergency Alarm should be set in Radio’s 
code plug. 

Sound notification after emergency call 

• Timeout (sec.) – select time period to repeat the alarm notification. To stop 
the alarm notification Dispatcher should disable alarm notification; 

• Tone – select the notification tone. All tones can be found in radio’s code plug 
configuration. 

Click Set defaults to apply default values. 
Click Import to import Swift .Tracker configuration from file. 
Click Export to save Swift .Tracker configuration as a file to the PC. 
Click the Input Pins tab to set the priority for Enabled/Disabled Pins: 
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Select programmed Pin in Enabled/Disabled Pins table. 
Select data transmission priority for Pin: 

• Deferred - to send the data into current packet; 
• In Memory - to save the data in the GOB memory; 
• Immediately - transmission interrupt - oriented. Select Immediately to 

transmit the data via free channel with radio channel priority; 
• Extremely - transmission via radio channel and GSM channel simultaneously. 

The PIN options are model dependent. All available PINs for the radio can be 
programmed in Radio’s codeplug configuration (See Accessories, GPIO Physical 
PINs) 

Note: Additional PINs are available only when GSM Swift.Tracker 
is connected. For more details, contact our technical 
support. 

• Click OК to save the settings. 

Templates for Extended Messages 
The Templates can be used for Extended Messages and Extended Notes. 
The Extended Messages feature is a special function allowing users to send detailed 
preconfigured templates containing necessary information to each other with the 
help of the special TRBOnet Dispatch Console application. 
This service has been created especially for clients who need to use more detailed 
and structured messages in their work. If the standard messages are not enough to 
contain all required information, you may use the Extended Messages service. 

• Go to Administration (1), Templates (2) to create a new template: 
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• Click Add From File (3) to add a template from file. 

Note: Before adding a template from file, save the created 
template to a custom directory. 

Select the directory where you saved the template and click OK to add the file. 
• Click Add (4) to create a new template: 

 

 Name (1) 
Specify a name for the template to display in the Dispatch Console (1). 

 Elements (2) 
Select elements to add to the template. Drag and drop the selected 
element to the desired place on the mail template box. 

 Template size (3) 
Specify the template dimensions and background color. 

 Click an element on the template. On the right side of the Template dialog 
box, you can see the selected element properties. 

Sending a template to a radio 
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• Click Text Messages (1) 
• Click the View menu, and select Show Extended Messages Tab (2) 
• In the Text Messages pane, click the Extended tab (3), and New message (4). 

 

• Select the template in the list (1). 
• From the drop-down list (2), select a radio to which to send the template. 
• Click Send to Radio (3) to send the template to a radio. 

Indoor 2D Map Converter 
TRBOnet Dispatch Console provides the Map Converter to use custom images as 
Indoor 2D Floor plans. The tool allows converting images to the BMAP format that is 
supported in Indoor Positioning. 

• Click Administration (1), Tools > Indoor 2D Map Converter (2). 
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• Name 
Specify a name for the new Indoor 2D Map. 

• Image 
Click … and locate the image (PNG, JPG, TIFF, GIS) on your computer. 

• Directory 
Click … and locate the folder where to save the converted Indoor 2D map on 
your computer. 

• Click Start to convert the image. 

To use the converted map 

• Click Location Tracking (1). On the Map menu, click Open New Map in Tab 
(2): 
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• From the Map Type list box, select 'Beacon 2D': 
• Click Add to and browse for the map you have converted. 
• Click OK to open the Indoor map in the Map pane. 

6.5.1.10 Disabled Radios 
TRBOnet Dispatch Console provides the Stun Kill Passive function that allows 
disabling a radio even if the radio is offline. The system will disable an offline radio 
as soon as it gets available. 

Note: The dispatcher can disable a radio when they have relevant 
Access Rights (for more details on adding and editing 
dispatchers, see Dispatchers section). 

• Go to Administration (1), Disabled Radios (2) to disable selected radio: 

 

• Click Disable Radio (3) and in the dialog box that opens: 
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 Radio 
Select a radio from the drop-down list. 

 Unlock 
Select the time period after which to unlock the radio. 

 Reason 
Enter the reason for disabling the radio. 

 Click OK to disable the radio. 

 

The Radio is added to the Disabled Radios list and is marked as Disabled in the 
Voice Dispatch pane: 

 

• Click Enable Radio (4) to enable selected radio. 
• Select a radio from the drop-down list and specify the reason to enable. 
• Click OK to enable the radio. 

6.5.1.11 Dispatchers 
The administrator can add, edit, and delete dispatchers in the system. 
Go to Administration (1), Dispatchers (2) to work with dispatchers: 
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• Click Add (3) to add a dispatcher. 

 

• On the General tab, specify general parameters for the new dispatcher. 
 Authentication 

Select the Authentication method from the drop-down list. 
Select TRBOnet Authentication to log on as a user registered in TRBOnet 
Dispatch Console users list. 
Select Windows Authentication to log on using the PC name. The system 
automatically shows the PC name as User Name. 

Note: The password is not required when Windows 
Authentication is used. 

Note: For more details on user access to Allocation Console, see 
Users section. 
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 User Name 
Specify a user name for the dispatcher registered in TRBOnet Dispatch 
Software users list. 

 Password 
Specify a password for the dispatcher. 

• Display Name 
Specify a name for the dispatcher to display in the Dispatch Console; 

• Description 
Add a description for the dispatcher. 

• Dispatcher Groups 
In the drop-down list, select the group(s) of dispatchers to which to assign the 
dispatcher. Click + to add a group of dispatchers to the list. 

• Available modes 
In the drop-down list, select the modules that will be available for the 
dispatcher in the Dispatch Console. 

• Invisible to all other users 
Select this option to make the dispatcher invisible for other users. 

• Invisible to all except the assigned groups 
Select this option to make the dispatcher invisible for other users except for 
users belonging to the same group of dispatchers. 

• Allow multiple simultaneous logons  
Select this option to allow the dispatcher to use multiple instances of Dispatch 
Console simultaneously. 

On the Dispatcher Rights tab, specify the available access rights for the dispatcher. 

 

On the Radio Systems tab, specify the radio system(s) that will be available for the 
dispatcher. 
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• All Radio Systems are available 
Choose this option to make all radio systems available for the dispatcher to 
transmit and receive Voice and Data. 

• Only selected Radio Systems are available 
Choose this option and specify which radio systems will be available to the 
dispatcher. 
 Select the checkbox in the left column to add the corresponding radio 

system to the Radio Interface for the dispatcher. 
 Select the checkbox the TX column to allow the dispatcher to make Voice 

calls using the corresponding radio system. When the checkbox is cleared 
in the TX column, the dispatcher cannot use the corresponding radio 
system to transmit voice and data. 

On the Radio Groups tab, specify a group to assign the dispatcher to. 
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• All groups are available 
Choose this option to make all groups in the system available for the 
dispatcher. 

• Only selected groups are available 
Choose this option and specify which radio groups will be available to the 
dispatcher. 
 In the list, select the groups to make them available for the dispatcher. 

On the Dispatch Call tab, specify Dispatch Call and SIP call settings for the 
dispatcher: 

 

• Radio ID 
Specify the Radio ID of the dispatcher. 

• Phone number 
Specify the dispatcher's phone number (additional data). 

• Email 
Specify the dispatcher's Email (additional data). 

Phone Call 

• SIP ID 
Enter the SIP ID that will be used by the dispatcher. 

• SIP Name 
Enter the SIP user name that will be used by the dispatcher. 

• Password 
Enter the password for the dispatcher to be authenticated by the telephone 
system. 

• SIP Profile 
From the drop-down list, select the SIP profile to use. 

On the Request to Talk tab, specify parameters that will be used by radios to 
request a call from the dispatcher: 
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• Automatically by receiving Text Message from a radio 
Select this option to request a call from the dispatcher when a radio sends a 
predefined text message. If you select this option, specify a brief text message 
in the Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to request a call from the dispatcher when a radio sends a 
predefined telemetry command. If you select this option, specify the VIO 
contact, and from the Command drop-down list, select the signal level at 
which the user's radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option to request a call from the dispatcher when a radio sends the 
specified DTMF tones. If you select this option, specify the DTMF combination 
without the # characters in the Command box. 

• Automatically by receiving Status from a radio 
Select this option to request a call from the dispatcher when a radio sends the 
specified Status to TRBOnet Server, for instance, 1. If you select this option, 
specify the Status. 

On the Reports tab, specify the reports that will be available to the dispatcher. 
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• All reports are available 
Choose this option so that all the reports will be available to the dispatcher. 

• Only selected reports are available 
Choose this option and in the list below select/deselect the reports to 
include/exclude. 

6.5.1.12 Email Groups 
Email Groups are used in Event/Alarm Management and Job Tickets configuration to 
send emails to dedicated recipient groups. 
Go to Administration (1), Email Groups (2) to add/edit/delete email groups in the 
system: 

 

• Click Add (3) to create an email group. 
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 Name 
Specify a name for the email group. 

 Description 
Add a description for the email group. 

 Email list 
Click Add to add an email address to the Email list. 

6.5.1.13 SMS Groups 
SMS Groups are used in Event/Alarm Management configuration to send SMS to 
dedicated SMS recipient groups. 
Go to Administration (1), SMS Groups (2) to add/edit/delete SMS groups in the 
system: 

 

• Click Add to create a new SMS group: 
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 Name 
Specify a name for the SMS group. 

 Description 
Add a description for the SMS group; 

 Phone Numbers 
Click Add to add a phone number to the SMS group. 

6.5.1.14 Users 
Go to Administration (1), Users (2) to add/edit/delete users in the system: 

 

• Click Add (3) to add a new user to the system: 
• On the General tab, set general parameters for the user: 
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 Login 
Specify the login to log on to the Dispatch Console. 

 Password 
Type in the individual password. 

 Display Name 
Specify a name for user to display in the Dispatch Console. 

 Max radios count 
Select a number of radios that will be available for the user. 

 Description 
Add a description for the user. 

• On the Radios tab, specify the radios available to the user. 

 

 Allow all radios 
Choose this option to allow using all radios in the system. 
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 Only selected radios 
Choose this option and specify which radios will be available to the user. 

• On the Advanced tab, specify settings related to taking/returning radios: 

 

 Lock radio on return 
Select this option so that a radio will be disabled after the users returns it. 

 Allow DTMF management 
Select this option to allow taking/returning radios by sending the specified 
DTMF tones. 
• Take radio 

Specify DTMF tones to be sent by the user to take a radio. 
• Return radio 

Specify DTMF tones to be sent by the user to return a radio. 
 Allow Text Messages management 

Select this option to allow taking/returning radios by sending specified text 
messages. 
• Take radio 

Specify the text of the message to be sent by the user to take a radio. 
• Return radio 

Specify the text of the message to be sent by the user to return a radio. 
 Allow Sign In / Sign Out management 

Select this option to allow taking radios when the user signs in. 
• Take radio 

Specify the text of the message to be sent by the user to take a radio. 
 Send notification to radio after it is taken/returned 

Select this option so that a notification is sent to a radio every time the user 
takes/returns it. 

• On the User Call tab, specify SIP Call settings for the user: 
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 Phone number 
Specify the user's phone number (additional data). 

 Email 
Specify the user's Email (additional data). 

SIP Call 
 SIP ID 

Enter the SIP ID that will be used by the user. 
 SIP Name 

Enter the SIP user name that will be used by the user. 
 Password 

Enter the password for the user to be authenticated by the telephone 
system 

 SIP Profile 
From the drop-down list, select the SIP profile to use. 

 Block incoming calls 
Select this option to block all incoming SIP calls for the user. 

 Block outgoing calls 
Select this option to block all outgoing SIP calls for the user. 

6.5.1.15 Logical Groups 
TRBOnet Dispatch Console allows adding custom logical groups in addition to radio 
groups. You can create groups and subgroups and then assign 
radios/users/dispatchers to these groups. 
Go to Administration (1), Logical groups (2) to work with Logical Groups: 
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• Click Add (3) to add a logical group. 
 Select Add as a Root to add a logical group as a root folder. 
 Select Add as a Child to add a logical group as a child folder. 

 

 Specify a Name and Description for the logical group. 
 Click OK to add the logical group. 

To display logical groups, enable the Logical Group view: 
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All created logical groups are displayed in the list of radios. 

6.5.1.16 Radio Groups 
Go to Administration (1), Radio Group (2) to add/edit/delete Radio Groups in the 
system. 

 

• Click Add (3) to add a radio group to the system: 
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 Name 
Specify a name for the radio group in the system. 

 Group ID 
Specify the Radio ID for the radio group used to identify messages to/from 
the radio group. 

 MDC / Sel-5 (Hex) 
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to 
identify and communicate with a target radio or group of radios depending 
on the call type. For more details on MDC 1200, see 
http://en.wikipedia.org/wiki/MDC-1200. 

 Description 
Add a description for the radio group. 

 Use custom Call Tone 
Select this option and browse for the sound file (WAV, MP3) that will be 
used as a ringtone when receiving calls from the group. 

6.5.1.17 Radios 
The administrator can add/edit/delete radios in the system. 

• Go to Administration (1), Radios (2). 

http://en.wikipedia.org/wiki/MDC-1200
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• Click Add MOTOTRBO Radio to add a new radio. 
On the General tab, specify general settings for the radio: 

 

• Callsign 
Specify a callsign for the radio to display in the Dispatch Console. 

• Radio ID 
Specify a Radio ID for the radio. This ID is used by other calling radios when 
addressing the radio, for instance, when making a private call or sending a text 
message. 

• MDC / Sel-5 (Hex) 
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to 
identify and communicate with a target radio or group of radios depending on 
the call type. For more details on MDC 1200, see 
http://en.wikipedia.org/wiki/MDC-1200. 

http://en.wikipedia.org/wiki/MDC-1200
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• Radio Groups 
In the drop-down list, select a radio group(s) to which to assign the radio. 

• Use icon 
From the drop-down list, select an icon for the radio. 

• Extended Device 
From the drop-down list, select the option board type the radio is equipped 
with. 

Location Service 

• GPS Source 
 Built-in GPS receiver 

Select if the radio has its own built-in GPS receiver to send GPS data. 
 Not equipped with GPS receiver 

Select if the radio cannot send GPS data. 
• GPS Profile 

From the drop-down list, select the default or preconfigured GPS Profile. For 
more details on GPS Profiles, see GPS Profile. 
 Location Enabled 

Select/clear this checkbox to enable/disable the location trigger. 

Telemetry Service 

• TLM Source 
 Not equipped with Telemetry 

Select if the radio cannot send Telemetry data. 
 Built-in Telemetry 

Select if the radio has its own built-in Telemetry. 
 Extended device 

Select if the radio is equipped with an extended device. 
• TLM Profile 

From the drop-down list, select the default or preconfigured Telemetry Profile. 
For more details on Telemetry Profiles, see Adding Telemetry Profile. 

Text Messages Service 

• TMS Source 
 Not equipped with Display 

Select if the radio is not equipped with a display. 
 Built-in Text Messages 

Select if the radio supports Text Messaging service (equipped with Display). 
 DMR Compatible Text Messages 

Select if the radio supports DMR Compatible text messages. 

Radio Status Service 
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 RS Profile 
From the drop-down list, select the default or preconfigured Radio Status 
Profile. 

On the Logical Groups tab, specify logical groups for the radio: 

 

• Select a logical group in the list of available groups. 
• For more information about logical groups, see Logical Groups section. 

On the Additional tab, specify additional information about the radio subscriber: 

 

• Name 
Specify a name for the radio subscriber. 

• Description 
Add a description for the radio subscriber. 
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• Click the Load Image button and browse for the photo or image to assign to 
the radio subscriber. 

• Make 
Specify a make of the vehicle as additional information. 

• Plate number 
Specify a plate number of the vehicle as additional information. 

• Phone number 
Add a telephone number for the radio subscriber. 

• Email 
Add an email address for the radio subscriber. 

• Max speed 
Specify the maximum speed allowed for the vehicle, in kilometers per hour or 
in miles per hour, depending on the measurement system specified in 
TRBOnet server. 

• Route Color 
Specify the color to display the route passed by the radio on the map. 

On the SIP Call tab, specify SIP Call settings for the radio: 

 

• SIP ID 
Enter the SIP ID that will be used by the radio. 

• SIP Name 
Enter the SIP user name that will be used by the radio. 

• Password 
Enter the password for the authentication. 

• SIP Profile 
From the drop-down list, select the SIP profile to use for the radio. 
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• Block incoming calls 
Select this option to block all incoming SIP calls for the radio. 

• Block outgoing calls 
Select this option to block all outgoing SIP calls for the radio. 

6.6 Configuring Job Ticketing 
TRBOnet Dispatch Console provides the Job Ticketing feature – the integrated 
ticketing system that allows dispatchers to create, assign, and track job tickets 
through the radio network. 

Note: Before using the feature, make sure that your TRBOnet 
Dispatch Software license includes Job Ticketing. 

• Click the Job Ticketing tab, and manage Job Tickets in the Job Ticketing 
pane. 

 

6.6.1 Adding a Status for Job Ticketing 
• Click the Statuses tab to see the statuses available for job tickets. 
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• Click the Add button to add a Job Ticket status. 

 

 Name 
Specify a Job Ticket status name to display in the system. 

 Description 
Add a description for the job ticket status. 

 Status 
From the drop-down list, select the Job Ticket status. 

Note: Specify a Job Ticket status name according to the following 
compliance table, so that Job Tickets are identified by radio: 

Name Status 

Accepted Accepted 

Rejected Rejected 

In Progress In Progress 

Completed Completed 

6.6.2 Adding a Job Ticket 
• Click the Job Ticketing tab to see the created job tickets. 
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• Click the Add button to create a job ticket. 

 

• Ticket ID 
This value will be set automatically once the ticket has been created. 

• Templates 
From the drop-down list, select a template for the Job Ticket. 

 Click the  button to create a template. 

 

• Enter the template text. You can also add: 
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 Priority 
Click this link to add the task priority to the text. 

 Date 
Click this link to add the date to the text. 

 Time 
Click this link to add the time to the text. 

• Enable Deadline 
Select this option and in the End Time box, specify the date and time on 
which to finish the task. 

• Priority 
From the drop-down list, select the task priority. 

• Text 
Enter the text message in this box. 

• Notify on status changes 
Select this option to send notifications when Job Ticket status changes to 
dispatchers, Email and/or SMS groups. 

• Notify if ticket is not accepted by 
Select this option to send notifications to dispatchers, Email and/or SMS 
groups if a radio does not accept the Job Ticket at the time specified in the 
box below. 

• Notification List 
Click this link and choose the recipients of selected notifications. 

 

You can notify dispatchers with the help of notifications in the Dispatch 
Console (on the Dispatchers tab, check Notify Dispatchers, and select 
dispatchers), Email groups by sending Emails to dedicated Email groups 
(click the Email tab, check Notify by Email, and select Email groups) and 
phone users by sending SMS to dedicated SMS groups (clcik the SMS tab, 
check Notify by SMS, and select SMS groups). 
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• Comment 
Add a comment for the task. 

6.6.3 Assigning a Job Ticket 
• Select the job ticket in the list, and click the Assign button. 

Or, right-click the job ticket and choose Assign. 

 

In the dialog box that opens: 

 

• In the list, select a radio, radio or logical group to which to assign the job 
ticket. 

• Click OK to assign the task to selected radio(s). 
As a result, the selected radio will receive the job ticket. 

6.6.4 Viewing Job Ticketing Statistics 
• On the Tools menu, click Job Ticketing Monitoring to see the Job Ticketing 

statistic diagram: 
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For more details on the statistics, see Job Ticketing Monitoring. 

6.6.5 Viewing Job Ticketing Reports 
• To view a job ticketing report, go to Reports (1), and select Common Reports 

(2) – Job Ticketing (3). 
• On the Common reports pane, click the Query parameters tab, and specify 

the appropriate parameters and then click Generate Report. 
• Click the Job Ticketing tab to see the generated report. 
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7 Installing Web-Console 
The Web Console is a special interface to connect to TRBOnet Server and monitor 
subscriber radios using a regular Web browser on any device. For more details on 
Web Console interface, see User Guide, section Web Console User Manual. 

7.1 Installing Web Console 
• Click Start>Control Panel>Programs and Features. 
• Click the Turn Windows features on or off link. 

 

• Go to Internet Information Services>World Wide Web 
Services>Application Development Features, and make sure all of them are 
selected: 

 

• Also, make sure that Common HTTP Features>Static Content is selected. 
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• Restart your PC. 
• Click Start>All Programs>Accessories>Command Prompt. 

 

• Go to This PC>Local Disk (C: )> Windows > Microsoft.NET > Framework > 
v4.0.30319/aspnet_regiis. 

 

• Drag the aspnet_regiis file into the Command Prompt then press the space 
bar and add the -i key. Then press the Enter key: 
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• Go to Control Panel > Administrative Tools. 
• Double-click the Internet Information Services (IIS) Manager shortcut and 

double-click ISAPI and CGI Restrictions. 

 

• In the Restriction column, set Allowed in all lines. 

 

• Copy the Web Site archive WebConsole to Computer > Local Disc (C: ) 
>inetpub to create a folder for the Web Console. 

• Go to Application Pools (1). Double-click DefaultAppPool (2) and check the 
.Net CLR Version (3): 
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• Click Sites (1), right-click Default Web Site (2) and choose View Applications 
(3): 

 

• Click the Add Application link. 

 

• Specify the Alias and Physical path for the application: 

 

• Browse for the folder with unarchived Web Console. 
• Click OK. 
• Select Application Pools (1) and click the Set Application Pool Defaults link 

(2): 



  

242 TRBOnet PLUS — Administrator’s Guide 

 

• Set Enable 32-Bit Applications to True (3). 
The Web Console will be added as an application to under the Default Web 
Site: 

 

Note: Make sure your account has sysadmin privileges and the 
database connection is successful (see Database 
Authentication section). 

To open Web Console, right-click your application, choose Manage Application > 
Browse. 

 

TRBOnet Web Console is now ready for operation: 
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• Enter the Login and Password, and click Connect. 

7.2 Configuring Web Console 
• If TRBOnet Dispatch Console is not installed on your PC, select the application 

and click Application Settings: 

 

• Specify the IP address and Port of the PC with TRBOnet Dispatch Console 
installed: 

 

• Right click TRBOnet Web Console and choose Edit Permissions. 
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• Click the Security tab and then click the Edit button to edit permissions: 

 

• Select User in the Users list. In the Allow column, select Write: 

 

• Click Apply. 
• Click OK. 
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Appendix A: Backing up and Restoring Database and Audio 
Recordings 
Configure Backup 

TRBOnet Dispatch Software has an embedded mechanism for database and audio 
recordings backup. Initially, it already has two paths to store database and audio 
recordings: 
%ProgramData%\Neocom Software\TRBOnet.Plus\Backups and 
%ProgramData%\Neocom Software\TRBOnet.Plus\Audio. 
For your convenience, the default paths can be changed: 

• Open TRBOnet Server and stop the TRBOnet Server service. 

 

• To customize backup folders, go to Database and select custom directory for 
the database (e.g. C:\TRBOnet\Backup\DB) and audio files (e.g. 
C:\TRBOnet\Backup\Audio). The database backups will be stored to selected 
directories. 

 

• Save your changes and restart the service. 
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Back up Database and Audio Recordings 
To back up the database and audio recordings, do the following: 

• In the Dispatch Console go to Administration section and select Database in 
the Navigation tree. 

• Click the Backup button: 

 

• Specify the backup details: 

 

 Backup audio 
Select to back up audio recordings. 

 Remove 
Select to remove audio files and data from the database. 

 Remove all data older than date 
Specify the date to remove data older than that specified date. 

 Audio Files 
Select to remove audio files. 

 Data 
Select to remove data. 

 Click OK to run the backup procedure. 
The Backup progress bar will be displayed in the lower-right corner. 
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4. In a while, a ZIP archive will be created in two possible directories: 
 The default directory is %ProgramData%\Neocom 

Software\TRBOnet.Plus\Audio for Audio files and 
%ProgramData%\Neocom Software\TRBOnet.Plus\Backups for 
backup files. 

 The custom directory is specified in TRBOnet Server settings. 
5. The archive includes the database backup file and audio recordings files. The 

archive name contains the date of backup. New backup files will be placed in 
the same directory. 

 

Restore Database 
To restore the database 

• Open TRBOnet Server and stop the TRBOnet Server service. 

 

• Unzip the backup archive and open the folder: 
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• Run SQL Server Management Studio Express with sufficient rights to 

manage databases. 

 

• Select Database in the navigation tree (e.g. TRBOnet): 

 

• Right-click the selected database, and go to Tasks/Restore/Database: 
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Select Database backup properties: 
• In the Destination group, type in or select Database name to back up to from 

the drop-down list (e.g. TRBOnet). 
• In the Source group, click Device. 
• Click … to select the directory with database backup: 

 

• Click Add and select the directory to which you unarchived the database 
backup (e.g., C:\TRBOnet\Backup\DB). 

 

Note: Select the *.bak file type. 

• Click OK to add the directory. 
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• Click OK. 
The database is added to the list of restored databases. 

 

• Select the checkbox and click OK to restore the database. 
• In the Configuration pane, select Database. 
• From the Database drop-down list, select the restored database. 
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• Click Test Connection to check the connection to the database. 
• Click Upgrade Database to upgrade the database if the current database was 

restored from the database version lower than current. 
• Click the Save changes and restart service link. 

 

Restore Audio Recordings 
To restore the audio file: 

• Launch TRBOnet Server and stop the TRBOnet Server service. 

 

• Go to Database section in the navigation tree and specify custom directory for 
audio files (e.g. C:\TRBOnet.Plus\Backup\Audio). 
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• Go to the directory you specified to store backup audio files. 
• Unzip the backup archive: 

 

• Copy unarchived audio files to the folder specified in TRBOnet Server settings 
(e.g., C:\ProgramData\TRBOnet Dispatch Software \Audio): 

 

• Click the Save changes and restart service link. 
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Thus, the audio files are restored. 

Schedule Backups 
To set a scheduled backup for the database and audio recordings, do the following: 

• In the Dispatch Console, go to Administration section and select Database in 
the Navigation tree: 

• Click the Schedule button: 

 

• In the dialog that opens, specify the Backup details: 
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• Enable scheduler 
Check to enable the database backup scheduler. 

• Days of week 
Select the days of the week on which to back up the database. 

• Start time 
Enter the start time for database backup. 

• Backup data 
Check to back up data. 

• Backup audio 
Check to back up audio recording. 

• Remove 
Check to remove audio files and data from the database. 
 Remove all data older than [X] days 

Select the number of days to remove all data. 
 Audio Files 

Check to remove audio files. 
 Data 

Check to remove data. 
• Click OK to run the backup procedure. 
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Appendix B: SIP Setup for Motorola Phone System 
The native MOTOTRBO phone system is supported in the case of a direct IP 
connection to the repeater. Mototrbo Phone system is recommended for IP Site 
Connect mode. 

Note: No extra license per repeater is required for Digital Phone Patch 
from Motorola. 

TRBOnet Server 
TRBOnet Server requires a specific setup for a repeater in the IP Site Connect mode 
as well as for SIP in order to make the phone system work properly. 
Open TRBOnet Server, and go to SIP Interconnect / Advanced Settings page: 
Set DTMF Access Code to 0 and DTMF Deaccess Code to #. 

Note: Mototrbo Phone System is available for repeaters in IP Site 
Connect mode. For a system based on the control stations, use 
TRBOnet Phone System. 

Launch Mototrbo CPS and go repeater General Settings page: 

 

The Radio ID of actual repeaters in CPS must differ from the TRBOnet Peer ID. 
TRBOnet Dispatch Console acts as another virtual peer repeater with Peer ID (e.g. 
IPSC network consists of 1 master and 3 peers. The repeaters' IDs (Radio IDs in CPS 
code plugs for repeaters) in this case would be 1, 2, 3, 4. The TRBOnet peer ID must 
differ from all the repeaters (the master and all peers), otherwise a conflict will 
happen in the network as peers have the same ID). The TRBOnet Peer ID is 64250. 

1. Open TRBOnet Dispatch Console. Go to Administration (1), Telephony (2), Radio 
calls configuration (3) – Configure (4) and set DTMF Access and DTMF Deaccess 
codes (5) to 0 and #, respectively: 
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Programming Radios 
A special setup is required for radios in MOTOTRBO CPS. 
Read a subscriber's radio in CPS and go to Phone Systems (1):  

 

Make sure that Gateway ID (2) is equal to repeater Slot IDs in TRBOnet Server as 
well as to TRBOnet Peer ID in TRBOnet Server. 
Set DTMF Access Code to 0 and DTMF Deaccess Code to #, respectively (3). 
Go to Repeater/Channels (1) and specify the phone system you have set up (2): 
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